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Chapter 1. About cardPresso

cardPresso, Lda is always deweloping cutting edge ID Card solutions. Our team has R&D
technologies and extensive ID software development skills and experience. The result of our efforts is
the Next Generation of Plastic Card Software - cardPresso, created in 2012.

Our programmers use the most recent innovations from different fields of information and ID security
technologies. Our goal is to create the perfect balance of functionality and usability, while ensuring
end users ease in using our software. We're constantly exceeding our goals through the team efforts
of our developers, analysts, resellers and our most important contributors our clients.

1.1 Overview

Welcome to cardPresso.
cardPresso is more than an application...

Why? Well, cardPresso is not only a very simple software, but also powerful and user friendly. We
have a dedicated and experienced team of professionals, support experts, software development
innovators and sales specialists, including our distributors that provide you with the best software
solution on the market.

cardPresso is committed to a continuous software improvement by responding to the clients
requests, keeping in touch with new technologies and anticipating the needs of an ever-changing
plastic card industry. Our worldwide staff is available to assist you as needed through training,
technical support, sales information or through a wide range of senices including full software
customization, stand alone projects or embedded projects, headed or followed by cardPresso.

cardPresso allows you to create a card from scratch to production, without any outsource program
to deal with any aspect of the card creation process, like image treatment or card encoding and even
the database connection issue, because cardPresso can connect to any database.

cardPresso's capability of working on Mac and Windows Operating Systems have been the market
revolution, satisfying both end-users. This has been not only a challenge but also a commitment that
allows cardPresso to work with a world wide range of clients.

Whether it's automating routine tasks or solving your toughest IT challenges, cardPresso delivers
rapid value and simplifies the plastic card creation process management, across physical, virtual and
cloud environments. And that means less chaos and stress for you, plus, big cost-savings for your
organization.

© 2014 cardPresso, Lda
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1.2 Features

= Software Box and Installation

cardPresso comes with a full setup on an USB key that allows you to work on Windows or Mac and
carry your work with you. It also brings a Digital Manual in PDF, card templates, clipart and shapes
and allows a group and user log-in management.

» Tools & Image

cardPresso has on it's tools a strong hold for its users, like 1D and 2D barcodes, variable objects,
templates, text setup, full image acquisition, face detection and a complete built-in image editor.
You also have access to a multi-layout design option.

= User Interface

cardPresso has five different views:

- the Welcome View where you define how yo start or resume a previous card creation process,

- the Users View where you can define groups and user log-in management,

- the Document View that gives you a complete oveniew of the document and at the same time
allows you to work directly on the card design,

- the Database View that is a full manipulation tool,

- and finally the encode view where you can setup your card encoding.

* Print
cardPresso offers a front and back print option, SDK driver printing, ethernet printer support, overlay
panel management and batch printing, print status and in some editions conditional printing over
database.

= Database

cardPresso allows you to connect to any kind of database, such as CSV, Excel, Access, among
others. cardPresso brings an internal database with photo connection and a powerful database tool
set where you can create and edit a database, link an image to a field, browse, filter and find
records, and concatenation options.

* Encoding

This feature allows magnetic encoding, contact smartcard plugin, contact smartcard encoding,
contactless RFID encoding and internal / external RFID encoding. cardPresso has also internal /
external RFID encoder support.

» Miscellaneous

cardPresso gives you free updates and automatic edition upgrades.

A user log that permits a step-by-step follow up of your work.

And a programming script (JavaScript, based on ECMA Script Language Specification).

© 2014 cardPresso, Lda
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1.3 Security

cardPresso, Lda team has opted for an USB pen solution that comes with a full setup.

Why? Because through this pen you can work in any PC or Mac with the advantage to carry your
work with you and also because it makes easier to recover your license online through cardPresso,
Lda.

This is a 2GB pen, which means that a lot of work can be carried on it, your card files, images,
databases, or whatever you need to carry with you.

Currently there is a cardPresso XL Edition license on your
computer, click here to check for registered upgrades for
this license

SN:CP-0701-0B03-017E

A) ‘! CARIPRESSO

Check for Upgrades

Close

B Advice: Always make a copy of your work. All data on your pen is recoverable except your work.
A pen is a piece of hardware as reliable as any other.

© 2014 cardPresso, Lda
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Chapter 2. Installation and Support

cardPresso is easy to install and customize.

2.1 Installing cardPresso

For Windows and Mac installation, please follow the steps covered on the the topics Windows
Installation and Mac OS X Installation.

2.1.1 Windows Installation

Connect the provided USB key on one of your available USB ports. The AutoPlay will run
automatically and choose the 'Open Folder to view files' option.

Double-click on the cardPresso executable file and the Installation Wizard will run. The Installation
Wizard is displayed where you can verify the Serial Number of your product and also select the
language to install. To proceed with the installation click the 'Next' button.

Install
This wizard helps you to install cardPresso
Serial Number CP-0701-0B03-017E

Shortcuts
Finish

Please select language to install

English -

CARIPRESSO

more than an application

Install or Evaluate
Select the installation folder. By default cardPresso software is installed on the Programs Folder but
you can select another destination folder by selecting the 'Select Destination folder' option.

Check the option 'Install for all users' if you want other Windows users to also run cardPresso
software. Click 'Next' to continue.

If you want to run the application without installing it please click 'Evaluate'.

© 2014 cardPresso, Lda
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Welcome

Please select the installation folder or click on 'Evaluate’ to run
cardPresso without installation
Shortcuts Install in Programs folder

Finish W Select destination folder
Install for all user

CARIPRESSO

more than an application

Shortcuts

Check the shortcuts that you want to create for easy access to the application, and if you wish to
open card files immediately with cardPresso select the file associations checkbox. Click 'Next' to
continue.

Welcome

This wizard can create shortcuts for easy access to cardPresso.
Select the check boxes below to create the corresponding
shortcuts

Install

- Create programs shortcut
Finish S
Create desktop shortcut

Create Start Menu shortcut

Create cardPresso file associations

CARIPRESSO

rmare than an appl

Finish

Click 'Finish' to install cardPresso software.

© 2014 cardPresso, Lda
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Chapter 2. Installation and Support “

cardPresso 1.1.23 XL Edition
Serial Number CP-0701-0B0O3-017E

M Delete the wizard file after installation
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2.3 Updating cardPresso

We advise to keep always your cardPresso software updated. In order to do so please go to Http://
www.cardpresso.com website and download the setup required for your operating system.

CARDPRESSO  omws wommen oomows npADRS ST CNACTS | MUSTNS oo ®

VIDEO TUTORIALS

INSUPPORT /VIDEO TUTORIALS OR
YOUTUBE.COM/USER/CARDPRESSO
SEEHOW WITHOUR VIDEO TUTORIALS.
NEW VIDEOS EVERY WEEK

diiAeLe ron. B Windows W

cardPresso

Yo

S  ee0ee 0

Ay vownwoao 4] pownroao Wl & pownLoaD [l YuD CHANNEL

1944 " DpF 1087 " Tor M

L1931 " for W

2.4 cardPresso Support

cardPresso, Lda's team treasures the relationship with our costumers, keeping it as close and
personal as possible. We are committed to offer you the best support.

We can offer support by phone, email, Skype or remote sessions (Team Viewer):
iﬂ
(+351) 261 866 163

B4
support@cardpresso.com

S

cardpresso.support

© 2014 cardPresso, Lda
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Chapter 3. Getting Started

O mis chapter explains how to handle a document, model or template, how to create or open an
existing file and also how to recover a backup file.

Document - Contains all data related to your work, including the chosen model or template, all
objects, database connections, properties, encoding properties. In sum, all the properties involved in
your card document creation.

Model - Contains all the features and shape of your physical card. These features are size and card
type, ifit is a basic card, contactless, magnetic or smartcard. Please notice that the card settings
depends on your chosen or created model type. For instance, you can't access the chip encoding
settings if you've chosen or created a card without SmartCard capabilities.

Template - Is no more then a pre-made document layout used to create a new document with a
similar design, pattern, or style. This means that you can use an existing template as it is or you
can change it as you wish, creating a new document or template from the opened template.

Backup - cardPresso automatically generates a backup file of your document every time it's saved.
This backup is created on a pre-defined folder (\My Cards\Backups') with the document name and
date/time creation.

O This document can be recovered any time you need.
Example: documentname(yyyymmddThhmmss).cardBackup

© 2014 cardPresso, Lda
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3.1 - Welcome View

* Welcome View

The welcome view is your starting point when it comes to working with cardPresso.
Here you can create new card models, open existing card models or previously made templates, or

even create a basic card with a step by step guide.

Here you can also access the Users View (only on cardPresso XL Edition or higher) or simply quit
cardPresso.

CARIPRESSO

more than an application

»*
Dz ‘ &* @) | =
e;' t using cardPresso and create your new card! : Ty _l

‘ 2 art using cardrre! and Create your new carn r-\ — -

To return to the Welcome View at any time:

0 Click Window menu » Welcome View

¥ You can get help in different ways. Choosing "Help" from the Help menu or context-sensitive help
that is always available by pressing the F1 with the cursor located on the element on which you want

help. In addition, many dialog boxes contain a Help button.

© 2014 cardPresso, Lda
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3.1.1 -CP Menu

The top menu bar, gives you access to the "CP" menu.
Here you can find information related with cardPresso.

cCp

About cardPresso

Clear Config
USE Devices
Update Security
Wiew Folders
Printer Drivers

Language »

E About cardPresso, Show your release, edition and serial number.

™ Clear Config, Sets cardPresso all settings to default, including print settings, object settings
even work space.

K USB Devices, Show every information about your cardPresso license pen, the drive ID and the
serial number, if this information is not shown then your pen has not been recognized by the system,
please check it.

E Update Security, Show information about your cardPresso license pen and allows online
upgrade.

Currently there is a cardPresso XL Edition license on your
computer, click here to check for registered upgrades for
this license

SN:CP-0701-0B03-017E
'5) | cARIPRESSO

Check for Upgrades

Close

E View Folders, Show information about cardPresso working folders. If you don't find a file or
don't know where cardPresso keeps it's folders like cliparts, backups, shapes, etc, you can check
on this list it's location.

© 2014 cardPresso, Lda
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BACKGROU...
BACKUPS
CLIPART
COMPONENTS
DATABASE
DOCUMENTS
MODELS
MYMODELS
PICTURES
PRINT
PRINTSETTIN...
SHAPES
TEMPLATES
USERS
TRAMSLATIO...

cardPresso Folders,

$PENS$/cardPresso/ClipartFiles/Backgrounds
C:/Users/Daniel/Documents/My Cards/Backups
$PEMS/cardPresso/ClipartFles/Clipart
C:/Program Files/cardPresso/COMPONENTS
C:/ProgramData/cardPresso/DATABASE
C:/Users/Daniel/Documents/My Cards
SPENS/cardPresso/CardFiles/Models
C:/Users/Daniel/Documents/My Cards/My Models
C:/Users/Public/Pictures/cardPresso
C:,fProgramData,fcardPresso,fPPJNT
C:,fProgramData;cardPresso,fPF{.lNTSETI'INGS
$PENS/cardPresso/ClipartFiles/Shapes
$PENS/cardPresso/CardFiles/Templates
C:/ProgrambData/cardPresso/USERS
C:/Users/Daniel/Documents/Translations

Close

E Printer Drivers, Show information about the printers and drivers installed on your computer and
if you click on View All Supported cardPresso Printers' you have access to a list of compatible
encoding printers.

E Language, Allows you to choose the language in which cardPresso is presented

© 2014 cardPresso, Lda
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3.2 - Creating a New Card

The first step to printing cards is creating your own card.

6 To create new card, in the Welcome View 0 Click Create New Card button

CARIPRESSO

more than an application

K
= o [
L

|

Or o Click File menu » New ( CRTL+N)

CP NEER Window Help

[ New Ctrl+N
£ Open Template Ctrl4+Shift+0
B3 Open Ctrl+0

Exit

Then you can then choose the Card Type that you intend to use from our list of supported Card
Types:

© 2014 cardPresso, Lda
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Card Types 23 Card Types | All Card Types -]

B
)} MIFARE CR78
) D) [l ceneric kJ
]
tI
GENERIC CR100
0 S D) [l 27rack
-— I i
1))) DESFIRE . Hau Lot
1 1
HICO LOCO l))) MIFARE HICO 1))) MIFARE
0 Portrait [ ok || close |

After selecting the Card Type, the cardPresso Design View will automatically open, giving you
acces to al the tools you ned to add and edit content to your new card.

HEEREDSEHERSE B VB & Lnn & DT

AP oBEEEBERE @m0 E2
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3.3 - Open Your Own Card Documents

© In cardPresso there are two kinds of files, the ones you create, called card documents and the
ones created by cardPresso designated by backup files.

To better organize your documents, in the "Open Card" window, you find "cardPresso Favorites"
with two folders - "My Recent Cards" and "My Cards". Or alternatively you may locate your file in

another folder in "My Computer".

You can sort the way how the cards are displayed. You may sort them by Name, Name
Descending, Modification Time, Modification Time Descending, File Size and File Size Descending.

Explorer| . Sort Cards By | Modiication Time
4 =) cardPresso Favorites
., My Recent Cards
My Cards DREGEED

> |l My Computer

Number of cards or name of your card

oK Close

O In the lower right corner you can find the information about how many readable documents are
currently present in the selected folder, or the name for the current selected card document.

© 2014 cardPresso, Lda
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3.3.1 - Open an Existing Card Document

© voucan open an existing card document to edit, change or even print again. The existing card
always keeps the last saved properties.

The first step will be to locate the document card that you wish to open. In order to do so, please
click the 'Open' button on the "Welcome View" or use the 'Open' option from the 'File' menu.

0 Click File » Open ( CRTL + O ) » Explorer and locate your card with extension .card

Explorer| .. Sort Cards By |name
4 [ cardPresso Favorites -/
. My Recent Cards |
My Cards ERESSH ol
> | My Computer
: 3 Card(s)
oK Close
O ciick ok.
Organize « Mew folder greer sy | IZ:.E:ZI
Marne : Date modified Type Size
Backups File folder
My Models File folder
[&| my_card.card 94 KB
File name: ry_card.card : ’card (*.card) v‘
[ Open |v] I Cancel ]

Ay
& Your file should have the extension .card

O Sselect the file extension in the corresponding Combo Box, otherwise your file will not be listed.
To proceed "Open".

—Also remember that you can open the file directly from Windows by double clicking on on it
inside Windows Explorer.
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3.3.2 - Recover Your Card Documents From Backups

L1 N backup is a file that cardPresso automatically creates every time you save a document in a
internal or external drive. The file will be saved with a date and time reference to make easier to
detect the last backup made. Like this you have the assurance that you have a copy of your

document in a specific date/time, in the backups folder.

Before opening your backup, you should know where cardPresso created the backup folder during

installation. To check the path:

© Click cP » View Folders

cardPresso Folders,

BACKGROU... $PEN$/cardPresso/ClipartFiles/Backgrounds
BACKUPS C:fUsers/Daniel/Documents/My Cards/Backups
CLIPART $PENS$/cardPresso/ClipartFles/Clipart

COMPOMNENTS C:/Program FlesjcardPresso/COMPONENTS

DATABASE C:,fProgramDataf'cardPresso,fDATABASE
DOCUMENTS  C:/Users/Daniel/Documents/My Cards

MODELS $PENS/cardPresso/CardFiles/Models

MYMODELS C:/Users/Daniel/Documents/My Cards/My Models
PICTURES C:/Users/Public/Pictures/cardPresso

PRINT C:/ProgramData/cardPresso/PRINT

PRINTSETTIN... C:/ProgramData/cardPresso/PRINTSETTINGS

SHAPES $PENS$/cardPresso/ClipartFiles/Shapes
TEMPLATES $PEMS/cardPresso/CardFiles/Templates
USERS C:,fProgramDatajcardPresso,fUSERS
TRANSLATIO... C:/Users/Daniel/Documents/Translations

Close

O Now that you know where your backups are stored

(.../usersl.../Documents/My Cards/

Backups ), you can easily locate the backup document that you need to recowver.

Q Click File » Open » Explorer » cardPresso Favorites » My Cards » 2= » Backups and

select your backup document in the folder "Backups"

© Remember that your backup has a 'filename(savedate Tsavetime).cardBakup' filename

convention.

Explorer

Sort Cards By [nreme

4 |w) cardPresso Favorites
. My Recent Cards
My Cards
> | My Computer

3 Card(s)

IPRESSO 3

OK Close

Q ciick ok.
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Organize + New folder =~ 0l @
Name ‘ Date modified Type Size
|E] daniel(20130111T124839).cardBackup 08-01-2013 16:21 Backup 94 KB
&) My_Model(20130110T215857).cardBackup ~ 10-01-2013 21:54 Backup 3KB
=] My_Model(20130110T220933).cardBackup ~ 10-01-2013 21:58 Backup 6 KB
=] My_Model(20130110T221047).cardBackup ~ 10-01-2013 22:09 Backup TKE
|E] My_Model(20130110T221135).cardBackup ~ 10-01-2013 22:10 Backup & KB
] My_Model(20130110T221327).cardBackup ~ 10-01-2013 22:11 Backup 3 KB
2] My_Model(20130110T221350).cardBackup ~ 10-01-2013 22:13 Backup KB
|E] My_Model(20130110T221406).cardBackup ~ 10-01-2013 22:13 Backup 8 KB
&) MyModel(20130110T170818).cardBackup 10-01-2013 17:06 Backup 83 KB
|E] MyModel(20130110T172244).cardBackup 10-01-201317:08 Backup 5KB
File name:  My_Model(201301107215857).carc v [CEFdBECkUp (".cardBackup) ‘]
[ QOpen |vl ’ Cancel ]

Ay
#" Your file should have the extension .cardBackup
(i Now all you hawe to do is to save your document with another name and with .card extension.

O Sselect the correct file extension in the corresponding Combo Box, otherwise your file will no be
listed.
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3.4 - Using Templates

6 A template is a collection of styles that control the layout and appearance of a card document.
You can quickly create your card document using one of our many templates.

cardPresso provides these templates organized in categories, such as Test and diagnostic; Sports;
Shopping; Schools; Loyalty; Clubs & Resorts; Business; Activities and Access Control.

But if for some reason this categories don't fit your needs, you can always create new ones, just go
to My Templates directory and once there create a new folder and cardPresso will assume that
folder to be a template category.

The Templates cover a wide range of graphics and variable field types, all of them fully editable.
These professional templates are part of your cardPresso software. Your cardPresso USB dongle
also contains additional templates.

Template Types 29 Card Templates [ All Card Templates | - |
- N
HourLoso
B
OK | Close
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3.4.1 - Create from Existing Template

0 To create a document from a template, in Welcome View 0 Click Templates

CARIPRESSO

more than an application

S =
ad [ [

Or o Click File menu » Open Template ( CRTL+SHIFT + O)

CP BEIEN Window Help

= New Ctrl+N
& Open Template Ctrl+5Shift+0
B Open ctrl+0

Exit
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Template Types 29 Card Templates
@ . Your Logo ( 5
- SCHOOL
H?url:cfgo
®
oK Close

— In the dialog box, search thru the available templates.

6 You can create a card based on a template and then modify the document without affecting the
original template

Fle Edit View Tool Database Window Help BEIE

i HEE -G8

foi

mm = H 1 Font Family

[Arial \']

Point Size

210pt 4 O Auto

Color

ping | Position | iter

[.RGB(u,u.n) -

BL

[ Word wrap

Enter T‘X

;IOhio ]Lénni# club

Source (M-I Fill | Outline | Rotation | 2

Script

y By making changes to the background, images, text, and orientation card. You can create a new
design to suit your needs. You can also modify any card object in your document.
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O A you have to do now is to save your new card document.

3.4.2 - Create Your Own Templates

O i the preset templates do not meet your requirements, you can create a template based on your

own styles.

To create your own template, start by creating a new card and chose a model type that fits your
need. For instance, if you chose for example a contactless model, the result will be a template

based on your contactless, but with your own design.

Commaon Card Types

Card Types 4 Card Types

80 )))) GENERIC )))) MIFARE

A

oK Close

0 Click "OK'. If you want to continue. Otherwise click 'Close’ to revert to the previous window.

L1 N template may include any object type, variable field or text that can be edited and modified at
any time. Make all the changes you want on your template and then sawe it with ".cardTemplate' file
extension, in the appropriate folder in cardPresso (.../My Cards/My Templates/...).

0 Click File » Save or Save as and create your file.

File name: your_card_template.cardTemplate

Save as type: |{TEMPLATES (*.cardTemplate)

DOCUMENTS (*.card)
p |

™ Browse Folders 1 1qnE| 5 (* cardModel)

L |

Ay
& Your file should have the extension .cardTemplate
0 You can edit your template at any time.

0 Click File » Open » Explorer | ===
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Explorer| .. Sort Cards By |neme

4 =) cardPresso Favorites -~
, My Recent Cards
. My Cards

> (M My Computer 3 Card(s)

IPRESSO 2

OK Close

Organize » MNew folder =~ O @

Marme Date modified Type Size

= your_card_template.cardTemplate 3 KB

File name: your_card_template.cardTemplate - [cardTempIate (*.cardTemplate) v‘

[ open |+) | cance |

O select the file extension ".cardTemplate" in the corresponding Combo Box, otherwise the
template files will not be listed.

O Atter you have completed your template edition Q click Save and your old template will be
replaced with the new modifications.

3.5 - Using Models

© cardPresso allows you to create a document in two different ways, by using an existing model
or by creating your own card model.

The first one only requires you to choose one of the many different type of models that cardPresso
has at your disposal. Like mentioned before, you have four major kinds of card models: basic,
contactless, contact smart card and magnetic, and each type can hawe different settings like sizes,
different kinds of magnetic strips and so on, all listed on cardPresso model type.

But if you have a specific type of card model that is not listed, cardPresso allows you to create it
and that's the other way to create a document, using a new card model.

O Note that whatever model you choose, it will restrict access to further settings and properties,
like referred before. If you open a "Contact Smart Card", the result will be a model of your "Contact
Smart Card", where you can only edit Smart Card Settings, and it will not allow you to access, for
instance, RFID settings.
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3.5.1 - Create from Existing Model

O mis topic guides you on how to create a new document using an existing model. You can start
a creation procedure by clicking on the create button on the "Welcome View".

0 'Welcome View' » 'Click Create’

Or o '‘Click File' menu » 'New' ( CRTL+N )

cP m Window Help

] New Ctrl+N
3 Open Template Ctri+shift+0
£ Open Ctrl+0

Exit

© Then choose the type of model you want. The model types are organized in 8 groups:

E Basic card models, have no contacts, no microprocessors or internal memory. Simple piece of
plastic that you can print in front and back side.

™ Common card types, are the most common types of card models, used by the vast majority of
users.

™ Magnetic this model type allows you to encode the magnetic stripe through cardPresso. This
means that you can print and encode your card at the same time or use an external encoder. These
cards may contain secondary technology, like RFID technology.

™ Contactless card is any pocket-sized card with embedded integrated circuits that can process
and store data, and communicate with a terminal via radio waves. This type of card model allows you
to encode through cardPresso. By using JavaScript language, you can program your card and
perform read and write operation on the card. This also means that you can print and encode your
card at the same time or use an external encoder.

™ Mifare, this card model, when chosen, allows you to read or write the several sectors of your
card. By using JavaScript language you can connect the sectors to database fields and update them
automatically or simply enter data through keyboard input, therefore you can print and encode at the
same time. These cards may contain secondary technology, like Magnetic stripes.
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E Contact, a smart card, chip card, or integrated circuit card (ICC) is any pocket-sized card with
embedded integrated circuits. In cardPresso you have four types of card models, 12C, JCOP (Java
Card), SLE4442 and generic. This type of card model allows you to encode through cardPresso. By
using JavaScript language, you can program your card and perform read and write operation on the
card. This also means that you can print and encode your card at the same time or use an external

encoder.

™ Unusual, set of models used by a small number of users. Model types dewveloped for specific

projects are now included on this group.

™ User Models, if you have any models in folder "My Models", they will become available in this

group.

Card Types 23 Card Types | Al card Types
B
))) MIFARE cR79
)) 1))) lﬂl GENERIC o

|
W cenerc et
1))) |ﬂ| 2 TRACK

i ‘— |

) S ;
))) DESFIRE Bus‘ Loco

HICO LOCO !))) MIFARE HICO b)}) MIFARE

OK

Close

After you have choose the model type, Q 'Click OK' and you will be able to start working on your

new card. Or o 'Click Close' if you want to revert to the previous window.
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& cp Fle Edit view Tool Database Window Help

BEE]

IE@I Eg@.&&&@WV“‘,,v,,

EFBEEEREE»oN0 2

s dn

61 Backgrounds found, 0 folders remaining

e For your first card design, please watch the video tutorial Create a Business Card, check also

the Objects and Properties topic.
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3.5.2 - Create Your Own Model

© To create a document using a new model, you have to start by creating the model. This will be
your starting point to customize your own document.

Card Types 4 Card Types common Card Types - |

Emg )))) GENERIC )))) MIFARE

OK. Close

Your next step is to sawe that same model with the extension '.cardModel' and sawe it on
cardPresso folder called "My Documents/My Models" in order to be identified as a model.

Oiis important that you save your file in the folder "My Models", to be displayed in the category
"My Models" in "Select model type".

Q Click File » Save or Save as and create your file as the example below, in your folder "My

Documents" (To see this folder locations, please click on menu 0 cP » View Folders)

File name:  your_card_model.cardModel -
Save as type: |IMODELS (*.cardModel) R
DOCUMENTS (*.card
TEMPLATES (*.cardTemplate - -
~ Browse Folders 1 2aVE 1| Caiicel I

Ay
& Your file must be saved with the extension .cardModel

O At this point, you've created your new model "yourdoc.cardModel." The next step will be to
locate your file and open it.

0 Click File » Open » Explorer » cardPresso Favorites » My Cards » | ===

Explorer| .. Sort Cards By |name
4 5] cardPresso Favorites -
| My Recent Cards |
, My Cards PRESSO ¥
> [ My Computer 3 Card(S)
oK Close
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Organize + Mew folder == « [ .@.
-
MName Date modified Type Size
=] your_card_model.cardModel cardPresso Model 3 KB
File name:  your_card_model.cardModel| - [cardModeI (*.cardModel) vl
[ Open |vl [ Cancel ]

0 Select the file extension in the corresponding combo box, otherwise your file will not be listed.

O After opening the model, you can customize the dimensions and corners radius. On your
right on the properties tabs you will find a tab named "Layout" where you can change the card
dimensions and corners radius,

Width  [85.725 mm =

Height [53.975 mm [

|2 mmm i '

2

|2 mmm i '

Background J Layout [
%

Clipart

Layouts

Script

You can also change the orientation of your card by O clicking on File menu » Configure Print

and In "Print Layout" 0 Click Orientation and select your card orientation. The card orientation
can be changed at any time, but this will be your card default orientation.

Orientation | | Landscape
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Q You can add images, text or other elements to customize the thumbnail that you will see in the
preview area.

My Model_85X55mm

0 The last step is to save the model that you've just created. From now on the new model will be
displayed in the Create Document Dialog Box, under the category "My Models".

o Click File » Save (CRTL+S).

Card Types 1 Card Types | My Models -]

5]
ofe
Your Logo

My Model_85X55mm

(7]
ok || Close |

{!] Please note that cardModels can't be printed, they have to be saved as *.card before you can
print.
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Chapter 4. Design

© The definition of design is the creation of a plan or convention for the construction of an object
(as in architectural blueprints, engineering drawing, business process, circuit diagrams and sewing
patterns). Design has different connotations in different fields. In some cases the direct construction
of an object (as in pottery, engineering, management, cowboy coding and graphic design) is also
considered to be design.

Well, in cardPresso you can also design and when you design you build a layout. To accomplish
this, cardPresso provides the user with specific tools and objects, allowing you to build your layout
according to your imagination, capabilities and needs.

0 As you know, when you design you create a file, called document, this document keeps inside
all settings you will use on your creation.

4.1 - Workspace

© In cardPresso you can customize your working area as you wish. You can reposition the menu
bars or you can view or hide properties areas.

0 On the View menu you have a set of options that allows you to change your working scenario.

ToolBars

Ef Here you can select all the dockbars that should be available in the working space.

W File Edit_Tqu Database window Help

s | View Card Front

— View Card Back

v Document Properties

4
ToolBars v Document Toolbar
Zoom ¢ v Views ToolBar
) v Zoom Toolbar
Metrics 3
v Database ToolBar

Bulers 3 I

) v Design ToolBar
Grid 3 9
Workspace Color » Use defaults

- ——————

Metrics

E Allows you to define the measurement unit that you wish to work with.
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* Hle Edit Tool Database Window Help

£ View Card Front

= View Card Back

v Document Properties

ToolBars 4
Zoom ’

: b -
Metncs v Millimetres
Rulers ’

Inches
Grid 4
workspace Color »

Rulers
Ef Visible - Show or hide the rules in the card design area.

E Selected Items - Shows or hide the area occupied by selected items on top of the card design
rulers Set

* Ele Edit'_l'm}l Database Window Help

= View Card Front

= View Card Back

v Document Properties

ToolBars ’
Zoom »
Metrics 4
[ -

Rulers v Visible

: 3
Grid v Selected ltems
Workspace Color ’ i

v Page guides

Grid
E Visible - Set the card visible or hidden

E Snap to Grid - Allows you to move and/or position the objects on a grid unit step or free move
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* File Edit]’uul Database Wndow Help

= View Card Front

— View Card Back

ToolBars
Zoom

Metrics

Bulers

Grid

Workspace Color

v Document Properties

v v v v

Workspace Color

Visible
Snap to Grid

K Allow you to chose the workspace background color

* Ele Edit Tool Database

£ View Card Front

— View Card Back

v Document PrcperL:ies
ToolBars
Zoom

Metrics

Bulers

Grid

Workspace Color

Window Help
4
[
Black
3 Elue
3 Gray
3 Wwhite
Bl W e
Custom
Choose Custom Color

© Switch between front or back card side.
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* Fle Edit View Tool Database Window Help

-
e Q=

€1 history records

e brow=- "~ qe

S0CCERscHooL

WHLLY0 URSOCCERSCHOOL.COM

© Switch to Database View.
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9 Ele view Database Window Help
@ 1Eo (@ B @ T
- n % s ) 3 3
o
“@m
Browse Records '
Database
C:/ProgramData/ ............. [DATABASEfinternalDatabase.mdb, Table:Employee
Record 1 of 15
Employee I1d Supervisor Id Last Name First Name
(mh? 5 Davolio Sonia Sal
B2 Fuller Andrew Vice
B3 5 Leverling Janet Sales
4 s Peacock Margaret Sales
s 2 Buchanan Steven Sales
F6 5 Suyama Michael Sales
=7 5 King Robert Sale:
(mE:] 5 Callahan Laura Inside
(=] 5 Dodsworth Anne Sales
10 2 Hellstern Albert Busin
n Smith Tim Mail
1
|Se|ect Al |Select None  Toggle Selection
Database Record
Database C:/ProgramData/ ................ IDATABASEfinternalDatabase.mdb, Table:Employee
Record 1 of 15
Employee Id ‘ | Photo
@ Supervisor Id
= Last Name
|Davnlin Fl
=l | | EEI ] ®B
= I |

Database Find

©® Sswitch to Encoding View.
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* Ele View Database Window Help
=== 0 " K = = HCWICRRENE ¥ ([J | A A A A ¥ [
BEEEEE ASDEEE &6 &N 5 del s de o &y & SO0
! -~
ENCODE DATA TBEMCODE OPERATIONS T

Front Back

Output @]

DATA INSPECTOR

BLOCK HEXADECIMAL ASCIl

cript | Database Find | Database | User Data | Printer Tools ( Preview I é

S

Continuos Read

il

q | i

4.2 - Document Properties

© When you open the document view, the first thing you will see is the work space and on the right
side the basic properties of your card document.

K Backgrounds - Each layout can have an unique background. You can access cardPresso
backgrounds library using the Backgrounds Tab. To apply a background just select it from the list
and the background will be applied immediately to your card layout. You can also set the
background using an image object.

E Clipart - You can access it using the Clipart Tab. They can be used as an image object, part of
your card layout creation, or as a background. Please note that you can only change the
background color of the object.

E Layouts - Like we said before on this manual, when you design a card, you are building a layout
and in cardPresso, a document can have as many layouts as you want. The Layouts Tab is our way
to offer you a quick way to manage all the possible layouts on your card document.

E Script - The Script Tab allows you to write your own script commands, based on the
ECMEAScript language specifications. This is a way to extend the already large number of features
that cardPresso offers you. It also allows you to interact with external software, using the results to
apply on your document. You have three different kind of script boards, one for each object, one for
the card document and one for encoding, three different ways to expand cardPresso capabilities.
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4.2.1 - Background

(i ] An image to be applied as the background of your card. cardPresso offers you many
background images that can be used from landscape cards to portrait cards.

= =
§ l All classes § [ All classes | = J
g g B
o o [
[ o
m m
= =
o P
3 3
e >
m (1]
— 1
h - B
61 Backgrounds found, 0 folders remaining 11 Backgrounds found, O folders remaining

0 Background are divided in classes that are accessible through the background combobox.

[AII classes | v

All classes fa
Technology B
Transportations
Unsorted
Geography
Foad

Shopping
Celebration
Animals
Architecture
Buildings

Cats

Dogs

Clean

Clown
Computers
Couple

Cycling -
lce

lce cream F|

(i ] It it possible to add a folder with images to use as background, in the Background Tab OAII

classes select O#User Folder.
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All classes v |

All classes A
#User Folder

. Background |

Clipart

7]

=
= |
o

=
]

—

cript

=

262 Backgrounds found, O folders remaining

oAnd select through the Explorer Browser the Folder with the images to use as Background.

Organize = Mew folder 4= - @
MNarme Date modified Type Size

J Backups 21-06-2013 12:10 File folder

, Downloaded Templates 21-06-201312:10 File folder

; My Models 21-06-201312:10 File folder
| . My Project Backgrounds 27-09-2013 12:36 File folder

, My Scripts 26-06-2013 13:05 File folder

, My Templates 21-06-201312:10 File folder

Folder: My Project Backgrounds

Select Folder l [ Cancel

elt's also possible to use your own image as the card background.

Add an image object to your layout, then right click on the object and chose 'Set as a
Background' option, like shown on the picture bellow.
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Wr Fle Edit View Tool Dambase Window Help
BEEARBEASEHE SS8 B o< 9une e L
=
e
.
1k
CE
n_ ' Delete
ﬂ I_ Duplicate
ﬂ — m Send To Front
!i & Send To Back
L
ﬁ Export Image
e [ set As Background
= Fit to Card
[+ Backgrounds faund, O folders remaining

If you want to change or edit the background, right click on the card and choose o 'Edit
background'.
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EAEESE kee® NAN &

Select all

Duplicate
Paste

(  Edit Background

‘PKERL EF RBEF

1063 x 709 - 100.0

The Image Editor will open and from there you can edit the background image. To commit changes,

o click on the 'Save Changes' button, otherwise press 'Cancel' to continue.
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4.2.2 - Clipart

i ] Clipart are pre-made images that can be used to help on the layout creation. cardPresso offers

you sewveral.
e
= | All classes
3 )
g El
u
i)
0 !il_‘. g
¥ 4 E
1282 Images found, 0 folders remaining

0 They are divided in classes. All you have to do is select one class from the dropdown combobox.

[ All classes * |

All classes fa
Symbols W
meats_and_eggs
thanksgiving
Nautical
Celebration

Clock

Countries

Background

Geography
Bread
Burguer
Food

Hot Dog
Peripherals
Storage
Vegetables
dairy
Dolphin
Dunk
Elephant
Grass Hopper

Gull . Fl

0 Select the image from the clipart list, and drag it to the card design area. The selected image will
be used as an image object that you can modify.
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\ ﬁ 1= M

N e

1282 Images found. 0 folders remaining
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4.2.3 - Layouts

i ] The Layout Tab allows to define properties, settings and conditions for the use of the layouts.
This feature allows you to use on the same card document as many layouts as you need and
conditionally print the ones you want.

Background

lipart

|Lay0ut 2 | |Lay0ut 2 |

]

[ Add ” Copy ” Delete ‘ [ Add H Copy JI Delete I

Auto Select based on database condition

[ Employee ID | = ]

[ Is Equal |+ ]

[J Auto select on card design

=]

w
—
3J
o
2
m
—
[ —
@
mn
o
0
o
fri}
o
a
p—
=
c
i
21}
i
o
O
m
a
Eﬁ
O
W
4+
0o
G
| 1

B/

M Name - You can give a name to your layout.

M Add - You can add a new empty layout.

Ef Copy - Creates a new layout based on the current selected layout..
M Delete - Delete the selected layout.

Ef Auto Select Based on Database Condition - When checked it allows access to a condition
box, where you can define fields and conditions for every layout. Remember that these conditions
are restricted to the selected layout.

(i ] After you enable the checkbox, the first drop list shows all the available fields from the
connected database. You can apply conditions based on the available fields as you can see below.
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[ Employee ID

Employee ID

Supervisor ID
Last Name .
First Name

Position
Birth Date
Hire Date
Add Copy Delete Home Phone
Extension
Photo

[ MNotes
I
_Emplnyee D . J Reports To

Is Equal . Salary
. SSN

(1234 ‘. ) ||Emergency Contact First Name

[ Auto select on card design Emergency Contact Last Name
Emergency Contact Relationship
Emergency Contact Phone

Layout 2

.m Background

¥ Auto Select based on database condition

Layouts

[ Is Equal

Is Equal

Is Not Equal
Contains .
Mot Contains

Is Null
Is Not Null

E Is Equal - Link the chosen layout to all records with the selected field equal to the input value.

E Is Not Equal - Link the chosen layout to all records with the selected field different from the input
value.

™ Contains - Link the chosen layout, based on the field value, to all the records that contains the
input value.

[M Not Contains -Link the chosen layout, based on the field value, to all the records that do not
contains the input value.

E Is Null - Link the chosen layout to all records where the selected field is a null value.
E Is Not Null - Link the chosen layout to all records where the selected field is not a null value.

(i ] After you have chosen one condition, you can set it to match any string, like shown on previous

picture '.' however please notice that the condition is not case sensitive.
0 If the record doesn't comply to any condition it will assume the layout of the previous record.

0 What benefits may be obtained from using multiple layouts? To explain it, we will show you a
sample case using one of the predefined templates available with cardPresso.

Q Now let’s imagine that you have three different departments in your company, Sales, Marketing
and another one that for this example purpose we will call it General, but only one database and you
need distinguish them visually for faster identification. The process is simple:

0 After opening one of our predefined templates, a connection to an internal database will be made
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W Fe Edt vew Tool Database Wndow Help
& B B = A A2
¥ 1 : ¥ 4 3 i v [ i 5 i I
Ciatabags
CProgramDEta) e = DATABASE irtermalDatak
— Table Employes
Record 1 of 15
! Arst Mame -
- Sonia
. . Hamor-
l . : Gales Reprasentatve
g girth Date
o . 187201208 [00:00:00) 12
m g Hire Date
= _§ 199100525 (00:00:00) -3
E E Soni _E_ Hame Phase
3 = nla. 12061555-9857
m Davolio
: Extension
o
' 2 {
T | - ; home prone (208)6656-9856T E Fhato
o :
v [HE 1# 1.1

It’s time to start working on the card layouts. Now click on the Layout Tab.
As you can see you already have one layout, from cardPresso business card.

Now we will add two new layouts in order to have three different layouts for sales, marketing and
general departments.

To start, change one of the layout's name to Marketing and then click on the auto select checkbox
to set the conditions.

On the database field, choose the field that will define the layout selection, in this case will be the
Position field.

Then in the next drop list set the condition for the chosen field, on our example we set it to
'‘Contains’.

And on the text box below add a value for the condition. In this case it is the department's name,
remember that this is not case sensitive.

Finally, enable the 'Auto select' checkbox. This option allows you to see the card layout that
depends on the condition field type when scrolling through the database records.
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stom

ourlogo
Yy 9

Cul

Background

|Marketing |

[ Add I l Copy
Auto Select based on database condition

Clipart

[ Position | = ]

[ Contains | L4 ]

|Marketing |
Auto select on card design

yourlogo

Sonia
Davolio

=
=
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Q
]
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]
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i
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Now choose our distinguish color for the card that in our example is what will define visually the
different departments.

Wr Be Edt view Tool Database Window Help

mEEEsb=aE AAAR DR EEEE - BE-
T T e —= |

il yourlogo

i = Sonia
Davolio

nome phone | 208)655-985T

EPBEEEBREE =0l

& More Colars...

[ |

=

© 2014 cardPresso, Lda



“ cardPresso Manual

Now add a new layout for Sales and General departments.

Click on the copy button twice.

As you see it copies our previous card to the new layout. All we need to do now is the same

procedure we made for the Marketing layout.

Define database settings for each new layout.

W Fle Edit Wew %ol Database Wndow Help

RmEEEE =2 ARK .

Davolio

EFBEEBR-=0oNml B

o

mmﬂt

|

Add

|| Copy Dalata
¥ Auto Select based on database condition

2

Layouts |

3

Cantaing

Gabes marketing
B Auto select on card design

£

Now use the navigation buttons and start scrolling through

the database records.

As you can see, now the setup of the card is finished, connected to an excel database and with

three different layouts to define the different departments.

1] But this is an example, you can choose as many
conditions.

layouts as you want and set your own
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4.2.4 - Script

Chapter 4. Design

© There are two kinds of scripts in cardPresso, one for each object and one for the document. In
this chapter we focus on the card document script.

This is an advanced user area, where you can program actions and procedures in ECMEAScript
language in order to define settings or update your object.

When Document Loaded

When Document Loaded

]
c
=]
o
=
o

e
|=)
]

m

Before Print

Before Print Record
After Print

After Print Record

Audit Successful Print
Database Connected
Database Disconnected

Print Dialog
Print Copies
5 @
G
I}
Script | Output '. @
H

'.' This drop-menu allows you to define when the actions or procedures must take place.

. And in the space bellow you can write your lines of code.

'.' To see the log of your program output, change tab bellow.
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4.3 - Document Objects

O These objects are the most important features in your card document creation process. There
are two maijor types of objects, static and dynamic.

The first class refers to objects that will never change along the creation or data input process, like
backgrounds and shapes, for instance.

The second ones can be static or variable. Static as a simple keyboard input text line can be but
when we connect the same text line to a database and make it change while browsing through
several records it makes it a variable object according to its data source.

The objects can be placed throughout the card space, in the front and back side. And can be
arranged as you wish in order to overcome your creation needs.

There are also a set of specific settings to each object that you can use according to your own
specifications, like color, size, source, among many others.

L
— = @ % T 02 EE
EEE VoL

New New New New New Print Print New 1D
Line Rectangle Circle Shape Text Counter Date Barcode
I:IFD : 1

LE"Y
T m PO
New 2D Browse Acquire New Database Signature
Barcode Image Image Image Image

4.3.01 -Line

O mis object is a simple straight line, but still has some features that you can setup. You can
choose between five different kinds of lines and a custom one
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Solid . v |

+ . )
~ c Llnewidthl.zmm
Ob
[=]
[
\\ \\

More Colors....

Advanced...l

E Solid Line: Is a plain line.

E Dash Line: Dashes separated by a few pixels.

E Dot Line: Dots separated by a few pixels.

[ DashDot Line: Alternate dots and dashes.

[ DashDotDot Line: One dash, two dots, one dash, two dots.

™ The Custom Line is a line that you can define as you wish. By clicking on the 'advance' button
you can set additional parameters like offset and pattern.

. Line width: varies between 0.1 to 10 mm.

. You can, also, change the color by clicking in one of the colored squares, acquire any color you
have on your screen using the dropper or use the advance color settings by clicking on the 'More
Colors' button.

o By clicking on the 'advance' button you have access to settings that allows you to change the
shape of your line. All you have to do is to write the command on the line like shown bellow.
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/RoundCap /SquareCap

Pen Parameters:

/SquareCap|

/SquareCap (FlatCap fRoundCap | oK ' .Cancel.

Ef SquareCap: A square line end that covers the end point and extends beyond it by half the line
width.

E FlatCap: A square line end that does not cover the end point of the line.
E RoundCap: A rounded line end.

0 If you right click on the object a pop-up menu is shown allowing you to:

Copy ctrl+cC
Delete Del
Duplicate  Ctr+D

m Send To Front
W Send To Back

Fit to Card

K Copy - Click on the copy option or use the shortcut 'CTRL-C' to copy the object to the
clipboard.

E Delete - Deletes the selected object.
E Duplicate - Creates an exact copy of the object on the work space.
E Send to Front - Send the object to the front of all objects on the work space.

™ Send to Back - Send the object to the back of all objects on the work space.
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4.3.02 - Rectangle

6 This obiect can be either a rectanale or a square, depending only of the side measures.

olf you right click on the object a pop-up menu is shown allowing you to:

Copy Ctrl+C
Delete Del
Duplicate  Ctrl+D

m Send To Front
W Send o Back

Ft to Card

™ Copy - Click on the copy option or use the shortcut 'CTRL-C' to copy the object to the clipboard.
™ Delete - Deletes the selected object.

™ Duplicate - Creates an exact copy of the object on the work space.

K Send to Front - Send the object to the front of all objects on the work space.

K Send to Back - Send the object to the back of all objects on the work space.

! ] You can also setup a number of properties and settings on the properties tab, on the right of
your screen. All properties and settings will be addressed further on this manual.
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4.3.03 -Circle

i ] This object can be either a circle or an ellipse. By moving the delimitation lines you can change
the appearance of the object.

olf you right click on the object a pop-up menu is shown allowing you to:

"""""" H
Copy ctr+cC
Delete Del

Duplicate  Ctr+D

W Send To Front
W Send To Back

Fit to Card

™ Copy - Click on the copy option or use the shortcut 'CTRL-C' to copy the object to the clipboard.
™ Delete - Deletes the selected object.

™ Duplicate - Creates an exact copy of the object on the work space.

™ Send to Front - Send the object to the front of all objects on the work space.

K Send to Back - Send the object to the back of all objects on the work space.

1] You can also setup a number of properties and settings on the properties tab, on the right of
your screen. All properties and settings will be addressed further on this manual.
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4.3.04 - Shape

O Tis object can assume many different shapes. On the Shape Tab you hawe a dropdown menu
with several categories of shapes. Inside each there are seweral shapes that you can add to your
card.

calf
>y g

A

Copy Ctrl+C

Delete Del

QD™
>
A

Duplicate Ctrd+D

,,..
-
-

m Send To Front
& Send To Back

M=)
AT A

\.

) et | outns | copin | posson | e

| ®
n
V1

Fit to Card
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-
a
H
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L
1
1
H
a
‘
H
1
1
L
H
1
H
-
| Shape

| -6

Wl rs2G90r "9 -

oo m- -

¢
i
?
i

O voucan change the color by clicking in one of the colored squares, acquire any color you have
on your screen using the dropper or use the advance color settings by click on the 'More Colors'
button.

olf you right click on the object a pop-up menu is shown allowing you to:

™ Copy - Click on the copy option or use the shortcut 'CTRL-C' to copy the object to the
clipboard.

™ Delete - Deletes the selected object.
™ Duplicate - Creates an exact copy of the object on the work space.
[ Send to Front - Send the object to the front of all objects on the work space.

E Send to Back - Send the object to the back of all objects on the work space.

O vou can also setup a number of properties and settings on the properties tab, on the right of
your screen. All properties and settings will be addressed further on this manual.
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4.3.05 - Text

O The text object allows you to add text to your card document. After positioning the text on the
card design area double-click on it to start typing your text. The default text format is a text box.

Please enter text

Your Text]

Close

0 There are three kinds of text objects: alphanumeric, numeric and Lists.

With the alphanumeric text objects, you can use a single line text or a text box, that allows you to
write more then one line of text.

The numeric type is divided in value, integer value and date/time.

There is also Lists and Database Lists, that are no more than a small list with two fields, one works
as an index and the other as the data that the object should display.

olf you right click on the object a pop-up menu is shown allowing you to:

;
¢
H

-.--.!.<--.-
Q
c
-
_|
1]
m————

Copy ctrl+cC
Delete Del
Duplicate  Ctrl+D

»
L]
:
L]
i

m Send To Front
W Send o Back

Fit to Card

E Copy - Click on the copy option or use the shortcut 'CTRL-C' to copy the object to the clipboard.

Ef Delete - Deletes the selected object.

Ef Duplicate - Creates an exact copy of the object on the work space.
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E Send to Front - Send the object to the front of all objects on the work space.
™ Send to Back - Send the object to the back of all objects on the work space.

© vou can also setup a number of properties and settings on the properties tab, on the right of
your screen. All properties and settings will be addressed further on this manual.
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4.3.06 - Print Counter

© The Print Counter object allows you to set a counter and print it on the card.

You can set the update of the object to manual or automatic and interact with a database field.

0 It also allows you to define the counter numeric format and values.

boooeeeee e -y boeoeoeeee - Duplicate  Ctrl4+D

m Send To Front
& Send ™ Back

Ft to Card

00000001+ 00000001[ corr  cutee

Delete Del

OIf you right click on the object a pop-up menu is shown allowing you to:

K Copy - Click on the copy option or use the shortcut 'CTRL-C' to copy the object to the

clipboard.

E Delete - Deletes the selected object.

E Duplicate - Creates an exact copy of the object on the work space.

E Send to Front - Send the object to the front of all objects on the work space.

™ Send to Back - Send the object to the back of all objects on the work space.

ou can also setup a number of properties and settings on the properties tab, on the right o
! Y Iso set ber of rti d setti th ties tab, on the right of
your screen. All properties and settings will be addressed further on this manual.
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4.3.07 - Print Date

© The Print Date object allows you to print on the card the current printing date and/or time.

You can set the update of the object to manual or automatic and interact with a database field.

O it also allows you to define the date and time format.

+ 96-05 Copy Ctrl+C

_____________ [P S N 7P Delete Del
,
A ﬁ Duplicate  Ctrl+D

m Send Te Front
W Send To Back

Fit to Card

olf you right click on the object a pop-up menu is shown allowing you to:

™ Copy - Click on the copy option or use the shortcut 'CTRL-C' to copy the object to the
clipboard.

™ Delete - Deletes the selected object.
™ Duplicate - Creates an exact copy of the object on the work space.
[ Send to Front - Send the object to the front of all objects on the work space.

K Send to Back - Send the object to the back of all objects on the work space.

O vou can also setup a number of properties and settings on the properties tab, on the right of
your screen. All properties and settings will be addressed further on this manual.
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4.3.08 - 1D Barcode

O This object allows you to create a barcode. A barcode is an optical machine-readable

representation of data relating to the object to which it is attached.

There are many different barcodes types, Code 128, EAN-8, UPC among many others. Each one

with different features and settings.

You can setup to see only the bars or complement it with readable data.

0 You can also connect the object to a database field to become a dynamic readable source.

WL

......... Q.

S e |
S a——

......... S

+
0 0

L 4
L 4

olf you right click on the object a pop-up menu is shown allowing you to:

Copy Ctri+C
Delete Del
Duplicate  Ctrl4+D

m Send To Front
W Send T Back

Fit to Card

E Copy - Click on the copy option or use the shortcut 'CTRL+C' to copy the object to the

clipboard.

E Delete - Deletes the selected object.

E Duplicate - Creates an exact copy of the object on the work space.

™ Send to Front - Send the object to the front of all objects on the work space.

™ Send to Back - Send the object to the back of all objects on the work space.

© vou can also setup a number of properties and settings on the properties tab, on the right of
your screen. All properties and settings will be addressed further on this manual.
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4.3.09 - 2D Barcode

O This object allows you to create a 2D barcode. A 2D barcode is also an optical machine-
readable representation of data relating to the object to which it is attached, ewlved from the 1D
barcode into rectangles, dots, hexagons and other geometric patterns in two dimensions (2D).
Although 2D systems use a variety of symbols, they are generally referred to as barcodes as well.

There are many different 2D barcodes types, PDF417, Datamatrix, QR-Code between others. Each
one with different characteristics.

© You can also connect the object to a database field to become a dynamic readable source.

[ | [ |
E Copy Ctr+C
[ | Delete Del

Duplicate  Ctrl4+D

m Send To Front
m Send To Back

Fit to Card

O Plcase be aware that this object is only supported on XM and XL cardPresso editions.
Q If you right click on the object a pop-up menu is shown allowing you to:

™ Copy - Click on the copy option or use the shortcut 'CTRL+C' to copy the object to the
clipboard.

™ Delete - Deletes the selected object.

Ef Duplicate - Creates an exact copy of the object on the work space.

E Send to Front - Send the object to the front of all objects on the work space.
E Send to Back - Send the object to the back of all objects on the work space.

© vou can also setup a number of properties and settings on the properties tab, on the right of
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4.3.10 - Image

O mis object is a very important one, not only because it allows you to add and work an image on
your card, but also allows you to transform that image into your card background.

An image can be add to your card from any source available like a scan device, camera, disc or
cloud and allows any kind of image, jpg, png and others.

With cardPresso you can transform that image as you want, changing color, light, size and many
other settings.

o Making it your card background is easy, right click on the image and chose 'Set as
Background' and your picture is adapted to your card size.

Copy ctri+C

Delete Del
Duplicate Ctri+D

.

m Send To Front
W Send To Back

Export Image

Set As Background

| ECEECEECEECE PO EEC PR R ELEE

Fit to Card

olf you right click on the object a pop-up menu is shown allowing you to:

E Copy - Click on the copy option or use the shortcut 'CTRL+C' to copy the object to the
clipboard.

™ Delete - Deletes the selected object.
™ Duplicate - Creates an exact copy of the object on the work space.
™ Send to Front - Send the object to the front of all objects on the work space.

™ Send to Back - Send the object to the back of all objects on the work space.
M Fynart Imane - Allows vnii tn exnnrt the imane aq a file tn anvwhere an valir comniiter

M set As Background - Set the image as the background of your layout.

© vou can also setup a number of properties and settings on the properties tab, on the right of
your screen. All properties and settings will be addressed further on this manual.
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4.3.11 - Signature

O This object allows you to add a Signature on the card.

A Signature can be added from Signature Pad devices recognized by cardPresso, which are the
WinTab, Wacom Bamboo & Topaz:

- SigLite LCD 1x5 - T-L460-HSB-R and T-LBK460-HSB-R

- SigLite LCD 4x3 - T-LBK750-BHSB-R

- SignatureGem LCD 1x5 - T-L462-HSB-R and T-LBK462-HSB-R

- SignatureGem LCD 4x3 - T-LBK755-BHSB-R and T-LBK755SE-BHSB-R
- SignatureGem LCD 4x5 — T-LBK766-BHSB-R

The Signature can also be saved to a Database as an image.

Copy ctr+C
Delete Del
Duplicate Ctrl+D

m Send To Front
®W Send To Back

Export Image
Set As Background

Fit to Card

@ i

B

olf you right click on the object a pop-up menu is shown allowing you to:

™ Copy - Click on the copy option or use the shortcut 'CTRL+C' to copy the object to the
clipboard.

™ Delete - Deletes the selected object.
™ Duplicate - Creates an exact copy of the object on the work space.
[ Send to Front - Send the object to the front of all objects on the work space.

E Send to Back - Send the object to the back of all objects on the work space.
m Evinart Imana - Allnwe vnn ta avnart tha imana ac a fila tn anvnwhara Aan vinnir comniitar

E Set As Background - Set the image as the background of your layout.

© vou can also setup a number of properties and settings on the properties tab, on the right of
your screen. All properties and settings will be addressed further on this manual.
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4.4 - Objects Properties

0 cardPresso has a properties space, shown on the right side of your screen and you can display
it as a set of tabs or as a tree or accordion set, as pictured below. To change, just right click on an
empty space on the tab and check one of the options.

ID [Item |

|ITEM_34DF91B4 | o
=8 Group [ITEM 24DFo1B4 |
wi
il | |

Group

2 Options | |
=% [ Design not allowed
= Options

0J Do Not Print [] Design not allowed

Opacity [[] Do Mot Print

=
o
=
]
=]
o

B Opacity

Clippin
Tree . PPIN9

Outline

These tabs change depending on the object we are dealing on the working area and as you will see
further on this manual.

6 Script, Layouts, Clipart and Background are the four basic tabs already refered on the 'Card
Document Settings' chapter. These tabs are shown after you chose your card model and are
previously referred to in this manual.
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441 -ltem

O The item tab allows you to define the ID, Group and visibility of an object.

|Item

D
ITEM_34DF91B4

Group

Options
[ Design not allowed
[ Do Mot Print

Opacity

U

Clipping

E Object ID - Defining the object ID not only helps you organizing data on your document, but also
gives you an easier object identification and helps you on encoding operations.

When manipulating a database you can use an ID to identify objects that will help you while
programming a script.

The options settings allows you to:

E Design Not Allowed - Check the 'Design not allowed' box protecting the object from being
changed, but only the graphical appearance and drag&drop position, not the content. This option is
applied to all objects but background.

™ Print - Lets you set if an item should be printed (Yes), if an item should not be printed (No), if it
should only be printed when it contains data (Only when has data), or if it should only be printed
when the data currently displayed in the item is valid for the type of item (Only when has valid
data).

™ Opacity - You can also define the opacity level of the object by scrolling the opacity button, from
100%, the default position to 0%.

™ Encoding - For items that hold data to be encoded, like magnetic tracks, this option allows you
to manually set if the date should be encded (Yes), should n't be encoded (No) or to only encode it
the item currently has data when being encoding (Only when has data).
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4.4.2 - Position

i this tab you can set the position manually or check the real-time position when moving and/or
resizing the object directly in the card design area.

The same properties apply to the objects dimensions, allowing you to manually change the width
and height of the object with a higher precision level.

Position |

X [8.019 mm |
Y [9.283 mm =l
|
|

Width  [31.015 mm
Height [29.112 mm

Clipping

© 2014 cardPresso, Lda



Chapter 4. Design

4.4.3 - Shape

i ] This option allows you to change the visual shape properties of an object, setting it up the \isible
area of that object with three different formats, circle, rectangle or round rectangle.

Item

Position

|

Shape

1 | g

X Radius:

[4 mim |v|

Y Radius:

[4 mm |Y|

Alignment
Rotation
Outline

Fill

Image

Source

Script

It's like hiding the image behind a layer with a hole in the middle, and the shape of that hole define
the visible part of our image, as shown below. For instance if you chose a circle shape the area of
the photo that is sitting directly above the circle content area now remains completely visible.

Original Clipping Effect Format

oTo define the clipping area and format all you have to do is drag the image boundaries.
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4.4.4 - Rotation

i this tab you can rotate or define a rotation angle to your object... Or you can select more than
one object and apply a rotation to all the selected objects at the same time.

Clipping

Qutline

Rotation ‘

Script

'.' cardPresso has quick rotation buttons for the most common rotations, 0, 90, 180 and 270
degrees rotation. You may also rotate the object in increments and /or decrements of 45 degrees
(also available using the shortcut '‘Backspace").

. If you wish to apply a more specific rotation use the edit box available for those situations

. Or turn the round button to the desired angle, updating at the same time the angle box value.

! ] All these changes are seen in real-time on the object.

4.4.5 - Outline

0 Outline allows you to chose between five different types of predefined lines and a custom one.
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S ——

Your Text...| Y e ————

I
e J

—— - Line Width |.3.25 mm - .

e ® More Calors..

Advanced...l

Fill

|7.

B

ESoIid Line: Is a plain line.

™ Dash Line: Dashes separated by a few pixels.
™ Dot Line: Dots separated by a few pixels.

[ DashDot Line: Alternate dots and dashes.

E DashDotDot Line: One dash, two dots, one dash, two dots.

K The Custom Line is a line that you can define as you wish and if click on the advance button
besides the normal advanced parameters you are allowed to set offset and pattern parameters.

. Line width is one of the settings that you can change from 0.1mm to 10mm

. You can also change the color by clicking in one of the colored squares, acquire any color you
have on your screen using the dropper or use the advance color settings by click on the 'More

Colors' button.

Q Clicking on the 'advance' button you have access to a serial of settings that allows you to
change the shape of your line. All you have to do is to write the command on the line like shown

bellow.
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/RoundCap /SquareCap

Pen Parameters:

|/squarecap| |
/SquareCap FlatCap /RoundCap [

oK |[ Cancel |

E SquareCap: A square line end that covers the end point and extends beyond it by half the line
width.

E FlatCap: A square line end that does not cover the end point of the line.
E RoundCap: A rounded line end.

4.4.6 - Fill

6 Define the fill color you want to see applied on your object, in case of lines, rectangles or circles
it will change the color of the object, on all other cases it will change the background color.

Outline

Al |

' solid il B

| v
More Colors...|

™ No fill: No color is applied to the object. This option is extremely handy when placing Text over
other objects.

Ef Solid Fill: Fill the area with only one color and you can define the color using the standard
pallet, the dropper or using the advanced pallet within the "More Colors" button.
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™ Gradient Fill: Allows you to pick a second color and make a gradient effect with both colors
and define both colors using standard pallet, the dropper or clicking in "More Colors" button using
the advanced pallet.

™ Dropper: In case of using the dropper you can select any color, even outside the program
window, like shown on the first picture below. After that the color is applied to the object and added
to the color pallet as you can see on the second picture.

Rotation

Outline

Fill

| solid Fil )

7|
More Colors...

Script ]

Ef More Colors: Gives you access to an advanced color pallet.

Ef Basic Pallet Color Theme: To chose a theme for your basic pallet color use the drop menu like
shown on the picture bellow and the theme is automatically applied to the basic pallet color.
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90% Black f\ \

Bananas
Black Body
Camouflage
Candy
Christmas
Coral reef
Desert
Earthtones
Easter

Eyes
Feminine
Fire

Fleshtones
Metallic

Midnight
Mountain
Mud
Donsil
Rainbow
ROSes
— Sand
Shades of Autumn

5
Sat |23? ,%] Green |254
val [254 & Blue |18

Hue [101 Red |90

[ oK ”Cancel‘

0n this example choosing Rainbow option will apply to the basic color pallet only colors related
with Rainbow theme.

Ef Unusual Color: In case you want to add an unusual color, you have two ways to do it, you can
drag the crosshair through the panel or input directly the color values on the boxes.

After that, the new color is added to the basic color pallet.

4.4.7 -Font

6 When you select the 'Font' tab, a number of tools allows you to define the font of your object.
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e W "
Your Text... !
A P &

Font

Font Family
| Arial . + || Anal

EE?

Pl

Point Size T Arial El
Oaeo @) 7 Arial Black
Color Tt Arial Narrow
(W r152c08102 .j T Arial Rounded MT Bold
Typeface T Arial Unicode MS
T Arno Pro
'L l‘ L . T Arno Pro Caption
[ Word wrap ' Arno Pro Display
[] Render as HTML . T Arno Pro Light Display
T Arno Pro Smbd

T Arno Pro Smbd Caption

T Arno Pro Smbd Display

T AUdimat

T AvantGarde Bk BT AaBbzZ

T AvantGarde-Book Th AcRhz7 [

TR

'.' First you have the 'Font Family' where you can chose the font type, all fonts that you hawe in
Windows or on your OSx are displayed here.

. Point Size - Allows you to define the font size, if you check on the checkbox the size is
determined by the space available between boundaries, to change just drag and drop the selection
handles.

. Color - Chose the font color.

. Typeface allows you to define more font settings that affect the whole Textbox, like:

BIU

. You can also wrap the sentence on your object by checking the 'Word Wrap' checkbox.

éYour Tex;‘ Your

R ——

( O werd wrap ) [ [¥] word wrap )
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. With 'Render as HTML' checked, you can use some HTML codes in your text to change the
"Typeface' in parts of it, instead of the whole Textbox.

----------------------- -l------------------------.I
| Textbox
«Render as HTML'
Test
CIEEEREERERRAN “EEREESAEEANN =

Please enter text
=u=This is a</u> <i=Textbox</i=
l{b}'ﬂender as HTML'</b> <p>Test
Close

E Text between <u> </u> will be Underlined.
E Text between <i> </i> will be in /falic.

E Text between <b> </b> will be in Bold.
E The <p> starts a new paragraph.
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i ] The bar code properties allows you to define some properties depending on the type of barcode
you want to use. There are two major types of barcodes the 1D and 2D, illustrated bellow.

x
(=] s

0

on cardPresso:

™ Type: Chose the type of barcode you wish to use, keeping in mind that in some cases your

Fill

_Barcade ‘

| Code 128

Barcode color

[CJRs16255851 v

Module width

| Auto v|

Bearer bar

| No bearer bar

Bearer width
0.75 mm

Quiet Zone

|Gmm

Human readable

| Eelow

Font

| Normal

CheckDigit

| None

Source

Let's start by making a general introduction, to the most common properties of barcodes, referenced

choice may change other properties range of values.

Ef Color: Define your barcode color.

E Human Readable: Defines if the readable data, alphanumeric characters, is imprinted or not

(only 1D barcode).

E Font: Defines the font of the readable data (only 1D barcode).

0 Other properties and definitions are specific to each different type of barcode, therefore will be

addressed further on this manual.

© 2014 cardPresso, Lda



“ cardPresso Manual

449 -Ilmage

© voucan acquire images from any source available, from disk, from database, from a camera or
even from a scanner.

Al lasses

O After you select an image and apply it to your working area, you have access to a new tab, the
image tab. On this tab you can change a set of properties as:

E Keep Ratio: Allows you to adapt the image to your object boundaries or keep the image ratio.
E Reinforce Black: This option forces the usage of Resin K on the black in the image.

E Flip Horizontal: This option reverses the active object horizontally, that is, from left to right. It
leaves the dimensions of the object and the pixel information unchanged. It looks as if the image has
been reflected along the central vertical axis of the object.

E Flip Vertical: This option reverses the active object vertically, that is, from top to bottom. It
leaves the dimensions of the object and the pixel information unchanged. It looks as if the image has
been reflected along the central horizontal axis of the object.

™ Grayscale: Applies grayscale on the image in which the value of each pixel is a single sample,
that is, it carries only intensity information. Images of this sort, are composed exclusively of shades
of gray, varying from black at the weakest intensity to white at the strongest.

E Chromakey Effect: Turn the chromakey effect on and off in which a color range in the top layer
is made transparent, revealing another image behind.

™ Color: Allows you to choose the color range on which the effect will act. Use the dropper to
chose any color on the image.

™ Tolerance Level - Allows you to change the tolerance lewvel of the effect. The bigger the
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tolerance, the larger the range of colors affected by the effect.

™ Effect area - Select the area of the image affected by the effect, if all image or only on the
frame.

o If you double click on the image the Image Editor opens with more edition tools.
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4.410 - Source

i ] The Source Tab allows you to define the origin of the object and parameterize that same object.
In cardPresso you have two major object classes, the images and all the text objects.

Image

Source |

| From Disk

Title

|Please browse image

[ From [:-isk-w""‘r

From Disk

Source
From Camera or Scanner
| e From Signature Pad
From Photo Editor
Updated From Database
| When ltem Double-Clicked item Link

™ T
J

Save with document

|‘|‘és

Format

| Image Free format

Face Detection

|N0

Open image editor

| Only when error

J

0 On text objects and barcodes the source can be a print counter, a print date, a keyboard input,

database or item link.

On image objects and signatures the source can be the disk, a camera or scanner, the image editor,

a database field or an item link.

On the next chapters we will show you how to use them and how to define them, in sum:

how easy it is to manipulate any of the sources or its properties.
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44101 - Text & Barcode

(i ] When you have a text or barcode object selected you can use the Source Tab to set the input
options for the object.

® On this tab you will define what kind of object it is, how it is updated, under what condition it will
be updated, when it will be updated and the final result.

Source |

Keyboard Input All I}ew_.rboard Input | = ]
Print Counter v
Print Date V— Title

E‘-‘E-l‘lt’g‘éggdelnp'-‘t |Please enter barcode data |
Item Link Updated
o ‘u'\.hen ltem Double-Clicked | » l
Save with document
[ MNo |~ l
Data Type
R .. i | Text Line |~ ]
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4.410.1.1 4.4.10.1.1 - Print Counter

(i ] This feature allows you to add a print counter to your card. It can be updated automatically and
saved with your card file, thus keeping the counter status. You can also define values, justify and set
the number of digits of the counter as explained further on this manual.

When a text object is selected you can go to the Source Tab and, on the drop down menu on top,
choose the Print Counter option or click on the 'Print Counter' button on the design toolbar.

0 You can update your counter in five different situations:

| Print Counter

Updated
[ Before Print - 4 7 | Before Print Card
When Iltem Double-Clicked .
When Load Document V= 0 BVE with document
Eefore Print @ | Yo
Before Prnint Card < =8
After Print Card EC—:‘ Minimum Value

1 —
E Maximum Value
£ 199899999 =
=8 Restart Value

1 =

Increment Value
2 =
Current Value
2 =

|ustified with zeros

Rotation

o
c
=
=]
o

| es

Number of digits
B =

Font auto adjust

4k}

3] .

3 | Never
o L

%]

h Concatenation

-

E=3

-

(=

w

E When Item Clicked - When you double-click the object it will update the counter according to
all the settings.

E When Load Document - Every time the card document is opened.

Ef Before Print - Count the number of times you send a print order and update the counter before
the printing procedure.

E Before Print Card - Count the number of cards you're going to print and update the counter
before each card is printed.
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E After Print Card - Count the number of cards you printed and update the counter after printing
each card.

O And set the following properties:

™ Save with Document - Save the settings and counters with the document so you don't loose
any data.

E Minimum Value - Defines the counter minimum value in case of negative incrementation.
E Maximum Value - Defines the counter maximum value in case of positive incrementation.

™ Restart Value - Is the value assumed by the counter when it reaches the maximum or minimum
values. (Min Value < Restart Value < Max Value)

™ Increment Value - Defines the incrementation value, it can be positive or negative.

M Current Value - Shows the current value.

™ Justified with Zeros - Justify with zeros until the desired number of digits.

E Number of Digits - Defines the number of digits used in the counter, you can justify with zeros.
E Font Auto Adjust - Automatically adjust the font size, but only if font point size is set to auto.

E Concatenation - Allows you to add a prefix or suffix to your counter value. If you don't want
these to be printed check the lanore on print check box.
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4.410.1.2 4.4.10.1.2 - Print Date

0 This feature allows you to add a date object to your card. It can be updated automatically and
saved with your card file, thus keeping the date status. You can also format the date and time as
explained further on this manual.

When a text object is selected you can go to the Source Tab and, on the drop down menu on top,
choose the Print Date option or click on the 'Print Date' button on the design toolbar.

| print Date

Updated
Before Print - 1 | Before Print Card
When Item Double-Clicked :
When Load Document V= = ave with document

Before Print I
Before Brint Card | Yes

Format

| dd-MM-yyyy (hh:mm) | = | [

Clipping

8 Font auto adjust

= )

=) | Newver

= L

5

=8 Increment Value

=] ra|
o |1 [¥]

Current Value
1 5

|ustified with zeros

Outline

| Yes

Number of digits
; -
Font auto adjust

[4F]

3] .

3 | Newver
(=] L

wn

A Concatenation

-

=3

-

(=

(]

0 You can update your date/time in four different situations.
E When Item Clicked - When you double-click the object it will update the date and time.

[M When Load Document - Every time you open the document it will automatically update the
date object.

E Before Print - Update the counter before the printing procedure starts and all the cards are
printed with the same date and time.

E Before Print Card - Update date and time before printing each card.
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O And set the following properties:

™ Save with Document - Sawve the settings and date/time of the last printing procedure with the
document so you don't lose any data.

E Format - You can format the date using one of the preset formats available thru the drop down
menu or by creating your own format by clicking on the pointed button and then write it according
with the legend bellow.

Date and Time format
dd-MM-yyyy (hhimm) |
| “ l@ dd-MM-yyyy (hh:mm)

yyyy-MM-dd
yyyy-MMM-dd oK cancel
yyyy-MMMM-dd
W!MM"dd d the day as number without a leading zero (1 to 31
yyyy/MMM/dd dd  the day as number with a leading zero (01 to 31)
yyyy/MMMM/dd ddd  the abbreviated localized day name (e.q. "Mon' to '
dd-MM-yyyy dddd the long localized day name (e.q. "Monday® to 'Sun
dd-MMM M the month as number without a leading zero (1-12
- “¥YYYY MM  the month as number with a leading zero (01-12)
dd—MMMM—Ym MMM the abbrewiated localized month name (e.g. Jan’ tx
dd/MMjyyyy MMMM the long localized month name (e.q. Januany to 'D
dd/MmM Y the year as two digit number (00-93)
hhemm Iyyyy wyyy the year as four digit number
- Time
Epmmgg S h the hour without a leading zero (0 to 23 or 1 to 12 if AM,
3 550 hh  the hourwith a leading zero (00 to 23 or 01 to 12 if AMA
dd-MM-yyyy (hh:mm) m tﬁ minute mt];oult a IIie-aclinq ze[m (0to 5)9}
_ _ . . mm  the minute with a leading zero (00 to 59
gg MM-yyyy {EE_'mm'SS} H the second without a leading zero (0 to 59)
MMyyyy (hh:mm) ss  the second with a leading zero (00 to 59)
dd/MMyyyy (hh:mm:ss) z  the miliseconds without leading zeroes (0 to 999)

zzz  the millisecends with leading zeroes (000 to 994)
AP use AMPM display. AP will be replaced by either "AM® or
ap use am/pm display. ap will be replaced by either "am" or

™ Font Auto Adjust - Automatically adjust the font size, but only if font point size is auto.

Ef Concatenation - Allows you to add a prefix or a suffix to your date and it can be printable, to do
that just check on the check-box.

4.410.1.3 4.4.10.1.3 - Keyboard Input

O mis setting allows you add an object to your card that is updated by keyboard input. It can be
updated automatically, saved with your card file. You can also choose the data type like explained
further on this manual.

When a text object is selected, you can go to the Source Tab and on the dropdown menu, on top,
chose Keyboard Input option.

E Title - You can give a name to your object, it will make it easier for further identification.

0 You can update the object in six different situations.
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Fill

Font

Source |

| Keyboard Input TextBox Properties

Title Columns (30 2
- Please enter text |
[ Before Print Card v d| g EONSJ(6 v
When ltem Double-Clic Jﬂ Update cancel
On Custom View Before Print Card
On Edit View \'—(
when Load Document ave with document
Before Print
Before Print Card ﬁ_“‘-‘| No
After Print Card Data Type
Text Box N J | Text Box
Text Line Font auto adiust
ont auto adjus :
;I;e:ld: Box . Textline Properties
alue
MNever
Integer Value | J Data Length (B0
Date et Mk
Time Valdation Rules
Date and Time
Database list 2

|

E When Item Clicked - When you double-click on top of the object it will open an input window to
update.

™ On EditView - This setting, when chosen, allows you add a new field to a small internal
database, as you'll see further on this manual.

Ef When Load Document - When the card document is loaded this object is updated.

E Before Print - After the print order and before start printing, it will open an input data window in
order to allow you to update the object, after that it will not be update again until next print order, on
the example below was date field.

™ Before Print Card - Before print each card, it will open an input data window in order to allow
you to update the object, on the example below was date field.

E After Print Card - After print each card, it will open an input window in order to allow you to
update the object for the next card, on the example below was date field.
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Print Record 1 of all

Please enter text

[2000/01/01 ]

Cancel Continue

Ef Save with Document Save on your card document the last object update.
E Data Type On this setting you can define what kind of data your object can hold.

E Text Line - Allows you to input text information in one line.

TextLine Properties

Data Length (g0
Input Mask
Validation Rules

oK Cancel

K Data Length - Defines the length of your text line (maximum of 128 characters).

E Input Mask - The mask consists of a string of mask characters and separators. You can define
your object input guide by choosing the mask or the Validation Rules, when both the mask prevails.

Character Meaning

ASCII alphabetic character required. A-Z, a-z.

ASCII alphabetic character permitted but not required.
ASCII alphanumeric character required. A-Z, a-z, 0-9.
ASCII alphanumeric character permitted but not required.
Any character required.

Any character permitted but not required.

ASCII digit required. 0-9.

ASCI digit permitted but not required.

ASCI digit required. 1-9.

ASCII digit permitted but not required (1-9).

ASCII digit or plus/minus sign permitted but not required.
Hexadecimal character required. A-F, a-f, 0-9.
Hexadecimal character permitted but not required.
Binary character required. 0-1.

Binary character permitted but not required.

All following alphabetic characters are uppercased.

All following alphabetic characters are lowercased.
Switch off case conwversion.

Use \ to escape the special characters listed above to use them as separators.

— = AVOWUWSTIHQTUOOX XTI Z0 >
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Q@ Examples:

Mask Notes

000.000.000.000;_ IP address; blanks are _.

HH:HH:HH:HH:HH:HH;_ MAC address

0000-00-00 ISO Date; blanks are space

>AAAAA-AAAAA-AAAAA- License number; blanks are - and all (alphabetic) characters are
AAAA-AAAAA-#H ronverted tn 1innerrace

E Validation Rules - Validation Rules are built up from expressions, quantifiers, and assertions.
The simplest expression is a character, e.g. x or 5. An expression can also be a set of characters
enclosed in square brackets. [ABCD] will match an A ora B or a C or a D. We can write this same
expression as [A-D], and an expression to match any capital letter in the English alphabet is written
as [A-Z].

A quantifier specifies the number of occurrences of an expression that must be matched. x{1,1}
means match one and only one x. x{1,5} means match a sequence of x characters that contains at
least one x but no more than five.

Note that in general Validation Rules cannot be used to check for balanced brackets or tags. For
example, a Validation Rule can be written to match an opening HTML <b> and its closing </b>, if
the <b> tags are not nested, but if the <b> tags are nested, that same Validation Rule will match an
opening <b> tag with the wrong closing </b>. For the fragment <b>bold <b>bolder</b></b>, the first
<b> would be matched with the first </b>, which is not correct. However, it is possible to write a
Validation Rule that will match nested brackets or tags correctly, but only if the number of nesting
levels is fixed and known. If the number of nesting levels is not fixed and known, it is impossible to
write a Validation Rule that will not fail.

Suppose we want a Validation Rule to match integers in the range 0 to 99. At least one digit is
required, so we start with the expression [0-9]{1,1}, which matches a single digit exactly once. This
Validation Rule matches integers in the range 0 to 9. To match integers up to 99, increase the
maximum number of occurrences to 2, so the Validation Rule becomes [0-9]{1,2}. This Validation
Rule satisfies the original requirement to match integers from 0 to 99, but it will also match integers
that occur in the middle of strings. If we want the matched integer to be the whole string, we must
use the anchor assertions, * (caret) and $ (dollar). When # is the first character in a Validation Rule,
it means the Validation Rule must match from the beginning of the string. When $ is the last
character of the Validation Rule, it means the Validation Rule must match to the end of the string.
The Validation Rule becomes /0-9]{1,2}$. Note that assertions, e.g. » and $, do not match
characters but locations in the string.

If you have seen Validation Rules described elsewhere, they may have looked different from the ones
shown here. This is because some sets of characters and some quantifiers are so common that
they have been given special symbols to represent them. [0-9] can be replaced with the symbol \d.
The quantifier to match exactly one occurrence, {1,1}, can be replaced with the expression itself, i.e.
x{1,1} is the same as x. So our 0 to 99 matcher could be written as N\d{1,2}$. It can also be written *
\d\d{0,1}$, i.e. From the start of the string, match a digit, followed immediately by 0 or 1 digits. In
practice, it would be written as A\d\d?$. The ? is shorthand for the quantifier {0,1}, i.e. 0 or 1
occurrences. ? makes an expression optional. The Validation Rule Md\d?$ means From the
beginning of the string, match one digit, followed immediately by 0 or 1 more digit, followed
immediately by end of string.

To write a Validation Rule that matches one of the words 'mail' or 'letter' or 'correspondence' but does
not match words that contain these words, e.g., 'email', 'mailman’, 'mailer’, and 'letterbox’, start with
a Validation Rule that matches 'mail’. Expressed fully, the Validation Rule is m{1,1}a{1,1}i{1,1}{1,1},
but because a character expression is automatically quantified by {1,1}, we can simplify the
Validation Rule to mail, i.e., an 'm' followed by an 'a’ followed by an 'i' followed by an 'I' Now we can
use the vertical bar |, which means or, to include the other two words, so our Validation Rule for
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matching any of the three words becomes mail|letter|correspondence. Match 'mail' or 'letter' or
‘correspondence’. While this Validation Rule will match one of the three words we want to match, it
will also match words we don't want to match, e.g., 'email. To prevent the Validation Rule from
matching unwanted words, we must tell it to begin and end the match at word boundaries. First we
enclose our Validation Rule in parentheses, (mail|letter|correspondence). Parentheses group
expressions together, and they identify a part of the Validation Rule that we wish to capture.
Enclosing the expression in parentheses allows us to use it as a component in more complex
Validation Rules. It also allows us to examine which of the three words was actually matched. To
force the match to begin and end on word boundaries, we enclose the Validation Rule in \b word
boundary assertions: \b(mail|letter|correspondence)\b. Now the Validation Rule means: Match a word
boundary, followed by the Validation Rule in parentheses, followed by a word boundary. The \b
assertion matches a position in the Validation Rule, not a character. A word boundary is any non-
word character, e.g., a space, newline, or the beginning or ending of a string.

Characters and Abbreviations for Sets of Characters

Element Meaning

c A character represents itself unless it has a special regexp meaning. e.g. ¢
matches the character c.

\c A character that follows a backslash matches the character itself, except as
specified below. e.g., To match a literal caret at the beginning of a string, write
\A,

\a Matches the ASCII bell (BEL, 0x07).

\f Matches the ASCII form feed (FF, 0x0C).

\n Matches the ASCII line feed (LF, 0x0A, Unix newline).

\r Matches the ASCII carriage return (CR, 0x0D).

\t Matches the ASCII horizontal tab (HT, 0x09).

\v Matches the ASCII vertical tab (VT, 0x0B).

\xhhhh Matches the Unicode character corresponding to the hexadecimal number hhhh

\Oooo (i.e., \zero matches the ASCIl/Latin1 character for the octal number ooo (between 0 and

000) 0377).

. (dot) Matches any character (including newline).

\d Matches a digit (QChar::isDigit()).

\D Matches a non-digit.

\s Matches a whitespace character (QChar::isSpace()).

\S Matches a non-whitespace character.

\w Matches a word character (QChar::isLetterOrNumber(), QChar::isMark(), or ' ").

\W Matches a non-word character.

- ' - Va4 v~

E Text Box - The multiline text box is used only if more than one line of input is required and
allows you to input text information. To input a new line the user must press CTRL+Enter. By
pressing only the Enter key will close the text box.

TextBox Properties

Columns |80

Rows |G

oK Cancel

E Columns - Define the number of columns of you text box (max: 128)
E Rows - Define the number of rows of you text box (max: 128)

E Value - Defines the object as a numeric value.
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™ Minimum Value - Defines the minimum value reachable, normally used to countdown.
E Maximum Value - Defines the maximum value.

E Step Value - Define step value when updated, use negative value for countdown.

™ Decimals - Defines the number of decimal places.

E Alignment - Set horizontal alignment

E Prefix - Defines character set that precedes the number.

™ Suffix - Defines character set shown after the number.

E Special Value - Is the value the object will assume after reaching the maximum or minimum
values.

Ef Integer Value - Allows you to write any integer value in one line box.

Integer Value Properties

Minimum Value o
Maximum Value 999599
Step Value 1

Alignment | Right
Prefix
Sufix

Special Value

oK Cancel

E Maximum Value - Defines the maximum value.

E Step Value - Define step value when updated, use negative value for countdown.
E Alignment - Set horizontal alignment

K Prefix - Defines character set that precedes the number.

E Suffix - Defines character set shown after the number.

K Special Value - Is the value the object will assume after reaching the maximum or minimum
values.

E Date - Allows you to write any date value in single line box.

© 2014 cardPresso, Lda



Chapter 4. Design

Date Properties

Minimum Date |1800)01/01

Maximum Date |2100/12/31

Alignment | Left
Calendar popup | Yes |

Date format | yyyy/MM/dd

oK Cancel

E Minimum Date - Set the minimum value to date to awids backdating.
E Maximum Date - Set the maximum value to date to awids introducing later dates.

Ef Alignment - Allows you to align text date inside object.

™ Calendar Pop-up - Every time you change settings on date field it pops up a calendar to easy
date manipulation.

Q Fevereiro_| 2011 )
dom seg qui sex sab
30 31 3 4 5
6 7 8 9 10 11 12
13 14 15 16 17 18 19
20 21 22 23 24 25 26
27 28 1 2 3 4 5
1 7 2 9 10 11 12

E Date Format - Helps you set a date value format, you have some predefined.

E Time - Allows you to write any time value in one line box.

Time Properties

Minimum Time ||30:00:00

Maximum Time |23:58:59
Alignment | Left

Time format | hh:mm:ss

oK Cancel

E Minimum Time - Set the minimum value to time to awids backtiming

Ef Maximum Time - Set the maximum value to date to awids introducing later time.
E Alignment - Allows you to align time text inside object.

E Time Format - Helps you set a time value format, you have some predefined.

E Date and Time - Allows you to write any date and time value in one line box.
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Date and Time Properties

Minimum Date (1900/01/01
Maximum Date (2100/12/31
Minimum Time |Q0:00:00

Maximum Time |23:59:59

Alignment | Left
Calendar popup | No

Date & Time format | yyyy/MM/dd {hh:mm:ss)

0K Cancel

™ Minimum Date - Set the minimum value to date to awoids backdating.
E Maximum Date - Set the maximum value to date to awids introducing later dates.
E Minimum Time - Set the minimum value to time to awids backtiming

Ef Maximum Time - Set the maximum value to date to awids introducing later time.

E Alignment - Allows you to align text date inside object.

™ Calendar Pop-up - Every time you change settings on date field it pops up a calendar to easy
date manipulation.

Q Fevereiro_| 2011 (5]

dom seg gqua qui sex sab
30 31{1:2 3 4 5
i) 7 9 10 11 12
13 14 16 17 18 19
20 21 23 24 25 26

27 28 1 2 3 4 5
6 7 8 9 10 11 12

™ Date and Time Format - Helps you set a date and time value format, you havwe some
predefined.

™ List - Allows you to create a list, composed by two columns, the first is an index column and the
second is the data column.
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[ List

Text Line

Text Box

Value

Integer Value
Date

Time

Date and Time
List Text Data
Database list

™ Database List - Allows you to create a combobox to select the update data to your object. This
only works if connected to a SQL database.

List From database Properties
SOL Select

User column |:] |

Data Column |1 |

imitRows [0 =

[ oK Hﬂancell

O e SQL Select statement is part of the SQL code and bellow we describe some examples in
how to use that code, specially how to use the select statement.

g

SELECT column_name(s)
FROM table_name

1] Lets consider the example bellow, from our internal database, where we select the position,
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extension and salary fields, from the employee database. This is the first step, the second is to set
a condition, only consider the records with the field salary with a value lower than 35000.

Now the selection is made and the condition is set.

List From database Properties
SOL Select

SELECT position, extension, salary
FROM employee
WHERE| salary=<35000

User column |0

Data Column |1

Limit Rows 40

0K Cancel

[ User Column - Here you define what column will be listed on the combo box, as a reference to

the Data Column.

E Data Column - Define to wish column belong the data that will be shown on the database list

object.

E Limit Rows - Setup the maximum rows to be listed on the combo box, to a maximum of 99.

O After we define the User Column as 0 and the Data Column as 1, we define the column to be
listed as the first (the count starts from zero) and the Data Column as the second and the result will

be as shown bellow.
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| Database list

Text Line
Text Box
Value
Integer Value
Date

Time List From databﬂ'!e Properties
Date and Time

Liet SOL Select

Database list SELECT position, extension, salary
FROM employee

WHERE| salary<35000

User column [t} ]

Data Column [1 ]

e =
umitRows (a0 ]

Please enter text

[ Sales Representative | ~
Sales F&apreﬁentaﬁve
Sales Representative
Mail Clerk

Receptionist

On your combo box is only listed the position field records (User Column 0) that matches the
condition (salary<35000). And when the position Mail Clerk is selected the object assume the
extension field record of the selected position 6261.

Ef Font Auto Adjust - Automatically adjust the font size, but only if font point size is auto.

Ef Concatenation - Allows you to add a prefix or a suffix to your date and it can be printable, to do
that just check on the check-box.
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4.410.1.4 4.4.10.1.4 - Database

(i ] There are two ways to add an object linked to a database to the card document. Open a
database and drag and drop the fields like explained further on this manual or create the object and

then connect it to a database. We will address the last option now.

After creating an object go to the Source Tab and select the Database option.

0 After you have chosen this option your tab changes.

[ Keyboard Input

Print Counter
Print Date
Keyboard Input

Database

Position

Item Link

| When Item Double-Clicke:

Save with document

Clipping

|N0

Data Type

| Text Box

oz
=
@
E
c

o

=X

Font auto adjust

| MNever

Rotation

Concatenation

Outline

[ Source

r

| Database

[ Connect to Database ... ]

Font auto adjust

| Never

Concatenation

0 And the next step is too click on the button 'Connect to a Database'. The Database

Connection Wizard will start allowing you to connect to any database you want.

After the database is opened, by default the object will be connected to the first table and first
column of your database, like shown on picture bellow. All you have to do now is define the table and
column that you want your object to be linked to.

K Font Auto Adjust - When you have defined a size for your object it allows you to choose if you

want cardPresso to automatically adjust the font size.
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l Database | = |
= [ Connect to Database ... |
= Font auto adjust
&

l Never | v J [ Never v

=] - Never
g e
= Expand to fit
o Shrink to fit

a
o
=
=
o
w

E Concatenation - Allows you to add a prefix or a suffix to your data and print it. While in
datatabase mode you can concatenate up to four columns on the same object and define a prefix
separator if needed.

Data Prefix
|—| [ ignore on print

Data Suffix
| [ ignore on print

- oncatenate database columns

Column Prefix

Column
'l Employee ID | = i)
Column Prenx
| |
Column
| (Not Used) |~ |

Column Prefix

Column

([ (Not Used) |* |)

[ OK |[Cance||

© 2014 cardPresso, Lda



m cardPresso Manual

o Ble Edt Wew ol [atsbase Windew Help

Iﬂﬂ..ﬂ:lﬂl ﬁ.& c el BB s -

do Bl s B L

Database
CoProgrambData) waemias [DATABASE/intemalDatak

Table Employes
Record 1 of 15

RE=eomi B

i)
|
i)

BEl

[197272/m48 (D0:00:000

Hire Diate
|1991/03129 (po:o0:00) 2]

Home Phone
{206)555-0857

Extemssan

mp 1%

- EFBEEB

Zoom Out
m—

As you can see the first element on our object is 'Employee ID' the one connected by default and
the two others we choose to merge in our object, the first and last names.
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4.410.1.5 4.4.10.1.5 - Item Link

(i ] This option allows you to connect an object to another, assuming the same values with
automatic update.

Fill

ont

Iltem Link M v ltem Link

Print Counter ’
Print Date Item / ".
Keyboard Input | E -
Database J
ltern Link Font auto adjust EMPLYEE ID
1D BARCODE
| Never 2D BARCODE

|

Script

When you chose this option your tab changes, allowing you to chose an object to link, showing on
the list all objects that are on the card space and which is possible to connect, in this particular
case we have a card with three other objects.

0 When connected the object will assume the linked object value and every time it is updated so is
our object.
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4.410.2 - Image & Signature

0 When you select an image object a new tab is added to properties tabs, the Image Tab, where
you will be able to define your image settings. But the source tab also changes, allowing you to

define the source settings of your image file.

4.410.2.1 4.4.10.2.1 - From Disk

| From Disk

From Disk

Title

From Disk

|please editimage

Source

|c‘..f

From Camera or Scanner
From Signature Pad

From Photo Editor

From Database

Item Link

Updated

| When Item Double-Clicked

Save with document

| Yes

Format

| Image Free format

Face Detection

|N0

Open image editor

| Only when error

(i ] This option sets the image source as the disk. When the object is updated the browser opens
allowing you to pick an image from disk.

To open an object from disk the procedure is simple, just click on the 'Browse Image’ button, add a
picture object to your card and a window will open allowing you to browse for your file.

Like shown on the picture bellow:
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Ef Title - Here you can give a name/title to your image, it will be easier for you to identify your
object later in further operations.

™ Source - Opens a dropdown list with all cameras or scanners that are installed on your pc or
mac.

Ef Updated - Your object is updated in five different situations:

Fill

T

When Item Double-Clicked

source On Custom View
On Edit View
[ From Disk When Load Document
Before Print
Title Before Print Card

After Print Card

|P|ease browse image

S
ouree [Image Free format -
Image 3x2
Updated Image 2x3
[when Item Double-Clicked Image 4x3
Image 640x430
Save with document Image 480x640

Image 800x600
[‘I‘ES Image 600x300
Image 1024x768
Format

Image 768x1024
Image 1920x1080
Image 1080x1920

Imaﬁ Free format

[ Image Free format

Face Detection

o

[Oriywhen error |«

Yes
Mo

Omwhen error

Open image editor

[ Only when error
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E When Item Double-Clicked - When you double-click on top of the object it will open the
interface related to the source you have chosen.
E When Load Document - Every time you open the card document.

E Before Print - Before the printing procedure it will open the interface related to the source you
have chosen.

™ Before Print Card - Before each time a card is printed it will open the interface related to the
source you have chosen.

™ After Print Card - After printing each card it will open the interface related to the source you
have chosen.

™ Save with Document - Save the image with the document so you don't loose any data, but in
the other hand if you don't want to keep the image for a smaller card document just chose 'No'.

™ Format - The image can have a pre-established format, like shown on the image abowe, adapting
the image to it or a free format, allowing you to keep the image source format.

Ef Face Detection - When you chose yes, after the image as been acquired the image editor
opens, allowing you to chose the face detection option.

E Open Image Editor - You can open the editor every time the image is updated (yes), never
open the editor (no) or open the editor only when an error is detected (Only when error).
4.410.2.2 4.4.10.2.2 - From Camera or Scanner

O Atter you add an image to your card, the first thing that opens is the image editor, but you can
change your image source any time you want and a camera or scanner is one of your options.
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Fill

Image [ When ltem Double-Clicked | «
| When Item Double-Clicked

_Saurce ) On Custom View
On Edit View
| From Camera or Scanner When LGEI_d Document
Before Print

Before Print Card

Title i
After Print Card

|Please browse image

S
ource [Image Free format -

| TW-Brother DCP-]315W LAN

Image 1x1
Image 3x2
Updated Image 2x3
| When Item Double-Clicked Image 4x3
Image 640x4380
Save with document Image 480x640

Image 800x600
Image 600x300
Image 1024x768
Image 763x1024
Image 1920x1080
Image 1030x1920
Image Free format

|‘|'Es

Format

| Image Free format

Face Detection

|N0

[ Only when error | +

Yes
Mo
Only when error

Open image editor

| Only when error

After chose this option your source pad changes allowing setup the camera or scanner options.

E Title - Here you can give a nameftitle to your image, it will be easier for you to identify your
object later in further operations.

™ Source - Opens a dropdown list with all cameras or scanners that are installed on your pc or
mac.

E Updated - Your object is updated in five different situations:

E When Item Double-Clicked - When you double-click on the object it will open the interface
related to the source you have chosen.

E When Load Document - Every time you open the card document.

E Before Print - Before the printing procedure it will open the interface related to the source you
have chosen.

™ Before Print Card - Before each time a card is printed it will open the interface related to the
source you have chosen.

™ After Print Card - After printing each card it will open the interface related to the source you
have chosen.

E Save with Document - Save the image with the document so you don't loose any data, but in
the other hand if you don't want to keep the image for a smaller card document just chose 'No'.
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™ Format - The image can have a pre-established format, like shown on the image abowe, adapting
the image to it or a free format, allowing you to keep the image source format.

™ Face Detection - When you chose yes, after the image as been acquired the image editor
opens, allowing you to chose the face detection option.

E Open Image Editor - You can open the editor every time the image is updated (yes), never
open the editor (no) or open the editor only when an error is detected (Only when error).
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(i ] Signature pad is a signature acquisition device, cardPresso work essencial with two kinds, the
Topaz or any device that work with the WinTab drivers.

The acquisition procedure is simple, after click on the 'Signature’ button and add the signature
object to the card a list will pop-up to allow you to chose the device in case of the Topaz, like shown

bellow.

After choosing the device the interface window will show and wait for you to add the signature to the

device like in the pictures bellow:

[ ——
Tenplate | Template 1

TOPAZ

WINTAB

The Topaz device also allows you to have templates for the signature frame. The Wintab drive have a
track pressure setting that according with the pressure made by the pen makes the line thinner or

thicker

Like any other image object, cardPresso allows you to use an existing object, all you have to do is
to click on the object and change the source to 'From Signature Pad' and starts the procedure of

signature acquisition.

Ef Source - Opens a dropdown list with all signature devices that are installed on your computer.
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E Updated - Your object is updated in five different situations:

| Please select your Signature Device from the list below

| | Repaz Siglite LCD 1x5 Backis
Tpaz SighemColors.?
®paz Siglite LCD 1x5
opaz Siglite LCD 1x5 Backit
W Tpaz Siglbe LCD 4x3
Wpaz SignatureGem LD 1xS
Topaz SignatureGem LOD 1x5 Backlt I

Topaz SignatureGem LOD 4x3
Wpar SignatureGem LOD 4x3 (T.LBKTSSSE BHSE-R)

Bgaz SignatureGom LCD £x3 |
Source |

| From Signature Pad

[ Wwhen ltem Double-Clicked v Title

When ltem Double-Clicked
On Custom View

|please sign here

On Edit View Source
When Load Document
Before Print | Topaz Signature Pad

Before Print Card

After Print Card \ Updated

Image Free format —— | When Item Double-Clicked
Image 1x1 Save with document

Image 3x2

Image 2x3 | Yes

Image 4x3 "l

Image 640x480 Lo \

Image 480x640 y Format

Image 800x600

Image 600x300 NS | Image Free format J
Image 1024x768 — .

Image 768x1024
Image 1080x1920

Image Free format

E When Item Double-Clicked - When you double-click on the object it will open the interface
related to the source you have chosen.

E When Load Document - Every time you open the card document.

™ Before Print - Before the printing procedure it will open the interface related to the source you
have chosen.

E Before Print Card - Before each time a card is printed it will open the interface related to the
source you have chosen.

E After Print Card - After printing each card it will open the interface related to the source you
have chosen.

™ Save with Document - Save the signature image with document so you don't loose any data,
but in the other hand if you don't want to keep the image for a smaller card document just chose 'No'.

™ Format - The image can hawe a pre-established format, like shown on the image abowe, adapting
the image to it or a free format, allowing you to keep the image source format.
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4.410.2.4 4.4.10.2.4 - From Image Editor

(i ] The Image Editor brings you new tools for image edition, there are many ways to open the image
editor, but to acquisition only one, open an image object and then change the source to 'From

536 1301 - 100.00%

On the tool bar you can set this settings on your image:

Ef Rotate clockwise - Is the circular motion is one that proceeds in the same direction as a
clock's hands: from the top to the right, then down and then to the left, and back up to the top.

™ Rotate anti-clockwise - Is the circular motion is one that proceeds in the opposite direction as
a clock's hands: from the top to the left, then down and then to the right, and back up to the top.

™ Flip Horizontal - This option reverses the active object horizontally, that is, from left to right. It
leaves the dimensions of the object and the pixel information unchanged. It looks as if the image has
been reflected along the central vertical axis of the object.

E Flip Vertical - This option reverses the active object ertically, that is, from top to bottom. It
leaves the dimensions of the object and the pixel information unchanged. It looks as if the image has
been reflected along the central horizontal axis of the object.

™ Brightness and Contrast - The Brightness/Contrast adjustment lets you make simple
adjustments to the tonal range of an image. Moving the brightness slider to the right increases tonal
values and expands image highlights, to the left decreases values and expands shadows. The
contrast slider expands or shrinks the owerall range of tonal values in the image. To change values
you can drag the slider to the left or to the right or setup manually typing the values on the boxes.
The values can go from -128 to 128.

E Color Balance - Is the global adjustment of the intensities of the colors (typically red, green,
and blue primary colors or RGB system). Changing the overall mixture of colors in an image and is
used for color correction and when you drag any of the sliders, you can see those corrections taking
place, adjustments are made to the color values RGB (on screen) or CMY (on printers). The values
can go from -128 to 128.
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™ Color to Grey - Apply gray scale on the image in which the value of each pixel is a single
sample, that is, it carries only intensity information. Images of this sort, are composed exclusively of
shades of gray, varying from black at the weakest intensity to white at the strongest.

™ Color to Monochrome - Not a combine black and white in a continuum producing a range of
shades of gray but really starkly contrasted black and white.

E Zoom In - This tool allows you to obtain a larger image, or a closer view.
E Zoom Out - This tool allows you to obtain a smaller image, or a farther view.
Ef Zoom Auto - Reset image to its initial size.

E Export Image - You can sawe the image as... in many different formats like png, jpg, bmp, tiff
and others.

™ Select Image Acquisition Source - Allows you to select the image acquisition source from
any device that is connected or installed on your pc. It may appear some devices that are not
connected but are installed.

E Image Acquisition - This tools opens the interface related with the image acquisition source
you had chosen.

™ Open Image File - Opens an image file from your system, including disk, pen, memory card or
any other source.

™ Select Image File Path - Allows you to chose your default image file path from all that you had
already used before on your document.

E Face Detection

M Face Detection Setup

K Undo - It erases the last change done to the document reverting it to an older state.
E Clear Image - Erases the image from Image Editor.

E Cut / Crop - On cardPresso crop tool you don't use the traditional handlers, the visual area is
automatically resized to the image object boundaries, to cut/crop the image all you have to do is to
drag or zoom in on the image and every thing that is on the blur area (gray and black squares) when
you click the cut/crop button, goes away. And the image is automatically adjusted to the object
area.

E Save Changes - Click on this button to accept the changes.

™ Cancel - Click on this button to quit on the changes.
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4.410.2.5 4.4.10.2.5 - From Database

(i ] cardPresso allows you to connect an image object to a database image, this way you can
setup the object as you want and then connect to the database image adapting it to your object.

The procedure is simple, first add a image object to your card change the source to 'From
Database’.

0 If not connected to a database yet 0 click on the 'Connect to Database' button.

Birtwer
Sdenc? thi atibiie drrer that wertibas your databans £ ofneBon.

......... . wtwrnal Database ImsAccessh
Durwct C5W s TXT b Divar

Corect Excel fil Drreer

50w verson 3

[ —r—

Open Databas Comnectviey (0OBE]
Open Databave Connectraty {D0BT ans)
RS OL Drrvee

. The connection wizard will start

6 After the connection is made, if there is no image field, the link is not made and the list stays
like the image bellow, empty.

If there is only one image field, the cardPresso recognize it and the link is automatic.

0O i more then one then a list will show you the options for you to chose, like shown

bellow.

| ) [« [ o [ m [ wn [ o | P [ o | r [ sT
[Phato cardin Image I
Rui Faria Fao0s43s  C\Users\Public\Pictures\Sample Pictures\Penguins.jpg

ljodo Lucas 32448035  C\Users\Public\Pictures\Sample Pictures\Koala.jpg

|paniel Gomes B2EDIFIS  C\Users\Public\Pictures\Sample Pictures\Jellyfish.jpg

Nuno Martins F2D08435

Carlos Pinheirg 32048035

|

DATABASE
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Source |

| From Database

Table
| Employee
Column
| Photo - [@Photo v
Save with document @Photo
@image
| Mo

Face Detection

|N0

Open image editor

| only when error

0 If you add a field image, please don't forget to refresh the database.

4.410.2.6 4.4.10.2.6 - Item Link

0 This option allows you to connect (link) one object to another object, assuming the same data
values with automatic update.

When you choose this option your tab changes allowing you to chose an object to link, showing on
the list all objects that are on the card document that you can connect to,

Q For the next sample we will use an image object.
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[ Item Link | v]

|

ITEM 162B3FAC

i ] When connected, the object will assume the linked object value and every time it is updated also
the first object will also reflect the data from the linked object.

This option allows you to have two image objects, one at the front of the card and another at the
back of the card, sharing the same data.

4.4.11 - Alignment

6 The alignment tab allows you to define the object alignment inside the boundaries.

[Alig nment ]I

Select your item alignment

0 3 N 3

Rotation

Your Text
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As you can see you can define vertically from top, middle or bottom and horizontally from left, middle
or right.

When the point size is in auto, on the font tab, it means that the font size justify the text to the
boundaries what makes the horizontal adjustment very small

(1) The default position is left and middle.
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4412 - Script

© There are two different scripts in cardPresso, one for each object and one for the document. In
this chapter we focus on the object script.

This is an advanced user area, where you can program actions and procedures in javascript
language in order to define settings or update your object.

[Script |

[ When ltem Double-Clicked ._
o

When Item Double-Clicked
On Custom View

On Edit View

when Load Document
Before Print

Before Print Card

After Print Card

Record changed

Script | Output . e

. This drop-menu allows you to define when the actions or procedures must take place.
. And in the space bellow you can write your lines of code.

'.' To see the log of your program output, change tab bellow.
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4.4.13 - Multi Align

i ] The multi align tab is only displayed when three or more objects are selected and is divided in
two classes, the alignment between objects and the distribution.

[Multi—AIign ]

( Alignment Between Objects )
T—
ol
] -
. —

Multiple selection

Ef Alignment Between Objects - Aligns vertically and horizontally the objects to top, middle or
bottom and to left, middle or right using as boundaries the card limits.

™ Distribution - Allows you to distribute the objects on the card area equitably, but instead of
using the card limits as a reference uses the object boundaries referring to the last object selected
that is marked with blue selection handles.

All other objects will be allocated according to the selection and having as a reference the last one
selected, notice that the reference object is also the anchor and will not move, all the others will be
placed according with the distribution settings.

In short, the space occupied by the three or more objects will always be the same, the space
between them is the one that will be arranged.
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4.5 - Edit View

6 This chapter will explain you what the Edit View is about, its basic concept, features, availability
and objective.

Imagine that you have a small business, with eight or ten employees and you want to keep a record
for each and even print a card for time attendance or access allowance
And then you think... but | don’t now how to work with a database.

! ] Edit View is a very simple, small but powerful alternative to a database, where you can
keep up to ten records, and manipulate them as you wish.

6 The Edit View is available from our basic edition, the XXS, allowing you to have a first contact
with cardPresso capability of database manipulation and if you don't need more than ten records or
don’t know how to work with a database, then the Edit View may become your ideal solution.

All the records are saved into you card document file, so there are no attached files or any other files
to look after and you can use an existing card template or create a new one.

Edit View also allows editing any kind of field type that you can find on any other database, text,
date, numbers and also allows you to add and edit images of any kind.

Ok after the presentation we took a cardTemplate like the one on the picture below:

{ You Lo go:

‘architects

Jeremy Hardens- L‘ -

S /%\/\ Engineer Supervisor V'!

As you can see we have three workable objects, the name, the position and the photo.

o Click on the name, for example and then on the source tab on the Update option chose 'On Edit
View'
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W Fle Edt wiew ool Database Window Help

=23

Yourlogo.

H A4 architects

Updatid
[ on Edit view -

‘When Rem Double-Clicked
On Custam View

Sav

‘When Load Document
Dt Bedare Print
Eofare Prink Card
|After Print Card

EFPBEEEEBER-onl B

© Then a new tab is available, the Edit View tab.

Edit View
@ Nasee o=
2000 0

1 of 1 history records

Photo

architects

YourlLogo

eremy Hardens' Q

" Engineer Supernsor @h

Name

|Jeremy Hardens |

Position

|Engineer Supervisor |

Very similar to the database tab, with the command buttons on the top and already with our name
field.
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'.' Go to the first record

. Go to the last record

'.' Go to the next record

'.' Go to the previous record
. Delete displayed record
. Add a new record

(i ] To start lets give names to our objects, like Name, Position and Photo, it will be easier in the
future to identify them.

To add the other objects to the Edit View the process is the same, select the object, go to the
source tab and on the Update option chose 'On Edit View".

Now we have all three objects on the Edit View, to order them as you like just drag and drop on the
tab.

Edit View |

a « > O =
M N N N

1 of 1 histery records

Photo

Name - \
|leremy Hardens |
Name EE:'J.'rH-:
Jeremy Hardens ﬁ
Position

|Engineer Supervisor |

Database

oAII you have to do now is add more records, filling the fields on the 'Edit View' tab, up to a
maximum of 64 records (on XXS Edition only 10).
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Chapter 5. Database

Li N database is an organized collection of data. A database is typically organized to model
relevant aspects of reality in a way that supports processes requiring this information

This chapter explains you how to connect to a database through cardPresso and how to use it to
your advantage

5.1 - Connection

0 In cardPresso there are two ways to connect to a Database.

One of them is by clicking on the Connect Database icon in the Dockbar.

.;__J

=2

The other is by selecting Connect in the Database Menu.

* Fle Edit View Tool gatabase Window Help

&) Connect
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5.1.1 - Configuration

0 here are several Database Drivers at your disposal:

XXS only has the cards internal database accessible from the Edit View as explained in chapter
4.5

XS has the, Direct CSV & TXT File Driver, that can only read the fields in these databases.
Edition of their records isn't possible through cardPresso.

And the Direct Excel File Driver through which cardPresso can edit the fields and records of the
Database.

With these drivers it is also possible to add Links to images and their Folders.

XM can connect to SQLite version 3 and the Direct MS Access File Driver. From here on it is
possible to Alter Tables and in the records add images as Binary file.

The cardPresso Internal Database (msAccess) becomes available in this Edition.

XL adds the ODBC Drivers and with them it is possible to connect to any Database with ODBC
Support, like: SQL Server; Oracle; MySQL; as others.

Database Driver
Please select the database driver that identifies your database connection.

Internal Database (msAccess)

Direct C5V & TXT Fle Driver

Direct Excel File Driver

SQLite version 3

Direct Access File Driver

Open Database Connectivity (ODBC)
Open Database Connectivity (ODBC ansi)
MySQL Driver

< Back | Next> ” Cancel ]

After selecting the Driver you will be prompted to Select or Browse to the Database.
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Database
Please select the database that you wish to connect to.

QODEBEC:0Open Database Connectivity (ODBC)

Database [| v]

Connection Options | |

|ODBC Administrator]

Or

IErﬂwse Fﬂr*.cst

Prompt for credentials

[ < Back |l Next = ” Cancel |

0 The instructions on how to configure each Driver connection, will be addressed further on this
manual.
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5.1.1.1 - Direct CSV & TXT Driver

(i ] In the Direct CSV & TXT Driver there are seweral configuration options, usually cardPresso
Guess function does the required configuration when the CSV or TXT file are opened.

Fle
Sample.txt

Fle Encoding

Delimiter

Auto. f

Type Field delimited . r_]

[ Has columns header]

Guess

Fields

Mumber
MAME
Date
Photo

Feld

Type

oK || cancel

Auto . v]
Auito

UTF-&

UTF-16

SO 8859-1

i Field delimited . v
Feld delimited |
Axed Record Size

| Banking Structured Fle

@=L
[ ]
=

<TAB>

<AUTO>

[ String . * |
jgtnng ™ I
Integer Number
Fractional Number
Date
Tinne
| Date and time

'.' File Encoding - The File encoding is by default as 'Auto’, if the encoding used by the database
is on the dropdown list chose it.

. Type - Is for the Size of the Fields in the Database.

'.' Delimiter - It is possible to chose the Delimiter used in the Database or Input it.

'.' Field Type - Select the Field Type accordingly.

0 Explanation on the next connection steps will be addressed further on this manual.
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5.1.1.2 - Direct Excel Driver

(i ] In the Direct Excel Driver it is possible to confirm the structure of the database and if needed
add more Fields to it. The cardPresso Guess recognizes the structure and configures the
connection, if the configuration isn't correct, change it accordingly.

Fle Relds

Sample. xlsx o
o 1 Mame

Worksheet Sample L Date

Phat
Header Al (D) . ’
Data Az o :

Feld
: o>
Type String . r Stnng v
) i |String |
Length 10 Integer Mumber
Fractianal Number
Date

Time
Date and time

Guess Ok Cancel

. Worksheet - Chose the Worksheet to which the card is to be connected.
. Header - Select the Header of the Database.
'.' Data - Select from where the Rows start.

'.' Type - Select the Field Type accordingly.

0 Explanation on the next connection steps will be addressed further on this manual.
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5.1.1.3 - Direct MS Access Driver

0 Since the data stored in the MS Access and the SQLite Databases has a fixed format, no
special configuration is needed. Just browse to the Database and open it.

The cardPresso Internal Database is a MS Access Database provided with the cardPresso
installer and serves as a Sample and for test purposes.

Database
Please select the database that you wish to connect to.

QMODE:Direct Access Fle Driver

Database |aSEfinternalDatabase.mdb ']

EBrowse Fur*.mdh]

[0 prompt for credentials

[ < Back H Next = H Cancel

0 Explanation on the next connection steps will be addressed further on this manual.
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5.1.1.4 - Internal Database

eEach cardPresso document contains an internal database as a smaller yet more convenient way
to keep records. This means you can have your own database records saved within the cardPresso
document itself, without need of external database files.

To connect to the internal database you can use the Connect to Database button.

=

On the following window select document Internal Database.

Database Driver
Please select the database driver that identifies your database connection.

document Internal Database

cardPresso Internal Database (msAccess)
Direct C5V & TXT Fle Driver

Direct Excel File Driver

SQLite version 3

Direct Access File Driver

Open Database Connectivity (ODBEC)
Open Database Connectivity (ODBEC ansi)
MySQL Driver

< Back Mext = Cancel

You can then use Database Operations to create your own tables and columns and save them on
your cardPresso document.

5.1.1.5-0DBC

(i ] The Open Database Connectivity (ODBC) provides the means to connect to several
Databases, such as, SQL Sener, Oracle, IBM, Fox Pro, dBase and others.

In case of Databases containing special characters, the usage of the Open Database Connectivity
(ODBC) ansi is advised.
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Database

Please select the database that you wish to connect to.

QODBC:Open Database Connectivity (ODBC)

Database [

’)

Connection Options |

|oDBC Administrator|

User DSN | System DSN | File DSN | Drivers | Tracing | Connection Pooling | About | . )

|User Data Sources:

Mame

Dirver

Microsoft Excel Driver ("xds, ~xdsx, ~xlsm, ~“x
M5 Access Database Microsoft Access Drver " mdb, *accdb)

<

UL

Ad

Remove

Cancel ]

Configure...

i

& An QDBC User data source stores information about how to connect to
E the indicated data provider. A User data source is only visible to you,
~ and can only be used on the cument machine.

OK

][ Cancel ] Apphy

Help

Driver do Microsoft Access (" mdb)

Drriver do Microsoft dBase (~.dbf)

Driver do Microsoft Excel(™xds)

Driver do Microsoft Paradox (".db )
Driver para o Microgoft Visual FoxPro

Microsoft Access Driver (" mdb)

Ba [

Rl P p—

- "o
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By selecting the ODBC Administrator these options are available:

User DSN - Shows the existing connections and provides the possibility to Add more connections
and Remove or Configure existing connections.

System DSN - Shows the existing connections and provides the possibility to Add more
connections and Remove or Configure existing connections.

File DSN - Provides the means to connect to a data provider.
Drivers - Shows the connection Drivers installed on the system.

Tracing - Provides the means to log the calls to the ODBC drivers for use by the support personel or
to aid in debugging your applications.

Connection Pooling - Provides the means to reuse open connection handles.

About - Shows the ODBC core components available.

i Please contact your SysAdmin for the configurations required to connect with your Database.

0 Explanation on the next connection steps will be addressed further on this manual.
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5.1.1.6 - MySQL Driver

6 The MySQL Driver allows to connect to a MySQL Database.

Database
Please select the database that you wish to connect to.

QMYSQL:MySQL Driver

Database [test ']

Hostname [1!].!].2.2 ]

Port |Default 2

Connection Options | ]

Usemame [mﬂt ]

Password [ ]

Keep credentials
- Prompt for credentials

[ 2.2 H Cancel ] F'?H Next > H Cancel

0 Please contact your SysAdmin for the configurations required to connect with your Database.

0 Explanation on the next connection steps will be addressed further on this manual.
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5.1.2 - Database Operations

i ] The Database Operation is an important function for XM and higher Editions. In the Database
Operation it is possible to Select, Create, Alter or Drop Database Tables, making it possible to
personalize a Database with cardPresso.

Since the CSV, TXT and Excel Databases do not have multiple Tables only the Select Table is
possible in their case.

Database Operation
Please select the cperation you wish to perform on your database.

" OMDB:C:fProgreamDatafa JDATABASE internall

Operation [ Select Table | =

Select Table
Employ Create Table
Alter Table

Drop Table
Select View
Select ...m Table
Select ALL

TABLE,19 Columns

< Back Mext = Cancel

This example is based on the cardPresso Internal Database.
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5.1.3 -Table Columns

i this part of the Database Connection Wizard it is possible to select which columns of the
selected Table you need.

Table Columns
choose Table columns

C:ProgramDatal ce e JDATABASE(internalDatabase. mdb-
Columns
Employee ID (=]

Last Name
First Name
Position
Birth Date
Hire Date
Home Phone
Extension 5

[FF nbhatn

Supervisor ID H

H select all columns

< Back H Next = H Cancel I

[ Select all columns [ Select all columns At least one column must be selected]

6 If no column is selected the Wizard won't continue.
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5.1.4 - Guide Columns

6 The Guide Columns will work as an Index of the Database.

Guide columns
choose Guide columns

CuProgramData) e, DATABASE/internalDatabase. mdb -
Guide columns

Employee ID [a]
Supervisor ID

Last Name

Frst Name

Position

Birth Date

Hire Date

Home Phone

Extension 2

[ = Back H Mext = H Cancel ]
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5.1.5 - Database Filter

© In the Database Filter you can add conditions to filter what is shown from the database. These
conditions have to be written in SQL Script without the "Select * where".

Filter
Filter

C:/ProgramDatay .. JDATABASE/internalDataba

Database Filter

[ < Back ][ Next > ]l Cancel ]

'—

Flter
Filter

C:/ProgrambData/ .. JDATABASEfinternalDataba

Database Filter

"Supervisor ID° = 5 OR " Supervisor ID” = 2

[ < Back ][ Next = ][ Cancel ]
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5.1.6 - Order Columns

0 With the Order Columns it is possible to change how the database is shown in cardPresso.

The organization rules used by cardPresso for the selected columns are:
Empty fields first, then the Numeric fields from the smallest value (0) to the biggest value (%9),
followed by the fields in Alphabetic order.

Order Columns
choose Order columns

C:/ProgramData/ e JDATABASE/internalDataba
Order columns

Employee ID [1] (o]
Supervisor ID

Last Mame

First Name

Position

Birth Date

Hire Date

Home Phone

Extension F|

< Back H Finish H Cancel ]
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5.1.7 - Properties

i ] It is possible to review the configuration of the Database connection through the Database Menu
and selecting Properties.

Tool EeEIEEECE Wndow Help

Js Disconnect

2 Pefresh

L3 Properties

Ja| First record

s Previous record

s Mext record

e Last record

4 Insert record

2 Delete record

0 The Database Properties are mainly used to check the configurations of the connection. Do not
change them unless necessary.
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Connection Properties

Property Value

4 Connection
Timeout Il} secs E, i
Driver QMDB
Host
Port -1
Database C:/ProgramData .
Usermame
Keep credentials
Table Employee
ko5
Saved images format AUTO |~
Include Images in reu:urd'set
Database thumbnails
Requery on insert Auto |~

L Keen datahase nasitinn [ e v I E
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5.2 - Dockbar

6 The buttons in the Dockbar ease browsing between records and managing the Database.

® C d) —4) > ») |
Database Disconnect Database First Record Previous Ne xt Last Revert
Connect Database Refresh Record Record Record Record
Changes
iy . iy - N -
e -
Insert Delete Save
Record Record Record

5.3 - Database

(i ] As it is with cardPresso Document Objects the Database Fields can also be added to the card
Layout through Drag&Drop. These Objects will be connected to the Database Field and update when
the field in the database is changed or when moving between records.
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Chapter 6. Printing

i Printing your cards is the core function of cardPresso. Within this chapter we describe the
sewveral printing configurations cardPresso provides for printing and how those settings work with
your printer to achieve the best printing results.

To ensure that the finished card appears as intended you should understand basic printing principles
such as the resolution of your printer or the calibration and resolution of your monitor. These
specifications are provided by the printer manufacturer and in the display settings of your Operating
System.

Make sure you have the latest printer driver and firmware versions for the printer you have installed.

6.1 - Printing with cardPresso

O The computer you wish to print a card from must be connected either to a local, shared, or
network printer and be configured to use that printer.

1. Make sure that you've installed the correct printer driver for your printer.

2. o Click the Print Button, or choose File > Print.

3. If connected to a database (see more on Chapter 5. Database) you can use the Database
Selection options to select the records you want to print (see more on Chapter 6.1.1 Printing
With a Database):

4. Update record after print writes a user determined value in the selected database field of each
database record that is printed, after being printed.

5. Copies sets the number of copies to print for each print job / record.

6. Driver Options opens the Printer Driver properties of your currently selected printer. Set
additional printer driver options in your operating system. See your printer driver documentation for
details.

7. Print Operations allows you to select the operations you wish to run on each print job.

Click OK to start the print job with your currently selected options.
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Printer | g Microsoft XPS Document Witer .

Manufacturer Microsoft
Driver Microsoft XPS Document Witer

Driver Options L_JEJ

Database Print Operations
Selection: Print Front
Range [ Print Back

From Number of records

[ Selected Records in browse view

[ Conditional print

Update
O update Record After Print

Copies

Number of copies

oK Close Cancel
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6.1.1 - Printing With a Database

O Print jobs with large databases can be very lengthy and complicated. That's why cardPresso
provides you with several options you can use to your advantage to, making printing with large
databases a much simpler job.

6.1.1.1 - Printing a Database Range

O print Range allows you to choose a range of records within a database to be printed
automatically. This range can vary from one card to several cards.

1 - In the From field, select the starting point you want for your print job.
2 - In the Number of records, type the number subsequent records you want to print.

When selecting a range, you have 3 options to select which is the record you want to start to print
from:

Start Record starts printing from the first database record.
Current Record starts printing from the database record that's currently open.
Last Record starts printing from the last database record.

After selecting which record to start from, Number of records let's you choose how many
subsequent records you want to print besides the starting record

Database
Selection:

Range

From | Start Record | = | Number of records 1 =1

| Start Fecord i
O selectel | jrent record rV

[ Conditig Last Record

Eg: If selected From: Start Record, Number of records: 100 cardPresso would print all database
records ranging from 1 to 100.
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6.1.1.2 - Printing Selected Records in a Database

(i ] Selected Records in browse view lets you select which records to print, one by one, by
selecting them previously in the Browse Records window in Database View.

1- 0 Click the Database View button, or choose View > Database View

2 - Select the records you want to print on the Browse Records window, using the checkboxes.
3- o Click the Print button, or choose File > Print.
4 - Select the Selected Records in browse view option and click OK to print.

EEEE = He) K8l o) de ) o) o) o Ea) o)

Database C:/Prog /DA Database.mdb, y
Fecord Lof15 st 2 o
Employee Id | . Exter®)
mp B Printer = g Microsoft XPS Document Whiter : e
Bz Manufacturer Microsoft 3457
3 5 Driver Microsoft XPS Document Witer 3355
Ela 5 : — 5176
Driver Options| | X
=5 2 ‘ 2 L—] 3453
s 5 428
oz 5 Database Print Operations i
ek 5 selection: 2344
s s election: Print Front 452
10 2 [ Range [C] Print Back 7559
11 10 6261
Elz s Selected Records in browse view w5
[ conditional print ™

<
|select all| |select Mone.
[ .. |

Database C:/P Data/c [ Update Record After Print
Record 1 0f 15

Employee I1d

e

Supervisor Id Number of copies [1 2]

Last Name

[Davolie |

First Name

[senia |

Position ‘

ok || close |[ cancel
[sales

e e

0 In the image abowve the records to be printed are 3; 5 and 8.
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6.1.1.3 - Printing with Conditional Printing from a Database

© conditional Print lets you configure a print rule using a value from the database records. When
printing, cardPresso will search trough all records within the database and will only print the records
that comply to the rule you have configured.

1 - Select the database Column which contains the data to be validated.
2 - Select the condition that fits the print rule you want.

3 - Click OK to print only the database records that follow your print rule.

Database
Selection:
[ Range
[[] selected Records in browse view

Conditional print

Column | Employee ID | Is Mot Null

Is Equal

Is Mot Equal

Is Smaller

Update Is Smaller or Equal
Is Bigger

[J Update Record After Print Is Bigger or Equal
Contains

Mot Contains

Is Mull

Is Mot Mull

0 This option is only available in cardPresso's XL Edition or higher.
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6.1.1.4 - Update after Print

i Update Record after Print allows you to change a record to sawe relevant print information,
after being print.

By using your own text or one of the options available in cardPresso it is easier to mark in the
database the records that have been printed, the amount of cards printed for that specific record and/

or the print date of the last card.
1 - Select the Column wich you wish to update.

2 - Type the data you want to store, or choose one of the available options cardPresso provides.

Update
Update Record After Print
Column _ Employee ID _ Apply your text here or
name of your database column SPRINTSTATUS

SPRINTCOUMNTER
SPRINTDATE
SPRINTSTATUS&COUNTER
SPRINTSTATUS & COUNTERSDATE

6.1.2 - Copies
(i Number of copies lets you set the number of times each card will be printed.

Copies

Number of copies |1
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6.1.3 - Print Operations

O In the Print Operations you can find the print and encode tasks that occur in each print,
depending on the Card Type in use.

As an example, a CR-80 Card Type layout would only show the Print Front and Print Back
operations.

Print Operations

Print Front

[] Print Back

Magnetic Encoding

[[] Contact Encoding

[[] Contactless Operations

O e operations selected in this area are the only ones sent for printing.
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6.2 - Print Settings

O Printer Settings allows you to configure the basic layout settings of your card, configure Print
Options which adapt to your to your printing needs, and gives you access to your printer's Driver
Options.

0 To configure your Printer Settings, click File » Configure print or Ctrl+Shift+P.
1 Paper Size, selects the paper size supported by the chosen printer.

. Orientation, selects the orientation of your document. Landscape or Portrait.

'.' Print Options, shows you the current Driver Properties, select the Rendering, Advanced
options and the Overlay.

. Driver Options, opens the configurations of the currently selected Printer.

Printer ‘ = Microsoft XPS Document Witer O
Manufacturer Microsoft
Driver Microsoft XPS Document Witer ) ) :
Paper Size | Letter il . Raientptons

Dimensions 279.4 mm x 215.9 mm

Orientation ‘ || Landscape .
Print Layout Print Options .

card Model [ = crioo w3 . ] > Driver
3 | s @ a [
Dimensions 85.725 mm x 53.975 mm £ A ] . Black
( e “ e Antialiasing
Orientation | [ Landscape { ;
|- - : &3 =3 =3 > Composite black replacement
Columns 3 4 Advanced
&3 &3 i > Invert Driver Orientation
v 4 G  Rotate 180
Top Margin |0 mm ’Fl!p Hon_zontal
) » Flip Vertical
Left Margin |0.556 mm | > Use Colored Card
Vertical Spacing |0 mm L > Print Jobs
. 4 Overlay/varnish
Horizontal Spacing |10 mm | > Mode

OK
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O in this area you can choose which Printer you want to use, its Paper Size whether it is Letter
as used by A4 printers, CR-79, 80, 90 or any size recognized by the card printer and the card

Orientation.

Printer ‘ (=] Microsoft XPS Document Whiter

i

Manufacturer Microsoft

Driver Microsoft XPS Document Whter

Paper Size | Letter

Orientation

Dimensions 279.4 mm x 215.9 mm

[ | Landscape

(i ] To view the Printers installed on your computer and their Driver version click cP » Printer

Drivers.

fle window Help

About

Clear Config
USB Devices
License

view Folders
Printer Drivers

Language

»

Printer Drivers l ? G|
Printer Name Driver

CIAAT CTC-940 CIAAT CTC-940,1.4.0.5(2012/09/05)

CX-330 C%330,5.0.0.2(2010/05/20)

CX-7000 UL

Ccx-D80 C%D80,7.0.0.2(2010/06/10)

DIS DCP360 DIS DCP360i,5.0.0.2(2010/05/10)

EDlsecure DCP350 EDlIsecure DCP350,2.12.10.17(2012/10/17)

Evolis Badgyl Evolis Badgy1,2.12.1.246(2013/04/08)

Evolis Elypso Evolis Elypso,2.12.1.254(2012/03/09)

Evolis Primacy Evolis Primacy,2.12.1.254(2012/03/09)

Evolis Primacy (Copy 1) Evolis Primacy,2.12.1.254(2012/03/09)

4| 3

|View all cardPresso supported printers |Ibsture Defaults | Save Close

Printer Drivers
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6.2.2 - Print Layout

© The Print Layout settings change depending on the Card Model you choose. In its drop-down
list you can choose the Card Types available in your cardPresso Edition.

Printer { =!I Brother DCP-]315W Printer = ] s-\

Manufacturer Brother
Driver Brother DCP-)315W Printer

Driver Options L)_(.J

Paper Size l A4 T

Dimensions 297 mm x 210 mm

Orientation { || Landscape

Print Layout Print Options
Card Model | ™#= GenericCombo v > Driver
n 4 Rendering
Basic - !
- I Black
L I» Antialiasin
Orientation = CR79 ' ! 9
W] CRBD I Composite black replacement
columns | ... 4 Magnetic Encode
= CRS0
Common Card Types b Macros
Rows 51 CRE0 I Character encoding
i . 4
Top Margin | .. Generic Contact Card {Advanced. ) )
. I Invert Dniver Onientation
Left Margin | = Generic Contactless Card > Rotate 180
= HI-CO C .
Vertical Spacing | .- Mifare Classic : FSp Horenntl
I Flip Vertical
Horizontal Spacing |Contact » Use Colored Card
= GenericCombo > Print Jobs
= GenericCombo_2MagTrack 4 0verlay/vamish
*~ Generic Contact Card N Modey
*= 12C Card :
» JavaCard
=~ SLE4442
Contactless
= GenericCombo
= GenericCombo_2MagTrack I
Generic Contactless Card
= HI-CO Mifare Classic
15015693 Card
= LO-CO Mifare Classic
Mifare Classic
Mifare Desfire
Mifare Desfire NFC
Mifare Ultralight
Magnetic
— HI-CO 2Tracks R
— HI-CO El )

@ Different Card Models have different Print Layout settings.

In the case of paper printers the you can print multiple cards in one page. cardPresso provides you
with a simple grid system that you can modify to fit your printing needs.

Print Layout lets you choose the number of rows, number of columns, top margin, left margin,
vertical and horizontal spacing. As you can see in the image below.

1 card Model, selects your card type.
. Orientation, selects the orientation of your card in document.
. Columns, number of columns.

. Rows, number of rows.
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. Top Margin, left margin of your document.
. Left Margin, top margin of your document.
T vertical Spacing, ertical spacing between cards.

8 Horizontal Spacing, horizontal spacing between cards.

Print Layout
. Card Model | 2 CR80 b r3 w3
Dimensions 85.725 mm x 33.975 mm A A [
. ko ksl o
. Ori:—:-ntatiun| [ Landscape — . _
d ea ka [P
@ coumrs o=
e (] [
@ ros
. Top Margin|[} mm -::|
. Left Margin |[}.556 mm = :|
1  Vertical Spacing |[} mm = :|
Herizontal Spacing |1[} mm = :| 8
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6.2.3 - Options

© The Print Options section contains information and configuration settings on how the print job is
sent to the printer Driver.

Print Options

» Driver

» Rendering

> Advanced

» Overlay/Varnish

ﬂThe Driver section shows the basic driver info of the printer currently selected.

Print Options

4 Driver -
4 Manufacturer
Windows (R) Win 7 DDK provider
4 Mame
Matica Printer Driver
4Version
6.1.7600
4 Class
Matica Espresso
a Model
Matica Espresso
4 Print Class
WIN3Z2API

4 pPrint Test
Print Test

Crvnclarimn

O The Rendering settings allows you to configure advanced Black rendering options,
Antialiasing, and Composite Black Replacemet.
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Print Options

» Driver
4 Rendering
4 Black

| Separate Render

4 Antialiasing
| fes

4 Cémpusite black replacement
| Disabled

- Advanced
- Overlay/Varnish

Black, configures how the black color is sent to the printer. You can Send as RGB; Send as
Monochrome; Send as RGB and Monochrome; Send Composite; Send Composite and
Monochrome or send as a Separate Render (default option).

Antialiasing, lets you enable or disable Antialiasing for either the whole card, for Text only and for
Images only.By default, the option is active.

Composite black replacement, You can use composite black replacement with one of the
following options: Using the options available: Grayscale (Low, Medium or High), Color Decrement
(Low, Medium or High) Red Increment (Low, Medium or High).

Black, To obtain the desired results, you can submit the black in RGB; monochrome; RGB and
monochrome; composite; composite and monochrome and separate render;

Composite black replacement, You can activate composite black replacement, using the options
available: Grayscale (Low, Medium or High), Color Decrement (Low, Medium or High) Red Increment
(Low, Medium or High).

oThe Advanced section provides you with the following options.

Print Options
Advanced -
4 thate 120

| Mo
4 FIi:p Horizontal

| Mo
4 FIi:p Vertical

| Mo
a U%e Colored Card

| Mo
4 F‘r:iﬂtjt}bs

| All Print operation
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Rotate 180, Rotates the layout by 180° when sending the print job.
Flip Horizontal, Flips the layout horizontally when sending the print job.
Flip Vertical, Flips the layout vertically when sending the print job.

Use Colored Card, Sends the print job optimized for when your card is than white.
You can select from Black, Green and Yellow.

Print Jobs, By default the print job is sent as "All Print operations", in this case cardPresso
sends all print jobs whether each print job was successful or not.

With Card by Card cardPresso only sends the next card to be printed, after receiving a success
signal from the printer.

With Card by Card and Wait cardPresso sends the print job one by one, and waits for a user
input. cardPresso will wait for a user confirmation that each selected print job is successful before
sending the next print job.

Oove rlay/Varnish:

Mode: By default the Overlay is Disabled. Depending on the Printer in use it is possible to send the
Overlay Layout during the print job to the driver by saving it to an External file or directly to the
printer as Separate Page.

Print Options

» Diriver

- Rendering

> Advanced

4 Dverlay/Vamish
a Mode

: Disabled
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Chapter 7. Encoding

(i ] cardPresso's other core function is encoding. The process of encoding consists in converting

information from one format to another, and in the context of cardPresso, storing that information in
a card.

To that end cardPresso provides you with a dedicated workspace stocked with tools focused solely
on Encoding and managing the way information is sent to your card.

This workspace is called Encode View.

7.1 Encode View

6 The Encode View is where you view manage the encoded information in your card and the
encoding operations to be performed when encoding to your cards.

You can access it by clicking the Encode View button, or trough the menu View > Encode View.
This section gives you access to the various sections that manage the encoding process.

The Encode Data window shows the way data is stored in each card.
The Data Inspector window shows the data currently being browsed in the Encode Data window.

The Encode Operations window shows the encode commands that run when the card is encoded.

The Properties window, to the right, has its own set of options in the Properties section which
provide you with convenient information and tools to make Encoding fast and easy.

W fle View Database Window Help
EEERE LSS AN - TEEEEER BB
X M) B B &9

Database
.

. 3 El Table Employee
Mifare Classic 1€ Contactless encoders | OMNIKEY Cardman s:21-cLo -] (2(@) 8 st

Record 1 of 15

- > Sector 1 card timeout=30;// maximum waiting time for the card to be pre: E] B
> Sector 2 o R DU atea it umig pAntang Sach card ot b diffrent rom the previous Employee Id B
> Sector 3 =

() " Sectors . 14
> Sectors card waitForPresent("MIFARE.CLASSIC"); S supervisorid

» . :22::3 log(*MEDIA TYPE:"+card.mediaType); = sE

Iog("MEDIA S/N :*+card.U
Sector 8 I0g("MEDIA S/N reversed:*+card.UID_LSB );
§ > Sectors
T > Sector 10 (Davolio
> Sector11 1/ TIP:SAVE MIFARE SERIAL NUMBER ON DATABASE RECORD
> Sector12 1/1) choose the database Dockbar,
> Sector13 112) drag the field where you want to save the serial number and drop over the line below First Name
= J/=> currentRecord.?=card.UID;currentRecord.save() g
5 onia
4 Sector 15 =
Elacka // TIP:UPDATE CARD FIELD. Position
Block 1 1/2) choose the preview Dockbar,
112) drag the feld where you uwant to update the serial number and drop over the line below [Salls Representative |
Block 2 1/=> item.7=card.UID: SR
<(Trailer 15,

Last Name

Birth Date
1972/12/08 (00:00:00) [%]
1/1n this encode area there are samples for the usage of the Mifare cards, such as,
/I howi to write and read a Mifare card in Hire Date
Contactless | Output [1991/03/29 (00:00:00) ]

Home Phone

- (206)555-9857 ]
Mifare Classic:Trailer 15 Extension
Block Hexadecimal ETH
9 S15803

Photo

Continuous Read

Notes

a member of astmasters Intemational.
(]

| e

7.2 - Encode Data

(i ] The Encode Data window is a visual representation of the way information is stored in your
card. It allows you to easily browse the card for a quick access to the information stored.
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You can find it by clicking the Encode View button.
Different Card Types have different types of Encode Data organization.

Here is an example of the Encode Data window of a Mifare card:

2 Mifare Classic 1K
= Sector O
Sectorl
Sector 2
Sector 3
Sector 4
Sector 5
Sector 6
Sector 7
Sector 8
Sector 9
Sector 10
Sector 11
Sector 12
Block 0
EBlock 1
Block 2
< Trailer 12
Sector 13
Sector 14
Sector 15

*
[*
El
[
[+
#
*
El
[
[
[+
]

7.3 - Data Inspector

0 The Data Inspector window shows you the data currently stored on the item you select on the
Encode Data window and allows you to manipulate the stored data. This gives you a quick
reference of the data stored in your card and eases the workflow while working on your Encode
Operations.

You can find the Data Inspector window by 0 clicking the Encode View button, or clicking View
> Encode View.

The information shown on Data Insnector also chanaes denendina on the Card Tvbne.
The Data Inspector window organizes the information stored in your card in 3 columns:
Block shows the card block currently selected in the Encode Data window.

Hexadecimal shows the hexadecimal value of the data currently stored on the selected card block.
If the user has changed the value using the Edit button, it will show the new value entered by the
user)
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ASCII shows the value of the Hexadecimal field in regular text format.

Here is an example of the Data Inspector window of a Mifare card where we wrote the hexadecimal
value for the word "cardPresso":

Mifare Classic:Block 2

Block Hexadecimal ASCI
S00B02 {536FEER961204461766FECE96F000000 ¢ Sonia Davolio...

Continuous Read

(i ] The Data Inspector window comes with a set of tools that allow you to quickly view and modify
the data stored in your card:

The Edit button allows you to directly modify the information stored in the item currently selected in
the Encode Data window. The Edit button works with Hexadecimal values.

The information will only be written in the card when you press the Write button.

Hexadecimal

|SBEFEEEQEIIDﬂ-ﬂ-El}'EEFECEQEFDDDDDD

ASCI

|Sonia Davolio... |

[ oK H Cancel

The Read button allows you to read the information stored in the item currently selected in the
Encode Data window.

The Write button writes in the card the value currently visible in the Hexadecimal separator of the
item currently selected in the Encode Data window.

The Continuous Read button makes cardPresso repeatedly read the data in the currently selected
item every two seconds.

This allows you to perform seweral write functions in the Encode Operations window and
immediately see the results on the Data Inspector window.
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7.4 - Encode Operations

0 The Encode Operations window is where all the code that manipulates how the information
pertaining your cards is written into the cards. You can program and test all the encoding actions
you want before printing trough this window.

You can find the Encode Operations window by o clicking the Encode View button, or clicking
View > Encode View.

The actions written here will then occur each time the card is encoded.

Here is an example of the Encode Operations window of a Mifare card type:

Contactless encoders | OMMNIKEY CardMan 5x21-CL 0

]

J{ The Mifare UID is read in Hexadecimal and ordered by the MSE "Most significant Bit"
{reading the bits from left to the right)

Jf cardPresso reads the UID using » card.UID

J{ to read the UID in LSBE "Least Significant Bit" use » card.UID_LSE

J{ to read the UID in Decimal {0-9) use » parselnt{card.UID, 1)

/i Mifare cards have 2 keys: A and B, normally the keys are all 'F

J{ f there is a » Error: mifare:Error readMifare:PSSC ERROR:6982:Security status not satisfied
Line:XX « this means that the key is wrong.

J{ The comand below sends an all 'F* key 'A'

mifare.key("A" "FFFFFFFFFFFE");

Ji Read and Whte to a Block of the card

Ji write to HEX in sector X block ¥
Himifarewrite(X,Y,"54657374207772697465000000000000", "HEX");

Ji from the connected Database
Jimifarewrite(X.Y, currentRecord["Hire Date"].toString()):

/i Simple text write
mifare.write(5.2,"cardPresso");

Contactless | Output @

52869735

i ] By default the Encode Operations window comes with some commented basic sample code to
get you started on the most common Encode Operations of the selected card type.

If a line is commented the code it contains will not run under any circumstance. To run you must
remove the comment tag ( // ) in the beginning of the line).

In the previous example the line containing the code "mifare.write(5,2"cardPresso");" is the only
one that will run because it's the only code line that is not commented.

- . — . -~ an ' ' er TN -
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7.5 - Properties

© The Encode View also has it's own set of Properties tabs located as usual to the right. It
provides you with several separators which contain convenient information about your card, your
printer, your users, your database and scripts. All with more tools to make your Encoding

Operations even smoother and easier to implement.

You can find the Encode View Properties tab by 0 clicking the Encode View button, or
clicking View > Encode View.
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HEEE & BE &

Database

Prewiew

B Table Employee
Record 1 of 15

S5

Employee Id
| 1

Supervisor Id

Last Name
o
m .
- |Davul|u |
]
-
v
O Arst Name
& |Sunia
e [EaiE |
=
¥ Position

|Sales Representative |

Databas

Birth Date
11972/12/08 (00:00:00) =

se Find

Hire Date
|1991;u3;29 (00:00:00) }%|

Databas

Home Phone

(206)555-9857 |

Extension
|5467

Photo

Motes

i a member of Toastmasters International. |

= |
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7.3.1 - Preview

© The Preview tab provides you with a quick overlook on the card design. You can swap between
the front and the back of the card design preview by clicking the Front button and Back button
respectively.

You can find the Preview tab by 0 clicking the Encode View button, or clicking View > Encode
View and clicking the Prevew tab on the right .

=

o

-

o

[l

o

=

a SHOPPING
|E -\_r' £
.

@

url

= 3;
o

n_

e e

]
]
m
O
b
L5}
3

Front Back

Database

7.3.2 - Printer Tools

© Printer Tools are a powerful set of tools that allow you to manually navigate your card inside
your printer (in printers that support these functions) so you have more control over how your printer
uses your card while writing your Encode Operations.

The available printer tools vary with the printer modules installed on your printer.

You can find the Printer Tools tab by o clicking the Encode View button, or o clicking View >
Encode View and clicking the Printer Tools tab on the right .

Insert card from card input feeder inserts a card positioned in the printer input feeder into the
printer circuit.

Insert card manually allows you to manually insert the card directly in the position you desire.

Position card at contact encoding unit moves the card from its current position to the contact
encoding unit.

Position card at contactless encoding unit mowes the card from its current position to the
contactless encoding unit.

Move card out of contactless encoding unit moves the card out of the contactless encoding unit.

Eject card to dispenser unit moves the card from it's current position to the card dispenser unit.
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Eject card to reject unit moves the card from it's current position to the card dispenser unit.
Magnetic Encoder allows you to read the content the 3 tracks of a magnetic card.

Direct Commands allows you to send commands directly to the printers who support this feature
(please refer to the printer manufacturer for a list of supported commands).

=
2
L

@ ||| Evolis Primacy
o

B

o

2 N G

L.

g

c

: Bagg

Magnetic Encoder:

User Data

| IS0 Encoding

Track 1

Track 2

Track 2

| Read

Database

@
=
T

Q

"

m
0

m
a

m
O

Direct Commands:

| -] (Send]

Database Find

0 These options work only with printers that support commands.

7.3.3 - Database

0 The Database separator works Encode View exactly the same way as in the other views. You
can browse your records, edit them and drag them into the Encode Operations window. Making
your work with Encode Operations in cardPresso even easier and faster!

You can find the Database tab by o clicking the Encode View button, or Q clicking View >
Encode View and clicking the Database tab on the right.
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EEEE S 58 B

Database

Preview

B Table Employee
Record 1 of 15

il

Employee Id
[ ]
| 1

Supervisor Id

| s

Last Name
k]
m .
= |Davul|u |
i}
I
]
O First Name
@ |Sonia |
= [SEULEl
=
M Position

|SE|IE-5 Representative |

Databas

Birth Date
11972/12/08 (00:00:00) =

Hire Date
11991/03/29 (00:00:00) |

se Find

Databas

Home Phone

(206)555-9857

Extension
|5467

Photo

Motes

i a member of Toastmasters International. |

b | B4
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7.3.4 - Database Filter

@ Database Filter is yet another strong tool that makes the work-flow on Encoding Operations
much smoother and faster in cardPresso.

You can apply Database Filters on cardPresso so you only see the records with the information
that matters the most to you. Making browsing database records a much easier and cleaner task.

You can find the Database Filter tab by clicking the Encode View button, or clicking View >
Encode View and clicking the Database Filter tab on the right .

To do so, simply select the column which contains the data you want to filter.

Select the condition to filter which matches your needs.

Insert the value you want to filter

Select Add Condition and click Apply (You can add more filters by selecting And or Or).

Now when you browse your database records on the Database tab, only those that follow the
condition will show.
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Database

Prewview

Table Employee
Record 1 of 15

Conditions,

i
8
|_
| .
L]
o
=
=
o

|Pumﬂun

| Is Equal {=)

'Sales

Lser Data

| And

| Extension

Database

| Is Equal (=)

15467

| Add Condition ...

Database Filter

SQL:

“Position” = 'Sales' AND " Extension” =
5467

Database Find

Reset | Apply

7.3.5 - Database Find

(i ] Database Find is a quick reference tool that lets you find specific values throughout your
database.

You can find the Database Find tab by clicking the Encode View button, or clicking View >
Encode View and clicking the Database Find tab on the right .

Select the Column in which you want to find a value.
Select the condition that fits your situation.
Insert the value you want to search for.

Use the buttons to navigate trough the records which comply with the condition.
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Found in record:5

7.3.6 - Script

% Database

=

=

=™ Record 5 of 15

P Teble Employee

a]

'TD_ Find,

E 5

f= l Employee ID | v |

o \
[ Is Equal | v |
|5

6 The Script separator is the Document script and contains all the code you might have added

before. See more on Chapter 4.4.12 - Script.
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Chapter 8. Users

@ when working with multiple collaborators, managing and providing select permissions to each
individual becomes crucial.

Users is yet another powerful management tool provided with cardPresso to help you specifically
with user management, allowing you to limit who can access cardPresso and what they can do.

Users provides you with tools that allow you to create and manage user logins for cardPresso. This

gives you full control over who has access to cardPresso and what they can do. With the added
ahilitv tn create arniine mananina larne niimhere nf 1icere hearnmes ac cimnle ac a <inale elick

8.1 - Users View

© The Users View gives you access to all the tools that allow you browse, add, remove and edit
Users and Groups. It also gives you access to an oveniew of all their operations and an additional
option to print customized audits.

You can access the Users View by clicking Window > Users View:
The Users View is separated in 5 smaller sections:

The Users View Toolbar provides you with the basic tools to add and remove users, add and
remove groups and print audit reports:

% Audit Report Prints an Audit Report for different files formats.

-.0 Add User Creates a new user.

-.0 Remove User Removwes the user currently selected in the Users section.
‘(-.0 Add Group Creates a new group.

‘(-.0 Remove Group Removwes the user currently selected in the Users section.

T'CJ) Refresh Views Reloads the users database on the Users View.
uf

© The Users section located in the top left of the Users Vew shows a list with all the users you
currently have configured in cardPresso.
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Users
Login Name
ADMIN Administrator
JOADLUCAS |odo Lucas
MUMOMARTING  MNuno Martins
PEDROSOUSA Pedro Sousa
RUIFARIA Rui Faria
SARANVAT Sara Vaz

O e Groups section shows you a list with all the groups you currently have configured in
cardPresso and it's respective users.

Groups
Group Name Users
ADMIN Administrators ADMIN,RUIFARIA

PRINTOMLY Print Only
VIEWOMNLY  View Only

PEDROSOUSA,SARAVAL
JOAOLUCAS NUNOMARTING

The Auditing section is located in the bottom half of the Users View and it shows a list of all the
actions performed by each user.

© You must first enable auditing for the intended users in the User Properties tab by editing the
user (see more on: Chapter 8.2.5 Edit a User).

Auditing

Date Computer Location Operation User Document | Description | Event Result
2013-12-16 13:17:01 CPPEDROSOUSAPC Users View ADMIM
2013-12-16 13:16:59 CPPEDROSOQOUSAPC MNew Document  ADMIN Documentl
2013-12-16 13:16:57 CPPEDROSOUSAPC Welcome view ADMIN
2013-12-16 13:16:52 CPPEDROSOUSAPC Refresh Views ADMIN
2013-12-16 13:15:55 CPPEDROSOUSAPC Users View ADMIN
2013-12-16 13:15:51 CPPEDROSOUSAPC Welcome view ADMIN
2013-12-16 13:15:42 CPPEDROSOUSAPC HQ Exit PEDROSQUSA
2013-12-16 13:15:41 CPPEDROSQUSAPC HQ Save Document PEDROSOQUSA Cardl
2013-12-16 13:15:30 CPPEDROSQUSAPC HQ MNew Text PEDROSOUSA Documentl
2013-12-16 13:15:23 CPPEDROSQUSAPC HQ MNew Text PEDROSOUSA Documentl
2013-12-16 13:15:17 CPPEDROSQUSAPC HQ MNew Text PEDROSOUSA Documentl
2013-12-16 13:15:15 CPPEDROSOQOUSAPC HQ New Document PEDROSOUSA Documentl
2013-12-16 13:15:12 CPPEDROSOQOUSAPC HQ WVelcome view PEDROSOUSA

The Properties tab is located as always to the right of the Users View. It's contents also change
depending on what you are currently doing, whether it's adding new users and groups or editing their
respective settings, all the information is shown and edited here.
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o EDIT USER
5
Login ADMII
g -
L Name Administrator
a
5 Password 2900000000000 00

Cenfirm Password 99 0000000000000
[ Disable user (cannot login)
Enable auditing

LN
o
[i1]

OAbove is the properties tab while a user is selected.

8.2 - Users

O A User system is a combination of a user name and a password and, if enabled, are required to
access cardPresso. The user name and password identify each person that accesses cardPresso
and determines what they can or can not do within cardPresso by attributing each user with its own

set of permissions.

8.2.1 - Enabling User Logins

O The first step to work with users is enabling user logins. You can do this by accessing the Users
View by clicking the cardPresso menu Window > Users View and in the bottom of the window

clicking the Enable user logins checkbox.

The first time you enable user logins, you will be prompted with the default user name and
password.

The default user name is ADMIN and the default password is admin:

This information will only appear once.
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On the next time yourun
software you will be asked to enter your
username and password.

}'. The default user name is ADMIN and the
~ default password is admin.

| Close

Enable user logins

8.2.2 - Login

O After enabling users logins, when you open cardPresso you will be required to enter the login
credentials on the welcome screen.

Simply type the credentials and 0 click the OK button.

User Name [ADMIN |

o

P>
- Password |@@00® |

Change Password oK Cancel

Every user that is created can login in this fashion.

8.2.3 - Add User

O with user logins enabled the next step to managing your users is adding them. You do this by
clicking the Add User button found in the Users View Toolbar.

Doing so will open the new user options in the properties tab where you will be prompted to fill
various fields required to create a new user:
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ADD USER
Login PEDROSOUSA

MName Pedro Sousa

Password L1111
Confirm Password @@ e e@®

|’ User Properties |

[ Disable user (cannot login)
[ Enable auditing

Save

Login: Write the username the user must insert when logging in cardPresso.
Name: Write the name of the owner of this username.

Password: Write the password the user must insert when logging in cardPresso.
Confirm Password: repeat the password to validate it.

Diable user (cannot login): The user won't be able to log in cardPresso until this option is
disabled (unchecked).

Enable auditing: Every user action within cardPresso will be recorded and \isible in the Auditing
section.

0 Click Save to sawe the new user. It will then be available for editing in the Users section.

O A new user will have no permissions until assigned to a Group (see more on Chapter 8.3.2 Add
Group).

8.2.4 - Remove User

O keep a clean and up to date user base you can remove Users that are no longer needed by
selecting the user you want to remove and clicking the Remove User button found in the Users
View Toolbar.

If a user is removed its user name and password will no longer work when logging in losing all
access to cardPresso.
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Lsers

Login Name
ADMIN Administrator
JOAOLUCAS Jodo Lucas
MUMNOMARTING  Muno Martins

[PEDROSOUSA  Pedro Sousa | Do you want to delete

RLIEARLA, Bui Faria user PEDROSOQUSA, 7

Delete uzer

SARAVAZ Sara Vaz Yag ' Cancel

0 Removing a user is a permanent action that cannot be undone.

8.2.5 - Edit a User

6 cardPresso
To edit an existing User select the user you want to edit in the Users section on the Edit Vew:
Users
Login Name
ADMIM Administrator

JOAOLUCAS Jodo Lucas
MUMNOMARTING  Muno Martins

RUIFARIA Fui Faria
SARAVAS Sara Vaz
TEST test

Once selected, the user's data will be editable in the properties window to the right:

@ EDIT USER
5

& Login PEDROSOUSA

o Name \Pedro Rocha |
a

5 Password 000000000000008

Confirm Password (@ @ 0000000000000 |
[ Disable user {(cannot login)
Enable auditing

Save |

When done editing, to save the changes o click the Save button.

o _ - .
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8.3 - Groups

O cardPresso adds Groups to its User management system to ease editing large numbers of
users.

Here you can add Groups and select each group's specific permissions and assign them to multiple
users.

When a User is assigned to a Group, it inherits all the permissions the Group currently has. Every
change to the group's permissions affects the permissions of all the users assigned to it.

0 A user with no group assigned will have no permissions.
8.3.1 - Add Group

O 0adda Group 0 click the Add Group button found in the Users View Toolbar.

Doing so will open the new group options in the properties tab where you will be prompted to fill
various fields required to create a new group:
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g ADD GROUP
g
a

Grou
EEL p | |
o MName | |
o
S .
o Location | |
{0
— Users

] ADMIN Administrator

[[] JoAOLUCAS  |odo Lucas
[] NUNOMARTINGS MNuno Martins
[] PEDROSOUSA Pedro Sousa
[] RUIFARLA, Fui Faria

[] SARAVAZ Sara Vaz

Permissions

4 Design

» ] File

» O] Edit

» View

» [0 Tool

» Help
4 Database

; Database
4 User Logins

» ] Users
4 DockBars

» Document

» Users

Group*: Write the uniqgue name cardPresso will use to identify the group.
Name: Write the name of the Group for easier identification.
Location: Write the name of the location/department/category of the users assigned to this group.

Users: Select the Users that belong to this group.

eOne user can belong to more than one group.

Permissions: Select the permissions that the users assigned this group will have.

0 Click the Save button to save the group with the selected settings.

*required field
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8.3.2 - Remove Group

(i ] If a group is no longer needed you can remowe it by selecting the Group you want to remove and
clicking the Remove Group button found in the Users View Toolbar.

If a group is removed all users assigned to it will lose all permissions the Group had.

Groups
Group Name Users
ADMIN Administrators ADMIN,™
EDrons edtors  peoggf U
PRINTOMLY Print Only SARAVA
VIEWONLY  View Only JOAOLU

Do you want to delete
the group EDITORS ?

Yes || Cancel

(i ] Removing a group is a permanent action that cannot be undone.

8.3.3 - Edit a Group

6 To edit an existing Group select the group you want to edit in the Group section on the Edit

Vew:
Groups
Group Name Users
ADMIN Administrators  ADMIM, RUIFARIA
PRINTONLY Print Only SARAVAZ
VIEWOMNLY  View Only JOACLUCAS NUNOMARTING

Once selected, the groups data and permissions will be editable in the properties window to the
right:
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a EDIT GROUP
£
1] e ~

Grou E OR5
% P ED R
o pMame Editors
5
o Location |HD
0]
 Users

[ aDMIM Administrator

[[] JoADOLUCAS  Jodo Lucas
[ NUMNOMAFRTING Muno Martins
PEDROSOUSA Pedro Sousa

[] RUIFARILA Fui Faria
[ saRaVAZ Sara Vaz
[] TEST test

Permissions

4 Design

» File

> Edit

» View

> Tool

> Help
4 Database

- Database
4 User Logins

» ] Users
4 DockBars

> Document

» Users

When done editing, to save the changes click the Save button.

OOnce created, the user Group field cannot be edited.

8.4 - Auditing

O The Auditing section in Users View is where you can see every action performed by any user
in cardPresso.

To audit a user you must first Enable Auditing for the intended user in the User Properties tab by
editing the user (see more on: Chapter 8.2.5 Edit a User).

After enabling auditing for a user every future action that user performs in cardPresso is registered
and listed in the Auditing section
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Auditing

Date Computer Location Operation User Document = Description
2013-12-16 20:12:35 CPPEDROSOUSAPC Users View ADMIN
2013-12-16 20:12:32 CPPEDROSOUSAPC Welcome view ADMIN
2013-12-16 20:12:22 CPPEDROSOUSAPC HQ Exit PEDROSOUSA
2013-12-16 20:12:15 CPPEDROSOUSAPC HQ Save Document As PEDROSOUSA Sales Card
2013-12-16 20:11:59 CPPEDROSOUSAPC HQ Save Document PEDROSOUSA MyCardl
2013-12-16 20:11:33 CPPEDROSQUSAPC HQ New Rectangle PEDROSOUSA MyCardl
2013-12-16 20:11:49 CPPEDROSQUSAPC HQ New Circle PEDROSOUSA MyCardl
2013-12-16 20:11:37 CPPEDROSOUSAPC HQ New Image PEDROSOUSA MyCardl
2013-12-16 20:11:34 CPPEDROSOUSAPC HQ Browse Image PEDROSOUSA MyCardl
2013-12-16 20:11:31 CPPEDROSOUSAPC HQ Delete PEDROSOUSA MyCardl
2013-12-16 20:11:28 CPPEDROSOUSAPC HQ Open Document PEDROSOUSA MyCardl
2013-12-16 20:11:22 CPPEDROSOUSAPC HQ Welcome view PEDROSOUSA
2013-12-16 20:11:09 CPPEDROSQOUSAPC Exit RUIFARIA
2013-12-16 20:11:05 CPPEDROSOUSAPC Save Document RUIFARIA MyCardl
2013-12-16 20:10:53 CPPEDROSOUSAPC Connect to database RUIFARIA Documentl
2013-12-16 20:10:47 CPPEDROSOUSAPC Delete RUIFARIA Documentl

8.4.1 - Audit Report

© For an easier view purposes cardPresso allows you to print or export customizable Auditing
Reports.
You can do this by clicking the Audit Report button on the Users View Toolbar.

Doing so will open the Audit Report editor window, where you can customize your reports before
printing or exporting them to files.

© 2014 cardPresso, Lda



Audit Report

“ cardPresso Manual

From date

To date

From time
To time
Computer
Location
Operation
User
Group

Document

Description
Event Result
Order

Report model

Output to

|=k

101-01-2000 |
131-12-2100 |
100:00:00 A
23:59:50 A
[AII Computers Y]
| All Locations v |
[ All Operations | » I
[AII Users f‘
[ All Groups | » I
[AII Documents f_|

|

|

*

eventDate

[
| auditMode
[

PDF File
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Appendix A - XXL Net License

(i ] The cardPresso XXL Edition includes the Net License Service. This senice allows you to use
the same license in 16 different computers connected to the same Local Area Network (LAN).

To use this senice, one computer must have the cardPresso XXL Edition USB dongle and be
connected to the same LAN as the other computers. When the Net License senvice is activated on
this computer, it acts as Server and provides the license to a total of 15 computers connected to the
same LAN.

eThe cardPresso Net License Service only works on a LAN. It does not work trough the
internet.

use (DD
=
| [

-l

Switch —
10.10.10.X

10.10.10.X

(i ] For best results, the computer with the Net License Service should have a Static IP Address.
The computer acting as the Net License "Sener" does not need to havwe a Sener type Operating
System.

To ensure the Net License Service is always available to the other computers, the USB dongle
should be connected to a computer that computer that is either always turned on, or at least when
the other computers require the Net License Service.

Appendix A.1 - Installing the XXL Net License Service

0 To install cardPresso's Net License senice please do the following:

1 - Install cardPresso on the computers but without the service.
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Please select installation folder or choose Evaluate to
run program without installation

Install in programs folder

M Install security service

M Select destination folder

Install for all users

2 - In the computer that will run the service and act as the server, open the cardPresso menu

cP>cardPresso License

F|Ie Window Help

About

Clear Config
USE Devices
Lincese
View Folders
Printer Drivers

Language

3 -In the cardPresso License window, click the Net tab click on the Run as Application button:
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USE Met

License server

security service not installed

Fun as Application § Install as Service

Close

O on systems using Windows Firewall, a warning will pop-up, please allow the cardPresso

connection trough the Local Area Network.

O some Firewall applications will not show any warnings and automatically block the License
Seniice, the required permissions are at the end of these instructions.

This will open a command line window which will show you if the ports are open and if a cardPresso

application is running in the network.

cardPreszso — License Seprvice 1.0.38
C Pre 12-2813
“1

MetBios not
securityServ

USBnotifications ad:
~%_bin.begin

securityDevi vddFile

securityle ddUolumeFiles:F
USBnotificationsThread: :ENUM.checkH

ection accepted:z1?2.168.2.136
C_enumerateDevices:

Client Computer
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In this example

192.168.2.138 is the Host computer acting as a Net License server, providing the license.
192.168.2.136 is the Client computer receiving the license.

4 - Close the cardPressolLS.exe window and click Install as Senice

usB Met

License server

security service not installed

Fun as Application Ilnstall as Service|

Close |

5 - Run the senice and confirm it's running.

usB Met

License server

security service is not running

Uninstall

d

Close
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USBE Met

License server

[ securty service is running ]

| Close

6 - In the License Senice Client Computer use the default configurations or change it based on your
networks characteristics.

Use MNet

License server browser

[ Use Windows WANS and _ _ _ __ _ NE -
Use Windows VWNS
Use Windows WINS and __ _ _ _ _ MENS

Use known static address

Disable .
v — Apply

Close -

Now you can have up to 16 computers in your Local Area Network, including the one acting as a
server, running cardPresso XXL edition.

0 If cardPresso doesn't automatically detect the license in a Client computer, open a command
prompt window (Start Menu > Run> cmd.exe) type "ping CARDPRESSO _LS" and hit return.

If the host isn't found as shown above, please confirm that it is in the same Local Area Network, and

if so, open a port in the firewall for:
CPSECURITY_SERVICENAME "CARDPRESSO_LS"
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CPSECURITY_SERVICEPORT 1947
(TCP to communicate and UDP for the name)

If the ping requests an answer from an IP address that doesn't belong to the Local Area Network and
has no answer, retest the ping after rebooting the Router and/or use a different router.

i Warning : If the License Senvice is added (Step 3) to multiple computers, a License Senvice
"cluster" is created and it will drown the real License Server.

Also, the Net License uses WINS or NetBios to assign the License to the client computers.
Therefore the License won't be assigned to a cardPresso application outside the WINS or NetBios
range.
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Appendix B - Advanced Print Operations

@ cardPresso contains several advanced features to provide you with the flexibility required to
adapt to any circumstance.

In this chapter we will show you an oveniew on which features are available, how they work, and how
to best use them to make your printing jobs simple, fast and most importantly, exactly the way you
want them.

Appendix B.1 - Overlay

i By default cardPresso uses the printer's default overlay pattern. However cardPresso also gives
you other options regarding how you work with the Overlay ("O" Ribbon).

You can access the Owerlay options trough the cardPresso menu File>Print Settings,
cardPresso gives you three options:

1 - Separate Page lets you design your own Owerlay with cardPresso's Design Vew.

2 - External File lets you design an Owerlay within cardPresso so later when printing it can be used
trough your printer's driver settings.

3 - Use the printer's default default overlay pattern by disabling cardPresso's overlay customization.

Important notes regarding how printers work with
Overlay:

@ Printers which support overlay printing have their own owerlay settings. These settings override
cardPresso's.settings. This means the printer's settings determine if the overlay is printed or not,
regardless of cardPresso's configuration.

You can your printer settings find them on your Printer Options trough the cardPresso menu
File>Print Settings, Driver Options button.

© cardPresso can only print overlay if the printer being used supports owerlay ribbons, has an
overlay ribbon installed and has the overlay option enabled in it's own Driver Options.

O if the overlay option is Disabled in cardPresso but the printer Driver Options have owerlay
enabled, the printer will still print overlay.

O fan owverlay option is enabled in cardPresso but the printer Driver Options have overlay
disabled, the printer will not print overlay.

o prevent unintentional Owerlay printing, we recommend disabling the Owerlay printing option on
i Iy i ional Overl inti d disabling the Overl inti i
your printer driver settings while designing your Owverlay. Enabling it only it when you are ready to
print.

Appendix B.1.1 - Separate Page Overlay

O One of the ways cardPresso allows you to customize your own Overlay is by providing you with
a separate page within cardPresso where you can design your Owerlay the same way you design
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your cards.

This option is found trough the cardPresso menu File>Print Settings, Print Options>Overlay/

Varnish>Mode>Separate Page.

When this option is selected, below it, you will have access to another setting:

Side: Lets you choose the side of the card where the Owerlay is to be printed. You can choose

either Front or Back.

Print Options

» Driver
: Rendering
4 pdvanced
» Inwvert Driver Orientation
» Rotate 180
: Flip Horizontal
: Flip Vertical
» Use Colored Card
- Print Jobs
4 Overlay/Varnish
4 Mode

Separate Page

4 5ide

Front

Once Separate Page is enabled, cardPresso will display an Overlay/Varnish tab in the bottom

left corner of the Design View as shown highlighted in the image below:
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* fle Edit View Tool Database window Help

mi

iEBER-=om[ E

i
—
I

© [0

[

[

l Design | overlayivamisn Il [N

mEESEE Ac8E AAK &

Background

=
o
o
O

)

{ All classes

62 Backgrounds found, 0 folders remaining

When you click this tab you will have all the design tools cardPresso provides to design your own

Ovwerlay.

ﬁ The Overlay/Varnish page can only be printed with the Overlay Ribbon.

Appendix B.1.2 - External File Overlay

6 External file lets you design an Overlay within cardPresso and then export it as an image file so
you can open it trough your printer's driver configuration. This way your printer will print all images
with the selected image as the Owerlay design.

This option is found trough the cardPresso menu File>Print Settings, Print Options>Overlay/

Varnish>Mode>External File.

When this option is selected, below it, you will have access to more settings:

File: Lets you save your Overlay/Varnish design to a .bmp file, to later be used by your printer

driver when printing.

Side: Lets you choose the side of the card where the Overlay is to be printed. You can choose

either Front or Back.
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Print Options

[> Driver
I Rendering
4 Advanced
I Inwert Driver Orientation
[ Rotate 180
i Flip Horizontal
i Flip Vertical
i Use Colored Card
i Print Jobs
4 Overlay/Varnish

llaries,l'My Pictures/Overay.bmp [;]!
4 Side

Front v il

Once External File is enabled, cardPresso will display an Overlay/Varnish tab in the bottom left

corner of the Design View as shown highlighted in the image below.

You can then open the Overlay/Varnish tab and use cardPresso’s design tools to design your own

Owerlay.
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* fle Edit View Tool Database window Help

Background

=
o
o
O

62 Backgrounds found, 0 folders remaining

l Design | overlayivamisn Il [N

After you finish designing your Owerlay in the Overlay/Varnish tab, you can use the Overlay File
button in the Print Options shown abowe to save your design to a .bmp file.

Once the file is saved, you can use the Owerlay settings on your Printer Driver settings to open the

Appendix B.1.3 - Printer Default Overlay

6 By default the printers which support Owerlay have their own Owerlay design. The third (and
default) Overlay Mode option is Disabled. When this option is selected cardPresso lets the printer
use it's default Owverlay design.

This option is found trough the cardPresso menu File>Print Settings, Print Options>Overlay/
Varnish>Mode>Disabled.

When this option is selected, no more options are available and cardPresso will not send any
overlay designs to the printer.

When printing, the printer will either not print overlay if the option is disabled on the printer settings,
or it will nrint overlav usina it's default desian enabhled on the nrinter settinas.

Appendix B.1.4 - IDP SMART 50 Overlay Settings

6 The way the IDP Smart 50 printer works with Owverlay requires the following configuration:
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Print Options

- Rotate 180 -
 Flip Horizontal
 Flip vertical
- Use Colored Card
- Print Jobs
4 Qverlay/Varnish
4 Mode

External file

 File
- Side
4 Format

24-Bits per pixel

The RGB value of objects in a “user defined mask” is the factor that SMART uses to distinguish
which panel is used.

R value is for the Owverlay (O) panel

G value is for the printing (YMCK) panel

B value is for Fluorescent (F) panel.

Value “0” means ‘activated’ and value “255” means 'deactivated'.

0 Examples:

- Blue = RGB(0, 0, 255) : printing and Owverlay

- Pink = RGB (255, 0, 255) : printing only

- Black = RGB(0, 0, 0) : printing, Overlay and UV printing
- Red = RGB (255, 0, 0) : printing and UV printing

Appendix B.2 - Web Print Server

© The Web Print Server alllows you to remotely print cards from a computer that doesn't have
cardPresso installed.

To use the WebPrint Server you are required to:

1 - Have a computer with cardPresso XXL Edition connected to a working local area network (LAN
or Internet) to act as the Web Print Server.

2 - Have another computer (Client Computer) connected and to the same local area network (LAN or
Internet).

3 - Use an external application on the Client Computer to send the Print Job trough IP to the sener.
The Print Job format must comply to the standard we provide in our website, available for download
here. .

OTo use this service, the Web Print Server computer with the cardPresso XXL Edition USB dongle
must be accessible to the Client Computer via IP connection either trough a LAN or an Internet

Appendix B.2.1 - Configuring a Web Print Server

O The first setp to use the Web Print Server senice is configuring the computer that will be
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running cardPresso and receiving the print jobs.
To configure the Web Print Server you must:

1 - Sawe the card file you wish to print remotely on the My Cards folder:

File name; -
Save as type: [DGCUMENTS (*.card) v]
¥ Browse Folders Save ] [ Cancel ]

1 - Create a copy or use an existing cardPresso windows shortcut, right click it and select
Properties.

Create shortcut
Delete

Rename

2 - Add the /PRINTSERVER switch to the shortcut Target after the quotation mark and click OK:
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Security | Details I Previous Versions
General | Shortcut | Compatibiity

bt

Target type: Application

Target location: cardPresso

Targst: v1e /PRINTSERVEH

Start in:

Shortcut key:  Mone

Run: [ Momal window - ]
Comment:
Open Fle Location ] [ Change lcon... ] [ Advanced... ]
OK || Cancel Apply

3 - Open cardPresso as a Web Print Server with the new shortcut.

4 - On the Web Print Server window you must configure:

The IP Address of the computer acting as the Web Print Server.

The Port cardPresso should use to receive print jobs.

The User Groups (see more on Chapter 8.3) that can access the Web Print Server.

When all the settings are configured, press the Save button to save the changes and press the
green Start Service button, on the bottom right to start the Web Print Server.

If correctly configured, the button will turn red and the Status box will display a listen OK message
as shown below:

© 2014 cardPresso, Lda



Appendix B - Advanced Print Operations 203

Listen: Allowed user groups
Address: |¥| Administrators
127.0.0.172 ] Editors
oy R ) Eore: [¥] Print Only
e 632 . [ View Only

.--'""'H-r

Save

Status:
listen OK (127.0.0.172:632)

@)

Close

Your Web Print Server is now running and has a .card file ready to be printed.

0When working within a LAN (Local Area Network) the WebPrint Server computer must be connected
to the same network as the Client computer that will send the remote print jobs.

OWhen working trough an internet connection, both the WebPrint Server computer and the Client
computer must be accessible to eachother trough a TCP/IP connection.

Appendix B.2.2 - Sending a Web Print Job to the Web Print Server

© With the Web Print Server configured and ready to recieve print jobs the last step to print using
this senice is sendind a Print Job to the server.

cardPresso has a preset format for the Print Job that should be sent to the sener. You can find a
sample executable file on our website available for download here.

This sample file exemplifies how to remotely send the Print Job data to the Web Print Server and
cardPresso reads the Print Job data.

The Item IDs sent from the Web Print Job must match the IDs of the items on the card that is to be
printed.

In the sample file the NAME item is declared as follows:

<item>

<ID>NAME</ID>

<VALUE>RUI FARIA</VALUE>
</item>
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Where NAME is the ID of the item to receive the value and RUI FARIA is the data to be written and
printed.

When sending Images to the Web Print Server they should follow the Base64 encode scheme
(read more here).

Appendix B.2.3 - Web Print Job Sample

O Hereis a sample of a completely formatted Web Print Job data to be sent to the Web Print
Server:

<cardPresso>
<login>
<name>ADMIN</name>
<password>admin</password>
</login>
<cardDocument>
<filename>example.card</flename>
<data>
<item>
<ID>NAME</ID>
<VALUE>RUI FARIA</VALUE>
</item>
<item>
<ID>ADDRESS</ID>
<VALUE>FUNCHAL</VALUE>
</item>
<item>
<ID>PHOTO</ID>
<IMAGE>/9j/4AAQSkZJRgABAQEAYABgAAD/2wBDAAIBAQIBAQICAgICAgICAWUDAWMDA
wYEBAMFBwYHBwcGBwclCQsJCAgKCAcHCgOKCgsMDAwWMBwWKkODwOMDgsMDAz/2wBDAQICA
gMDAwY DAwY MCAcIDAWMDAwMDAwMDAwMDAwMDAwMDAwWMDAwWMDAwWMDAWMDAwWMDAw
MDAwMDAwWMDAWMDAwWMDAZ/
WAARCAEAATQDASIAAhREBAXEB/8QAHWAAAQUBAQEBAQEAAAAAAAAAAAECAWQFBgcICQo
L/8QAtRAAAgEDAWIEAWUFBAQAAAF9AQIDAAQRBRINMUEGE 1FhByJxFDKBKkaEIIOKxwRVSOfAk
M2JyggkKFhcY GRolJicoKSoONTY 30Dk6QORFRkdISUpTVFVWYV 1hZWmNkZW ZnaGlqc3R1dnd4eX
gDhIW Gh4iJipKTIJWWI5iZmgKjpKW mp6ipgrKztLW 2t7i5us LDxMXGx 8jJytL TINXW 19j22uHi4
+T15ufo6erx8vP09fb3
+Pn6/8QAHWEAAWEBAQEBAQEBAQAAAAAAAAECAWQFBgcICQoL/8QAtREAAgGECBAQDBACF
BAQAAQJ3AAECAXEEBSExBhJBUQdhcRMiMoEIFEKRobHBCSMzUVAVYnLRChYkKNOEIS8RcYGR
omJygpKjU2Nzg50kNERUZHSEIKU1RVVIAY WV pjZGVmZ2hpanN0dXZ3eHI6goOEhY aHiimKkpOUIZ
aXmJmaoqOkpaangKmqsrOOtba3uLm6wsPExcbHyMnKOtPU1dbX2Nna4uPk5ebn60nq8vP09fh3
+Pn6/90ADAMBAAIRAXEAPwD9CJVAdIF/y6y/9+6j/wCEVnh/1kEV/fuvoPNf10+2SVr+8Nfanh/9gXH/
ADwk/wC/dR/20f7kv/fuvePO838KDCk38Ef/AH70/wC4Ye1PB/7N/wCelH9j9kr3j7Fa/wDPvHUc2j2M3
+stbaX/ALZ0fOww9qgeF/wBj0f2P XuA8HBVN1sY 6jPgP Q5v+ XGP/AL+UjX2h4n/Y 9HIMe9e2/wDCttH/
AOfeovBAhW OjzfwSmgPaHi/9j0f2P X E/wAK9OKS8r/IrHUf8Awp+ym+5PL/37p/uzT2p43/Y9H9j17D/
wpm1m+5f5/wC2dRTBP8AuXcdHtaYe1Pl/wCx6P7Hr1j/AlUnP/BPbf8AkSo/+FJ33/PS2lo/
dknlf9j0f2P XgH/CmtS/uRVXm+D+qw/8uvmO0fuzoPM/7Co/sd/WVRJvhjgUXW xqvwAIFfQj95Y 3NWY
+10H/ALJ/2KP7C/2K7SbwfPD/AMsZf+/dRjw3JB/B0/6Z1Hsqge10P/seo/7THrtP 7Bkh/
g6VHNo9Hsghr7U4/+x6P7J/2K6z+yf8AY qT+yf8AY 09mM4/+x39Y 6P 7J/wBiuwg0eSX+Cj
+wWOikBxfIjv61J/Z3+x XY f2F/sVH/AGT/ALFZgcf/AGb51HINSV2H9h{f7TFR/2F/sUAcn/AGZ71H/
2nfwZrrP7C/2Kj/sKgDk/wCzWipP7M966j+wqgk/sKgDk/7M96PscnrXWf2FUc2g96A0X
+x/5zRXSf2PRW Xt TnPVKPP08+ivROMkoqOpKACrEHeq9Sf8taBALHN1J59V6krnAsed
+60qODWIJAEISVXgSgOLHN1JDeV XopezAuefUkHeqcHepPNf1pezpgXPPoqvB3qSs/Z0WLEM1S/bH/
v1ShmgSjevTHTLn2w/wDTOj/rokfH/ TOqOF ZfVqYiSbTbGb/WQW 3/AH70/s Gxm/5dbaipPPrXevTH7Ur/
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APCIlaNN/rLGOo/8AhXuhyj5LHy/+2lann0VI9W D2pj/8Kx0qY fcligOb4S6VNnPmS 10FHN0/ZVBHN/
wDCmdOm4+1yx/8AbOo5vgna9Ew/IddZUIL2V T/AJ+G3tDh5vgan8F9HLj/AJBR1Xm
+Cc/8EIt/38r0Dz6k8+n7KoZe1PM5fgnfiweXz/00pn/CkOR/54x/9/K9P8+jzv3tZfvA9qe Tz B/

VY OfsvVBASEqWN8K9S/54S17R59HNST36P 3hr7Q8P/wCFe30P/LrL/wB+6rzeCZ4eZE5/6517553/AEQ08
+j95/27D2h8+f8ACHyf3DRXv+U/uR/9+6Ky/ef8+w9oeNwz UV 812f7eEnIfvNA/79yV o2f7eFj/AMvGh3UZ/
wCulen9Wxn/AD70X2p9D0V8/wAP7eGif8tNKuY/+2IXLTOuTwxN/rIL6Oj6tjP
+fYe1PdPPqSGawr4f22PB0/8ArJ7TmP/tnWhZ/tgeB5sf8TW X/AL9117PEU/8AI2B6559WK8rtP2rvA8v/
ADGY4/8ArpHW pZ/tFeDrv7niOy/7+UfVP+fY e1p0z0Tz6PPrj9N+MHhy8+5rIL/ANtK 11fiF p\V59z UrKX/
tpR7U00g8+iseDxVYzfcu7L/\VS5VyHW IP+e9t/38rL61TH7MOIO9SVnwbknXzl/wDv5ViG8T30
+tUxFipPPgn9s9/0qTz61+s0wLkHeplO9U/PqSG809pTAUVJIVPzU9asQzVr7UCSpKj8+jz6YFijz6;8
+igCxDNUIV6k8+gCSplO9V/PqSGaucCxRUN1J59BmSVJVepKr2oEIFR

+fUnn1JoHn1J59V6koMy Tz6k8+q8HeigCx59F ROUAfmp4J/Z1u/Elr5n262jk8vzPLgv8QvgDqvgO1
+1yeXc2f/PSOT/VV7H8Gdn9IxyfOM6yP2rvG 1r4V+F955nMI1+7jriwW JXFSp7O0mbV T5mwJvK/
Ggn2yP3rmofEnnf8APPzKsQ3klelVg1IVDY 3ftj/36 SHU+9Y/9p+1Sfa0/

wCelH1goBuf2mnW SpPtnvBApXPw3nnVYhwK 1+s 1P+fgGzFqXk/6uQx/9c6nh16f/nve/wDfysP7Z7/pR/
aftWn9pYgr2Z0kPiS7z/x93P8A38qWHxhqUP8AyY/XP/gRIXNHP{8ASiIbU/J96P7SxBn70Omdhz/
E7Xfuarff+BElaln8cvE+myxyQa5fRyf8AXSVM7zxUmmxCSf8Adxxf8tK4fxv+2B4L8By
+XfazbeZ/0zk82inmVSv+7p0/aB70mfUmm/tOeNY v Y 5L/wB+62LP9qLx5D/zGZZf+ukdfnwH/
BVzwVoN15cFrfXx/6Z/uq2NN/4LY +B9Htf3ngS +vpP+wj2WYOAN/AKbNPZn6AQ/tdeOfIZfW OV
AG71ch/bZ8XQ/wCsSyl/7Z1+¢efiT/gsI4E1i6jk07wrfW Off
ACO0j8zzar/8AD2LwPL5M2t9bR/8tP8ApPIR7LEBVMGH1emfpBZ/t7+lle JNKspf
+2lakP8AWUIU4f8AWaBH/wBs5K+G/hX+2B40+LV1cW

+larH90i/5Zyf8ta9lhmkv.W OdPNKk;jl/1ckdc1XE4OnU9nUw4ezPqyD/gocn/LTwSL/wCBFaFn/
WAFAtK80eZod9GT/WBNK+S/JBAUSIUcOMmMPuc1r7TL/8An2ZVcN/08Psiz/

b98MTfByxvo/8AtpHW 72Z/tyeC5v9ZP cx/9s 6+ GVv39HNP8A9NaP Z5fUCNTqH3pZ/tpe ASv+Y rLH/
wBdLeStCHImwJN/wAzBH/37r8//no81/Wj6tg/+lQKtOofohZ/tOeC7z7niOxrQs/jx4Vm+5ril/38r84/tnv
+ISQ6IPDwZJaPg2D/wCflQz9IUP0ss/ipod5nZrNI/38rQh8Y adNnZfW UvBA28R1+ZcPiSfPySS/9/
K1NN1ieb/Ivc/9/KPqWH/6CDX2Z+IEOWV WV P3bf9/Ksf2zH/z0j/7+V+d9neal/wA/d9H/
ANtJKuf2xrk MXy X19/4ESUR2b/1EGX7w/QiHUK6+ZH/38qT7Z7/pX54Q/
FrxHpuRBrN9H/20geH9pDxrpudmuXP/AHS8rL6l/z7xAeyqHGEfHbPf8AS pPPr8+4f2uvHFn9z XJeP
+elWIf22PHNn/zE05f+2dH9m4j/AJ+UxH3559S QzV8H2f7eHjiH/WT20n/bOtSz/wCChHieH/WWttLR/
ZuM/wCnZn/3DPuDz6K+NI/+Ci2rKuG02Nm9ftF FP8ImH/PsD5m+Bv7Y 2pTe CNQvpLVTbKOw/
wBXBP8A9M4/MrzvOpb9tGD4zafpcCW sfixf8fFeV6PDJZ/Cq8k/1fm3HI/
+Q64vwyf8AnokWLBU8PD94elVp/NDrLP4tWMP/Lpc5rUs/jZpOP8Az1j/AO2debzWfH3Jf+/IEMP+xRU
+rIHrEPxmO0ocSSXPH/TWyL4taHN 1vo68f+x/9dajmhrP2dMv2Z7Z/wALOOP/AJ/o/
wDtnViH4haVP9zUrb/tpd5VeF/Y/wDYjqSKz T/

pnWns6Zn7M98h8VWM33NSts/9dKsf8JGkOwy Tx/8AfywmsWik/wDPM1h+PPG1r4J0a4nu5/8Aln+7jjk/
ey 1nVIn/AABdQO9IMTmpeMLTQbW Se+ud7Zlo/

M8y SSvmw48f8FLNO80eZpvhm111K8/57/8ALKwPXte8Y/HjWY47VLE6PR/M/dx+Z

+6rgP Cv7HN3Paxy Tp/108z91XTU+p4D95iP 3IQ0p5bUmcH48/aW +IfxUluJLWbm2t7r/IhB
+6iirh/7Au9Y uo/tc/m/wDXSSwqDTf2P+wR/8Afytz TI2RE03+CP8A7+VzVeJPafw/3Z008uPk/
wD4QOSGtS08ByfZY/8AVEVIOW X7IsnPmeX/ AN+6p3n7Md9ps 3y J5sf/ADOSUVN/tL2n/Lw1
+pTPBIN8Hp5X714/wDtnVi88Bfupl9nm/8ATS OvZJvhjd6PJ5k S
+2Z/171Xm8LXc38B509riP8AI3UNfZV DWW PBU+gxfa4J7qOSL/nnd5VegBPOt74h/
A3y7STUrm50uL955c9xJXW TIDGfUv3aQeb/2zrl/Ffwfkhl/49c+b/rP3nleV XTSzep/Dxv7wV XBe0OPsj4D/t
+eGfjZayR/2ILpOoReX5k E95/ra9wh8S XX/P 3L/38r8g/Enwru9Huo/sKeX|95/rK98/Zj/bq1XdexR+H/
E8EupW8UnIxz101cNh6IP2mCOKrhqglM/Qj/hJb7/n71om8SX2P9ZH/AN
+68T039qjTtSijnSywpY5q0P8AhpGx/wCgdfVITp1P+fZw1PaHrH/CSXcP/POplfGEmceRbV5PB+0TpU3
+ssb60rkPx400Y/\WPt0f/AF0t6fs6n/Psz9meqQ+MOP8Aj1j/AC/IR/BACY QQ/
wCstf8AV3JXc3xy0fol3/5DgnN8YLGb719Hz/0zo9ma+1PULz4qWNIHJJOII/ 7+V o/ Cvak QeK vET
+RLHHF JH+7krwrUvHIjqUX7y+6/8AP Sus/Z78VadpvxBt/Mu48yxyV206eH9mc 1U/Sz4S6Pa3ml/
VILaWP/mXm/7YFnY+CYrOTTol7KSX/WJH/qq3Pgn8fDMGgxxz6rHHJ/q5P 3del/
ALaXxUtfFXjyzgtbuOWO1j8z/nIXzW G/3wVM4u817zqgpzan3rn4deT/npH/38qgx/
a8EO0XySRy/8AbSvSg1aZZoTan3qvaP+3VP+0/
aq814mfIZHTIqBsf2n7VIDefBATSsP7253NR/2IJDWWAOg+2/7dFY SawxX5pOaKPaGZ5BrFn/
AGb8NLO02Rxx3Unmf+1K5P8As 1P71dx48hkh0OvR4JPN/dW cdcn5HVXR/
y7Ay5tN6eZHU2PpsNakONH2P/Oa5TQy4bPzqP7NT+5Wp5PIfRP2rb2pXt TL
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+xf7FSfY/8AOaufLW X4w8VWwvgnw5calffBAHVFW X Tuma+10f8Aid8QtO+GOjfa9Sk8r/WeXxhfw9+G
+u/tUeLRrOpJLY6PFJ/rJJP9bH/0z00HQdS/ao+KFxdzz30ejxXH+rkk/

wDRdfVnhvTbXwrpdvY 2KRx29rRjsd9Up/VsP/EPawW C/wCXIQPB/
WANI9KB8E6XHaadax21vFHXQQ7lap/wBp+1R/bPfOK8Cngv8An4evINSHI170TSpMPrWf9sk5/
eRx1H9s8n/Ip5uaPgxpSgmxDKkI+laFnsm/grl4by TzPkkirY 03z/8 AnpGc 15uJPSp0/aGpNpsEOX
+rjrDVP CsE 0Mokfl/9M4621Zp/wDlolW PP rnNfgODHO3wTa2cvmbP+/IXJvAelal/

rLG2Ig5B3gxD5nFY 1P3h0+ypnH6I+zroGpSmT7DHXB+Nv2D9K8bSybP3f7ySSPy469802aetyz27/
wCWdZ0sdjMJU9pTqGVXBUBh8d+FB+s/BnWY/DGuWW/wWDPW8A8spY67T7F/
sVI9AePPAdj480H7Jd/8sV3IvJ/zykry O88Nz6DdS QTp+8ir7HLc3+t0/af8vD47NsFUoVDn/
sckpFH20P 1NdB9i/2KJrNM/cjr0/aHknP+Sn8EdHIPWpPZ/wByo/sf
+c0e0MV3ZnzQ1JZ2zSWd15iSSx1b/ALOkpY dM7ZrT2vszKrV/dngmg/GDWdN
+CNxaJPKY4riSPzPMryfXtSu9Yv5LueeWW S X/AJBSV3Ggw+d8L7iPzI8xXkkn7z/

mXF 3ImfNrpp4mpTpnNhv+nhT86TjY 8W AH8qP7ZP/wA/EVBA38gxNZ0VzfXah0/uyvBA2ncf8/dz/wB/
Kkh8VarZ/wCr1K5jqOaGTrVeazk837nNafW qgfuzUh+JGuQf8xW5NST8Lg8R+V8mpS/9tiew/
Keo50ZPN+tZ+1/6dIGs 3xj8Tqcf2lj28uis SWHD80UvaU/

+fZznrvx OvJL3VLOCTI35V8A8865eft XQEibPi28EnMk X7 us Ou2qc5HUfk/9NKKorEftSOjyPeiiucsjm?2
WceXmSeXH/ANdK+R/2ivi3P8WVICPD9jP/AMS O1kjjk8v/AJayf8tK9w/aj+ JEHgT4aXEfmeXeap/
01vXzH8ONN/s26+1fvZZP9Z+8rrp1PY U/rB1Y L+Ie+BmGDwfoMcEfm/ug9MOHXwtk Ukled
+G9ReGLzP3v73/AFkdemeA5p5v9Z/q/wDnpXzfs/afKh9TTq
+004s7zzqsTTVI2fr5keauTXkFnF5k8ItbR/35JPKrT20e 1LEMMk 1XItH/
wCWHKklcXgXxy8M6DL5cmqx5/62xy S 1zesftaaHZ/u0+0y/8AbvJROWXF T/

12ZfXqcD2SzhsY edkctbFneWMMv7zy46+W7z9szTWN8uO1uf8AtpHJUmm/tjaPNL5¢c8n2b/
VSFWdXLalQ7sNm9OM+sIv/gqSbyJg8X+Hvx4g8S QxyWs9v_H/z0jkrOCDxJ
+B6jkMn7uWwgdKpTPfp4dmnUOo+x/
uhsohhk/6a1TOHxJBNjzDVjxV4kTQo05JJPLt5ZPL8yuapTNTQhmk6VqW2ZnEX
+1jNefzfGzQ9H/19227ZP+mddh4a+KmneV5fmf62uLE0z T2pqQ61+98uRKx/HmgprFh56J/pFrH/AN/
aBSHWLHXwZ8yo5Y71ZY LE+zqHFmW Gp4vD+zP G/PqOftW p4k0efTdUul5E8uPzP 3dZ9fomHq
+0pn5W/d/uywRj/AGKkqOun2ZAUUY/2Kk+WikY 1TpPCv7 74fahB/wBNJJP/
ACHXLzQ11ngnzJvDmoQeZ/z0/d/9s64+aYy1pVpnNTI5+1V50U/56VYmM8zmqac01Z+zNyOo5
+1SefVeaapJ9oRTHP2omvKjmm/wCutBIxpuaKqgSXeHIOeKKCvanr3jyyk+1fbp/8AW XUn7yufr6M
+0X7N8kPhe4n0eTzZLX955EkdfN/nfva7/Z+0p+0pnL7UKKj8+jz6z/hmhJP2q0jz6x/GViRPB/g3VNSk/
WCXW 3kkrL+JUMz5H/ab8dyfE L4tXE EF 1Hc6fpXmR2//AEygxoMP7q3k2eX5\yVwej3n9p39xfSJ/
x9SeZXonhWzzYeXyzirMqvrz2Z7eGpnY eHIZJptk TzZJf3ccdeuaCYNBObz 7uS 02}ij8y T/pIXD/
AAXOFLPy7uffALZ1x/7UXx4g0HWWOktcyxyyeXJ5f/LXImXiU/3+Ip06Z69Wr7CmeoeA/iR/
WALU16PTbXzbKz+zyXtx P5f+tj/ANX5f/ TOtDx5/Y HW30b7dPa21zcS/u4/tH72v)/2LfGsHIT7RqU/m/
utHkjk/d+VF5nmfeqOuT+PHxIu/GHiO4g8z/R4v3fl/wDP Kvbq06ftPZ0/4dM82rV OX+IXxm1Wa/
kjgnjso4pP+WEfV5nr3xa1ma6+TUtS/7ZyVqaxCk0skcn/LKub1KG1ThMmfLjk/wCelF Sr/wA
+6ZzVazZn3njXxBP8AcwtS/wC/klbHg/x5rm2n95qVz
+6/56VnzalBeRfuX82iz1LyZcSJXm1cTU/59nThqdM94+GOsQaxHbyX0FtHJ5n7y SOPyVv8AlpXtHg/
xTqum2v8AXxLtSub6zij/1E8nmM183/AAr17ysSbP8AIn/z0r2Dwr48g8N382/5aSyR+XHXN7X2|Q9v
+GeueFf2tPAmmxW8F 94jsrK4/wBXJHJ5kssUIZ/xg/aKO0DxtFHaaPritgXm/vP 3cn+qrH+A
+mwdk80fbpINNjtxcSRx/6PHJ5v7yuw8bfBO18eaD/wAeNIcy RFSATVEX/
ouMgfV6el9n700e/70pUw/7s8H17UtZ1iXz7FL6WP/AJ7/APLKUT1/x54jh1XzJJPE+m2UkUn/QQ8qu8/
s2DTfgZbRpJLF9g1S4triOkk/49Zl//tdeLePNHg1KXy/tf2bzf3nl16W GxP7w8CpTxB7D8K/2kPE/hu//
AHNjXRL793/y 3vPN82vqj4b/ ALXUGVaX5|9B5MR/wCstJPN82vzn8K/DF Jr+ P Zff+Q67zQfDc/gm/s 50k/
eRBVI5RVY7B4s6¢NicRT/iH3p42+KnhzXtL8INS8u8i/1iTxyRfuby42vOijk/1scvBAzz/e10fBL4nJ42
+Bmn2N9Y 6brkcUfl3kE/72uk8E/DHWPr2gXEFrPfe G5JZP M8vzPNi/6afuSK6ctOnTp+zPm82/
ie00PgPz67j4wfBP Uvg/a293Pd22paXdfeu7ST/v35kf/LOuD8+vS/dnjklHn1X+2f8ALO0/O6bKozOz
+Hs6fZdU/wCufl1yE376LPNdh8GfOMuryP8Ae+XLH5cf7uux8YaPd+G7
+SCdPL/55/8ATWOpq1f3hmZ3nSf36qTTUTTV X+2e/WCIUdATTV XmvJP+mdRz TV X

+2e/6UGZY 87zpf3IRz9qj+1/7FFnN9slgf+vhnVgly 0tHmhDHqaKtLDxRV GZ+oW paCk0X3P 3Zr4r/
AGovhingPxIJd2sEcen38n/LP/VRSV98Xmm/uq8P/a0+G/8AwlXw+wWiebcWv+kxyVvgveqezMva8lQ+15
+1H7z31zRP2qPz6MT+7qezOn2pJXk/7Y HiT+wfgtqEaT+XJfBA+jV6xXzn+35q/k+HNDtP+Wkt5J/
yOrPDO0/3gf8vDxfw TZwQW skezzf3kdewe GOBTW JY 9nixx 14/4Vs5PtMn/AC18qPzK9Q8K

+Kk02W SRPOX5f+rryMb/ABD6TDNY fEjx3B8PBsIVBPHbSRRyf8AbKvm/wCDPg+7
+LWqf2IrL3P9h6X/ AMtJP+W slIbnjbxhB8SPFEIPP5en2tx5IxJJ/wAtf+mddJN4gkmOGPTdOtY 7bT4o/
LjeCj2vsKfs6Z6VPDVP4IQ6jwf8QrWz8USaakHIxy2fixxxx/8ALSVJ/HN27Tb/AFDzE8u4
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+0Sf6yOStyHTbuG/ju4J5Y 7yLI5HJ/y 1rtlfjZ4gmtY 7TUpNN1K3i/5+9Pjllop4n2f7unTM6uG/59nz/o
+g32vapHB5csccsnl+ZJWx4w+Fc+j2EkemIR3MY/d+ZHJ/7Ur6l0f4nJeReXP4c8L/APgwqS81j7ZnyPD
+gS4/56R13fXf+nZw4nBVKh8l+FBP9sXVnadayxx+ZJ9onkjgPxJoKaPrMIon720KT/
WV90axpgqTHI54c8Nx/wDbOuT1iax0395J4V8N3Mnl+Z/x7yVITxNOpU/hmviLEUzy/wCHsN3pssnmJ
+7P116540+D19r11/aX9pXMcl1HJHHBJ5k XV f+Ht39s h8x NAOTTY 5f+edvXrvgP Tplf9Ok8vzPL/d/ubz+s
+z/A1224bBe0gfivDoPhvdbTSNBt9Ng/497 COOKVRNBO0390Y +9cnpE 32y XyOrpLPUoNH/d+ZKc15GJ/
eH2WHOT+P370v/CVDnxRd6PJc/bJY4737JHH5s XmR/6z/pp/q6/PWVNBNs7C4u9ksvV

+tHhXUk 101jk2ebXyf8AH79k Xw5Z+Lbyx0rxHZab9q/eyW GpSeV/
rP8ANNJRIUZUBMPiDxMywXs/428j/D281K81ST7Layy+VH+8/d16hZ

+Np4ZbePUk8w\W.8y OOP97Xonw3/AGG9Zs 9ZiuOu/
t2lyyfMIONVI5MNj/6Z10fHj9mnVY'YtPWHODUrK01j8u48z975tdNXE4epU/d1DLBU6Ns/3h6J
+yw6QX8lja/6 THL5f8Aq4/NIr1jxJpv20/kjk8uW SL/AJ5181/si69d+D/iro9xPPLGbW4t/
MroKP8AgoF8N9G/4Zuk+I2jppscmgxxy SeR/wAtY 5P +en/bStfrP 1 TEU8P/AM/DxMyp+0xHs6h8f/
Ej9pBP+FX6h4Ru01KWOW 3kvbO78v8AdS +X/wAB85P8AIp5dY w8V QeKVBGI3cE/wBpijlj/
ANZXgem3mqg+PPFGsXcl9cnR9Ls7i03jkk82KLzP+ef8Ayzr2D4Y +G7X4b+CNP0a1T93a/wCs8z/
npXt4n2fs/ZngYnDez/d0ztPPqT9/efu4EMsg/wCedZcOp+dXtn7NPw3TUr+PVb6P935n7uQin+7p
+00UBj9InX9nXxHDY R3ckNtH5v+r8y StD9pz4 D6z Z+Df7 S+y+bJafézy/+edfTHWI8NpZ2s UH/
PKu8m8NwalpclveJ5tvL+7kj8uvgdmp TxHtKhmfkfgPmQmT955dZc03/TSwpTotn9IGT4Y 6z JrOIJH/Zd/
J5n+s8ryq+Z5W.z89e3+7nT+sU/4ZpTOmMRzTVHNNUC37r3qP/
W1xVQDzpP8AVpWx09n5EX7y T97W fptn/

sR1sQfuYs5jrT2viszLyzcUVGsiMM50qgP 13m/1Ncd48s01HRriCRPNPIlyV5v4P/
b88Ja9mPUkWNk/56SR/uq7yHx5pXzRpJ9K 1Ky 1K3/AOekEIY +1qUBn7ymc 1XD1Kf8Q/P/
AOIXhvBA4RwxbgFj/wA8pKw/1969Q+P2j+T8S9Qk S Qnzf3klcH/Y 9elifZmtMx50f3VMf7e0JvMNe8NweZ/
z0k/7aVIUTW cn9yvmfovCz +x6z4buSE/56f8AfyjDUzow/WDEPK9Hh+xwyf8ATW uf

+JPjABPY SWkKEKW2i6/55/wDLK OtibUrXTdBuLu7njj8r/WV X/ Zv+Fd38eP G9xrl35sen2skckfmRx
+VdfOM68Sn/AM/Kh9Lhgf7wk+D/AMDdS8beXd33m21nLH5kf7uvbNN+GP8AY 8R2Qeb/ANNKO Is/
B8Gj2scCQW 3IxfBATOtCzOhP7kfl 1w/ VKh7X Xw8v/4QOe8+TZH/AN+6jh+FdxDL/WAu3/

fuvZItNS GLSEjgWNCKP8FHs/Zjp06Z5nZ+Cfsf+sk/8h1JeQwaba+Yida7DX/Lh/dolc3NpE959/y/Lrmq
+0/5eHb9W p/8uzg/EmpT3l15aJL/ANM/L/1tSaD8N59Y 8u7nTy4/+ecn+trODTdBgh/ebl/MNXP J8r8a6af/
AE7M/Z1P+Xhz80gmz8v5K6jR7NLOXxjku5/s 1Y d5q6abL5n+t8gviF/wBo/wDaun8CWixYad5f2y X/ AFez/
IIR70pOp70mdtX2dCn7SofRE 3xIsdBi/wBFfzZP+ek8f7qjTPjBBrEokn/4
+P8AnnHJ5VIQPjB4z8bazJswb6W SX/InHXs/WAM/EmuQ+HbOPUZIEX/PStcThvZ0/3hlluOp1z78
+GPxCsfN/1nixy/8ALOtz4zfCux+JFhb6IBze2Ef+s8vAFsdfB/iL9gG+
+DemWQhhNzf3fmSIXkzFXuH7Gn7Yt98U9QubfW Y rfEf7wx 18tjgelp/wCO0Uz6WITp1P4dQ7zQfCtrZ
+WHH+WkX7vO3W p4k 1jXNHOsHTr6+j/ef6zzK3NS0e 1 WJJJErPmmS GW O3kk P8A20ryfrPP
+8qGfs625/8A8LC8R6bf+591fSezZ/y92cctdJ4q+P3/AAnNngOTSVEG)j219by/
WiCS4kitZZl/9XVzUvhKmpeZPa/6yW TzPLryfogL Tbv4V/Cq4 1J01t5v+ef7uvby 3E
+0xFONTPn8yy6meb6D8SIPid48/sPQIKONRPDel/6 TeRwSfaftUkcn/LSvXdS87/IpzXh/wCyvpvoj
+DbzUpJ5Zf7 2P M/wBZ/wAs69Uh1JK+1p/

xD4DG1aftD0j4b6P J4q8R2cH7 3y 5f9Z2JX2r8HVCqW cUdoicxR18xfsi6D51r/
AGjslllluP8AVIHX2J8K7MxSySf89a6s T/E/dnkVap654Jh/dH5P 3legaP Z+dF XD+Dvuu40ib/V5rmqU/
aGZzfxm+Fdj8TVAW 0aNfQRyx3Uf7vzP+W UIkv8Y Phjd/Dfx5qGjXcEtvAgk8uv2gm/fRZ5r4 X'wCCmfwZ/
wCJzp/iO1tiNklj8udoynE+zqVMNUND4XMhMP7viqPynrqJvB8418y SCs+8037H/
rdJDmtKpr7Ur6b5kMVaFzZ/8 Aqq4vakfHhPBM2GCCXUtUIj/ANR/yytf+ulZ
+1/59mX8Q9GW6RhnMdFP8v7UupgwBOuBT6CTiitP9oD2R9t TeG570tDw3eX3hu/

jntZ5baSvZIvh7Y zf6zzasab8PdHs+fsvmyH/npXV9ZM6eJgHNGWV d94wm+1zpLLJ/z08usabwifP/
cl/7919AQ7If41/+/dE2yb/AFiR/wDfuswNT/n2ZU6p83zeD5If4P/ACHS VLS
BSbwrdpujeF77ZHHHO9skjrOGPGGvaV4VsPtepSWVIb/APPSeOvPOt7WPDP7Tnwl/
sDSn8WIrjizLef7P8A6qjBY mn9Y/efwzpw2GxHtPaezPzX8eXcmpXVnodr+9
+1Sf8ALOVgz9mnwgnw88EW 9p5SHI3E Uf7yuf8B/su2wv3uvt93PHgV5NH5fy f8ALL/rXY abgfokXUmz/
V/8868jHVadSp70mfbYan7M7z+0v8AY gP+3vix5nf/AKZ1hwax537xJM1o0Wc3/
AEO0p06Z01KZOEN550Ucn/LOX95Uc14kPVM1nzXn7r/WVIBIrE/P+tNdABZY 10bzwrPgPzvIN/Ck8n/
rrXOej Takv/LP95WNBJNLIP/AEZWh9j/AHVR/ULOL95JXN7UKIU87
+KI5PoPljzP3d1Xz38VPCEPjabEk8n2byf7le+fEjxgn7yBEtm/In5kn/LKWN4fCs15dS Tyff+mdelhgf/
Lw8jHZI7Sn7M5/4f/DhPCFjGht THcf8tLj/AJ61654b0eDUtLt5JE zJ/wA86r+FfM 1K Xy D+ 7kij/wCWkdR
+Kbz/AINPIwJ+7i/dyf8ALLISXNifZz/iGeGXxNSmV/ip4Ptfib4 Ts4L421t9l/wCPeSP/
AJZV0OH7Lvwg018B6pJHazyyyS/wDPSq+seG/7S8B+ZBJ5WoGPzI4/+micn4J8belPCsUkdjP/

© 2014 cardPresso, Lda



m cardPresso Manual

AK395JJ5deBicNUnTINTPsspzLDOP4h9p2ep T3k Uf+tq7/ZgXn+s8uWvmwwi8VPFVnL5I3d/9s/
LrulfjZfab5fmJHLJLJ5ccnmeVXz9TBYinU9mel9ew9Q948N+F XhI8xJJf+/n7qrnxg+Etj8Zvg3rnhy+SPzL
+3/0eTy/+WIcX8MfjAmpfu7j931JP+WIlemax4807R7D7XPdx20f/ADzk/wCWtc3talPEU6hzZI TOp T/
dnw3Z60nhCw;jOpP3cel/6NHViIG8r0zW PgmnjzxbgF3Y zx2VndXH+j/u65f&x58FNc
+HstvPJB9us5ZP9fB/wC1K/TctzLD1Kn8Q/JcdgsRT/iH1h+zfo6aR4N0+D93/q/M+Svo Tw3420fwrF/
xMtSsraP/AKaSV4wV8B+d4S0+eCTzbebt451515P 3VR3w3k/uR1r7WnU/5eHm/
VqZ9MaP8AtUeANHHIyeJ4/wB1/wA8466DR/20vhI5scf/ AAK/I/8AXS 3krdzvP CskP+sMVZ82g96091h/
+1Q0+rUz9F P Cv7 RXgvxhLHBp3ifSbmS X+ DzPKrj/wB q7R4P GHwl1jy 515fKt/Mjkj/
e€18Lw6P5MprsPDfxO1LwroOlimqyy28scnmRzyfuq5s TgvZ1PaY eoZVadM8nvUhil8uuP8V8fUkZ/1ddR
qU3neZsrk/EKH72SSSTI5XTV p+0/eHP TOX1Kb7HF JJJ5f+ XX8MMISdS Ty Z8y X/
WSV6p4q8yawulP3fmS 15v5y Qy 3En+r8gOs ToPLfiNpUVp40lUdCin9KK6HUMB//
CVXTXzw4eb7w96KcaeiGzokY 2v3VW IZqp2farldNI4iSj/IrUdRz TeVFIKO/

wCnY ofxD89/25P 2xp7P4I6hptjB9u+wSeXb/VvP 3X7uvO/h78VPE95f2d3qVrHLp91/
rPL/5ZVx/7SGmyf8AC39YjnTpcSeXwB/K948HeG7XTth9pcey 2Ik/wCWdPNgdOF Snh6Z
+rYn2dOnTInTK +vax9s/5af6qvO7zW JIbqgSRP+eleieNtBTw34cku/tFv./yzj/eV5X5P72vIPExNU6jQdek
+1Rx+Z/ra6j TdARSaX/'WeX/10krzvTJVO/wCmdbGmalP9qgkjz/qq1p0zP2h3E 2pIP 3fMtRww+d/
rErDs9eSGWPz/Lj/2/Mrch1JJovkgzop1Qh0zyfeqepXnk1J53P3/3lc34w17+x4pJPIb/ANtK56ntDp+s
+zJNY 8ayabY SeX/rK4fWNek 1668+ST95/WAOKX/EniSTWL+SSSSX7PL/
AMsBw708k82TYkv72tadP2Z5NXE 1Khs TQp5uJD9p/
wC2dWIdHSylku7uTy7Py/8AV/8APKqc3igx8EBX9uu5PNk/52x+ZXmfiX4wT69dS SP/AKV/
AJZxxyVIV9p/y7PSwWW/8wKh7hpvx UODRS5flkgll/d/6+Py/3tWP7S8M6xE JOvpf+udfNfBAwWs KP/np T/
wDhY UkMXy T3MVBA 1zrzauCqf8uz62nTwf8Ay8pn0zB8TtAhHkeRLKalfEng6aX9/J9m/wCuf/
LKvmOHWNV 1KX9xa30vbOSq+v6IrOmxb54Lny/+micVXLan/Pw0qVcH/z7PgzWNNsZrXzNOu45bT/
npXB6x8VIPDf2iP7dnyvaXHXz/D8Ttc02KTZBLHH/ANdKr+DptV+J3jKOx/1ccsnm Sf8ATKunBZdU/
wCXQ+bxO0p06n7s+yP2VIH1n4wS XGufad 7L T4pP9Zcfe2X/tnXuk+g+dL+8n
+3Sf8APSSsf4G2cHg/4X6fY 2uY 7fy/+eddZZz JN+82R1IVp+0qe0D

+0gIT92WNBOeTTZY 5EkrsLOyg1GwEF2kcscv+sjr7PzJvetzTobuGWP/AFctcVWnUpnV+7qUzP 1L/
hO/g+ft3gDWY77TxceZceHtW/exfs65eb/AlKrT+Cbr7D41+GO0ttefouT7JeSRebJ/20r1izh
+2Rf885K5w1/AHSVjz4NOmBkkf2yL97b3cn/ACykrpw2d4f2ns8xp/8AcQ+ax2U/8+zi/
wDh7R80buLEngvxJH/1zuLeW qff AA8a8M+JIVBAQFCW peXAM9J7iOvh/4y/BnxB8B/
GVxpWs2sv2fzP9Du4/8AVXUdbnw9IS GW 37p5dfw/Usvan7SnT/8AKh83Vp0629gaD
+0tP481mO0sdKsrLzf+WnmebXSTalPefoy SWWvA/gzeed4ns9h/5aV7xDnyvdZWns6dP
+Gc1Up3neuX8SferosXWXneub179zF JJ/37r0qZ0zg/Emy Gw8y SSvG/FU13NLJaW sksv2
+4Kk/7ZvK9g8bf8gG4k T/WV5npsN3pus 3Hnyfu/tHMR11S/
wCXhpTOpTwzZaZaW8EnmuY4gA2123D1zRXDeP8A4qgRaLraQF 5d3kg5+pJP9aK5Y4bRG31Q/
WyzwlceZH/38gx9r/wBivy 7s/iR4jsVORrmr23/X04kg50P 7QnjW G6ul/wDhKtb8uKT93/pFen/Z21/5
+HB7Kn/z8P0887/YkgwNeV+dcP7VHjyH/mZ9SIx/z0/e1qW{7Y 3xDh/5mCW X/tnWv1LEUzWnT/59nH/
tdeCZNH/aWuLTZJHHLef6z/nr51d5488Y f81f4Dyn7248vy/L/wCmdY fiTxJFE7WdP 1nVZ/tOofaP9lkrl/
jDZ32sazp9jamX SpP+mnIRVImVX2+190fqNL/d6ZJ/ws JPEng2S Dy P 3k X+ sk/wCev72sPyfO/g/8iVOn/
CsU8H+Fpl5Lu2uf+mkdcvZzJ9gkj2f6qSWNINT/AOXZ8/if4hY 87y Y gks 7y Sb61H53m/hRpv/
H1J8nmx1pT9oc1UuTTedF5fmVoaP4kkspf3kksuf8AnpWNsm+51q0O87xyV 1VapnTgnWQ699si8ywN/
idef2ldeWn+s/5aV 1kM32018uT/AJZV xfjCLztZkk/561zUwvh04n2hz2rzQQWFv

+88u4l/1n7us TXHIroNrJPP528qtjWNOS8EeysPR/2dZ/G1/8Aa9Su5Y 45f+WccdHsqd T/
AJeHThqdM831LxXgXxO1S3ggSWX/AKZ/63yv+mldhoP7PaxkUcmpSX0snl/6uP8AdV7R4P8Ag/o/
gO1/0W1jj8393/z1qw4k8S Jo/wC7gg8uP/pnWVTE/wDPs9unV p0/4h5WN8MdK8Nx+ZJp0c X/ AEOk/
e1Th1LR70Xy4Ps3/XS0O0qfxI8S Xes SyRweb5mfK4uz+11zVcNUgKIQ6f7bw9P8Ad
+zPYNN15LyLy0Ok83NU9e0e1lijkn8uX/rpXD6PeTw5/ 1tak2s TzQ+XJmwWNag4apTD+1/aGH8SPI+y+WiR/
upP+WddB+zT4V8nRrzUuftF 1/6Lrz/ AOIW pf6 Tbx pJL+9k/wBXXgngPxVB4b0G3tMx/uo/
+Wlevhv3eHPn8TT9pU90ofXHwx 1hD410+NPNI/d12nhgbzvdD+9krx/8AZv17/hJICVVAM8/M8VAL917JD/
AKH/AKuszX2dM6iGb7H/AAVoWesJDzmuLmvB5knmS8U/SJp/
MH7yWuWrhvaBTgngOm6x533M810umzJNF+8SOvPvDd59jh/efviZK6zRISkviviMI8zy 68DE4Y 6frJT
+LPwx0P4neHP7N1zTo7m3/52/8ALLyq+N/2Iv2Xf+FD6p/bOgJLc+G7/wDdx/vP 3trJ/wA86
+7POS7tRH5kZrg/id4DsfiFAXWDW3dwR/WCjyfBAPKSssDmVTCVP4n7syq4LD1Kf7w+P/g/
gWPGVnGn+r8ywoyH97Xy/4V8K33gP4tf2VfebHJa3HlyVIURIs/LrOI9pTPgMT+7qF Ob/U1zfiQST20n/
wWADbrrLyH919yuf8SQ+TY SSc1rVImZ0zz/xJD5thcR7PNxHXj15e T/b/ADNn+tr23UofPP8ArOle T/
EL4e6lpt/Jd6dJ5tnN/WAS/L82WKuH2f7z222

+19mePeNTJ4k1171Y duV Cked4zRXSTaNqgFvcSI9tcghjgeX2or044XRHF 7U7n7HS53F Z+g/

© 2014 cardPresso, Lda



Appendix B - Advanced Print Operations m

vopJD9yW SSuo/s2SHI5W X4b0fydMj2JLXbVpnDSI4Y U61J/y 1rQ+xf7FH2P/
ADmj2ZrSNzwref6LXaeG9Skmiul5/Lj/
ANXHHJ/0zrzeGGSH7nm1T1jx5rnhuWP7LBHcx/8ATOw8bgqgn/Ls+/y3HUG
+HINUPUPEInaw2Fx5nm/vY 5K8Xhm8mXH+trU8SfGDUptLkgntZZfiN/wCedcvZ6xJeeZ+4/
eeXblc3sbns/wB4Z1Tc/tdIvdKsaPeJpsUnmdéw4dS/56JVwXnnRUUzIgmpeakhl8xP/IIY 95rEKNh5/
wD6Mgneax5MVZd5q8k0Xly T/u/+eckleoZm5266byL/AFIVIS 1JJpPLkr7zWEhHIolRw
+JJJpfufBAkSuUGqdB3Hg/R7XWB5iSebH/z0ruLOzTTY VBAW ebXnthDxJ/Zs Ukf7397 XQf8Jh53/
POWqndTgmxqW pf6z/nnXH6x2Z/bJZJP9VW xDefbP+edF5DBDF J5n/POtqdU19qeZe JNB8
+KT9x5vm/9NK5D+zfJI8vZ+8/6516hqUOEP/LeOL/
pnXPaxeJ5vXzaOgnAc5Zwyf3PLgxeQpZ2vmSeVRqV55MXPI+2XF +MPFTw
+ZB5n7zy64apt929mcfdq1L/Alg2zj3/ALs SRyf+RK90s/CsHiTwvomzy5JY/wB3JH/
z0r5j8SXnn6p5nmebX0B8IPFVxgXgm3jtlL82GP8A56V6RzU6WKh7B+xzrE/huHWNNNn/
wBVJHJbyf8AXT/WV9IMabqUk0X7zza+BIN8Va58N/G/26RLb7PL+7k8z/nnX1x8MfFU+vaDHOKkkfly/
V5PL/wWCWdcWOp1KdT2h690n7Q9Qhm TpWhZ/6HXP6DZ
+TL5kkkfmVsefWftfaGW JpmxZ6I53NbFnrEKMX+s/7Z+2XH2d4kMuDJWh/
bFc1XDHN7UByHxh5P Xy6JvF UF5KPMkIrk5tT71Tm1L97/rK82pgjO0geJLHXO
+EunePNUs9ZtfLj1S1/5aSSf62rn207h/wBZBUdn4jkhigSbxJINF/rK6aeb4ihT9mebiclw
+Lqge0l50ZPKPyVh69F/oskkhirYh8VecPLk/5a1T16FLyKTZJ1rtp8QU6GIT94ebjuHMRQp
+0pnn95CNM5NZ81mk33K1LyzPm1HDDX1NKpTqHz9UxpvCOM8haT7xoroY4YyoyaK10M4PUrPydL
uH/AOeUdU/Dej+TpdnH/WAtDHXSeMNNMPhe8d/9X5dWNNOdPsscezy/3f8Aq69+rTp/8vDIp1THhOC/
VPkj/wC/IHO9mMe9dB/ZP+xR/Y/wC+/wBXW Xs6Y U6py81mn9yq80MmPuc11E2m/wCxVb+yJP8AMdZ
+zNKdU5T+x5JpPOXHXF69Zy WegXEfP+sr1j+zf3w/wBc68z+Kmjyab+88zy44v8AlpXkYBmfSZSc3NgX
+ISRyf8ALKq82pdNhrm9S 17y Zfkn83/rn\WN4wk/1ea8T2R6VWqdBNrE95dY 8yjUrzyoo/3n7z/
IpWipuvQeV+8/1tXJpkvivuV 3e1D/AJdMmXDN500NS G88mKqU2peT5kf8AqzWZNqUnm/
VJPNrngmXtTrNB15IY pl/+mlaE2vZi
+SSuDh1PyfU1JFr39xKkzg4moeoWfiCDRzHHIkssnl/8s5Kr698SEm/dp1rzubXs/wCsT95/0zou/
wB1YR/VPLkrb2Ye1NzUVGCTXX+MI/7Z1j6Iry Xnyfuc/8AXS ufGpSedJ+8qvDrH+Id6x+A09gampalBDD5f
+rk/wCulcP4r1KS8uvMKk T/V8tK2NY m8663+ZXF 69gXn TS MKzgmft Tm9OXJuj7V6D8BPiCnhq88iT/
AJbfu683uj5ty T61p+HLS SaUbKAwW38Q+sNS+y+MNKjn8zzfNjr1j9nwxUkPhKOxkkMclh+7/AHIfH/
g/49X3g+LyLhPMt5ZP+/Ve4fBndqWusarJBB+7+3x+25dGOp/uz6 TDVaz9Qab4xSzik2Vn
+JPHiXnIxwSS/wDTSWP5te/0X/ pnLXJzeJJIdZk8y S Xy68mk FWrTqHOB4b8S SebHHJJnza7Czm/
dfivO9eR/D3Uv+EkiikM/m/wDPT93/AKqW 7P/AFRrgPKgizan5PW Oa8kgxeQyQ/Wsu8715tUumP
+2P8A3DS/8JJJD+7rP11JP3IV/WDIrXBiXTgHd TqnQQ6950tWIdY S8781zcvimTzEkqOHUpIR8Ie TUp
+z/hnt4arz/wAQOPEkXky+ZJ5v7 3/vIWTDDVie8k 1K 1kjkeWW gej3iQyyRyfuSIV8AnpX2WQY 7np
+zgHWNEGW +2zxHtKZoRQkJ30q0nSivrPanzBzPjDUtO1LRVTUbLZzJZI/M8z91+7rcs4Y JwTxy/
wDbSvM4dnXy4811dn/LT/y HXwwv+velP6PxPOfgffMNiID1T+xvO4zmo5tM72ZrzeHW LuUEfJdy 1ch8YazzZ/
u01W52f885K7cNx/T/5eHzed8AsOp/wbh3HIMpDFVObTO2a5v8A4TzW SMy Xfm/9s 6P
+E81Lzf3n2aWP/ppHXpU+NsPUPIXPgpxHT/hmp/ZidJK83+J2jyfarj5P+ekldp/wnk/SS1tpf/
IVc/4qvP 7e8yfZHH5VIuS OP97WVOATF /wzyavB2aZNT/22mfLfibRSNBupNn+rrm/7Y zL
+8r3TxV8PYNflkjT/W Sx/wDP SWK/GHw9/
sGWORPN!IjIpfGeR7Ux7PxInm9a6Cz1jzowkrj5tBkirQ0fzIf3fPI1FWnUOmIVNiaWeaX95JWfqU3kxSVY
mvKy7zzJvel/180apVMe88SSebUkHiuSH1qP UtHT+5LxXN6I5kNdNOmc/t ToP
+Ekk83zKJWUnI58yuPm1GSH1qvwea9JN+FP2gzsP+Ek86KQJ/
rkz5te/56SVy80pSdZMOTX cpobk3iSSbrPLxWHqV4k/W56jn7UAQSsRiu0+E+kPqcOmK4d8IvpXp/
wCzfMZtZulP+Whj/d1r7TqTgvdmI5Dc174e/wCi/In7ysP4V6xrmkeMrOx06T955n
+rk/1Veqaxshl8uSs/4AM+FY i/bzokfmGOSSOj937M+gxOGqUD2AaxPZ2HkX0n
+kRf8tPLrCs7xLzVPL/AOetbvj2z8618/8A5aRf6y OOP/W 1x+g3kcOWV/
mMSOM682nTIMc Xt TOjwT4lk8N6zHInl/6z/IpX0B4b1hNYtY 50kjl/6aV8z+ckv/
PWWRPgb4w8mKS0nk/1Unl1pV/h+0pmn8Q9sm2Q/vHzzW PgX+mf8tP/ACHUMmTJefP M/
d1JqWyal14mK9oaljn7yH/AKaVH9s SGX/'WdKsXkL
+b8nJrPmh8mXzJK4vancF5gXnY2SdapzaxJDEP9XzRNefu/L2Vn3kOHmM81zVTopmhZ+I15PN8y T/
wAh1cmh/tiXzESXzKx7LZ+NalnqUIn5X/
POInVqUKntKZrVp08RTINUHf22dP ZoprW4Minkng3vRVwIL3EKQY cOV7f+srPm5cNK7P/2Q==</
IMAGE>
</item>
</data>
</cardDocument>
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</cardPresso>

Appendix B.3 - AutoPrint

© One of the advanced print features you can use with cardPresso is the ability to automate print
jobs and use external applications to run custom print jobs. This feature is called AutoPrint.

For these purposes cardPresso allows you to use the Windows Command Prompt to run print jobs
you have previously prepared.

The possibility to use the Command Prompt to run customizable print jobs allows you to create .bat
files with your custom settings and run those .bat files whenever you need.

You can also use external programs to run custom print jobs, either by running the cardPresso
AutoPrint commands, or by running a previously saved .bat file.

To work with AutoPrint, the card you are going to use must be previously saved with your printer
settings configured.

Appendix B.3.1 - AutoPrint Commands

© Below are the commands used to interact with cardPresso through the command prompt:
/(P)RINT - Print

IFILTER:"data" - Conditional Print Filter

/CONTINUOUS:seconds - continuous printing with seconds delay

ISHOWPRINTDIALOG - Always show Print Dialog Box

IDBFILTER:"Filter" - where "Filter" is the equivalent to a SQL WHERE clause
ISAVE:"optionalFileName"™ - Saves the document opened in the command line applying all
changes made by Print or DBFilter

If optionalFileName is specified, then the card document will be saved with the new name.

For example:

/SAVE - sawes the document with the current file name

/SAVE:"D:/Tickets/newCard.card" - saves the document with the new file name

Using the Save command with a filter allows you to preview the card fields filled with data that meets
the determined conditions before printing.

/EXIT - Forces cardPresso to Close & Exit after printing

The syntax for the /P print command to be used from Run or Command Prompt is:

"c:\Program Files\cardPresso\cardPresso.exe" "c:\cP Test.card" /P

where:

"c:\Program Files\cardPresso\cardPresso.exe" - cardPresso's executable file location

"c:\cP Test.card" - card file location
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[P - print command

0 note: cardPresso's exectuable file location may vary depending on your operating system and the

location you selected when installing cardPresso.
The card file location is where you saved your cardPresso .CARD document.

Appendix B.3.2 - AutoPrint with Command Prompt and Windows
Run

© AutoPrint commands can be run directly either from the Windows Run dialog box, or from the
Windows Command Prompt.

To run an AutoPrint command from the Windows Run dialog box, open the dialog box trough the
Windows Menu Start>Run type the AutoPrint command in the dialog box and click the OK button:

- Type the name of a program, folder, document, or Internet
rescurce, and Windows will open it for you.

"cheP Test.card" /PR4

QK | | Cancel | | Browse...

To run an AutoPrint command from the Windows Command Prompt, open the command prompt
trough the Windows menu Start>Accessories>Command Prompt. And type the AutoPrint

command in the Command Prompt window:

Microsoft Windows [Version 6.1.76611]
All rights vreserved.
.exe" "ciscP Test.

Copyright <c> 2887 Microsoft Corporation.

sslUzersscPPedroSsouza’civProgram Files™ oo e
ard' <P

Appendix B.3.1 - AutoPrint Batch File

© AutoPrint commands can be stored in a batch file (.bat) for later use. This way, you can create
as many batch files as you like, each with it's custom settings, and run your desired file with the

desired settings whenever it's needed.

You can create a batch file in any regular text editor like Notepad.
Simply create a new text document. Type the AutoPrint commands you want to run and save the

file with the .bat extension.
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MName Date modified Type Size
cPbatchfile 30-12-201515:51 Windows Batch File 1KB
j cPbatchfile - Notepad = @ ® |
File Edit Format View Help
"ciWwProgram Files', Ay exe”™ "l M. Test.card™ /P ] -
r Y
| Save As g
OU | . % Local Disk (C:) » cpbatch - |¢f| | Search cpbatch 0 |
File name:[| ] -
"'—_1. Save as type: [Tad: Documents (*.bd) v]
¥ Browse Folders Encoding: [ANSI v] [ Save ] [ Cancel ]

You can then run the .bat file directly, or trough an external program such as the Windows Task
Scheduler.
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Appendix C - Encoding

O The multiple types of encoding available in cardPresso provides the best flexibility when working
with multiple card types.

To ensure a good knowledge base, in this chapter we will further develop the topic of encoding,
addressing each type of encoding and how to perform it within cardPresso.

0 For testing purposes, we recommend disabling Front and Back printing on the print window (menu
File>Print) before printing.

Print Operations

Print Front
Print Back
7| Magnetic Encoding

Appendix C.1 - Magnetic Stripe

i Magnetic encoding is a contactless type of encoding performed on the magnetic stripe
(Magstripe) of a magnetic card. cardPresso supports both High Coercivity (HiCo) and Low Coercivity
(LoCo) magnetic cards.

There are up to 3 tracks on magnetic cards: Track 1, Track 2 and Track 3

Each Track supports a specific data type and size.

Track 1 - 80 Alphanumeric Characters
Track 2 - 40 Numeric Characters
Track 3 - 110 Numeric Characters

When a magnetic card type is created, cardPresso displays a visual representation of the Magstripe
on the Card Back view. This allows you to individually select each Track and edit the data to be
encoded directly trough the card design view.

You can access it by clicking the View Card Back button, or trough the menu View > Card Back.
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Appendix C.1.1 - Macros / Sentinels

© When encoding data into a Track the data must follow a specific set of formatting rules. These
are what determine which Track is being written and what data is to be written.

To do this, encoders use a set of characters named Sentinels which determine where the data to be
encoded starts, where it's separated and where it ends.

Start Sentinel (generally '%') marks where the data to be encoded is going to begin.
End Sentinel (generally '?') marks where the data to be encoded ends.

Field Separator (generally V) separates different fields within a track.

ex: %Example/Text?

Where:

'% is the Start Sentinel.

'Example’ is the first field of data to be encoded on the current track.

'"A'is the Field Separator.

'Text' is the second field of data to be encoded on the current track.

'?"is the End Sentinel.

cardPresso simplifies the process by using Macros: an array of Sentinel presets for several

manufacturers, making changing Sentinels as simple and easy as a click (see more on Appendix
C.1.5).

Appendix C.1.2 - Adding Data to a Track

O Tracks in magnetic cards can work as easily as any other item in cardPresso when it comes to
adding data. Simply double click the data you wish to add data to encode, input the data to be
encoded on the input textbox and click the Close button. The change will be immediate:
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Trackl:

Example

This allows you to quickly add information into a magnetic card without any previous knowledge on
magnetic encoding.

Appendix C.1.3 - Adding a Database Source to a Track

O when working with databases, having the versatility to add a database item to a Track is
fundamental.

As with any item in cardPresso, each Track contains it's own set of properties which can be used
for advanced encoding operations.

To add a database source to a Track:

1 - Select the Track in the Card Back view.

2 - On the Source tab, to the right, change the Source type to Database
3 - Select the Table where the database data is stored.

4 - Select the Column which contains the data to be encoded.
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Database

Table

Employee
Column

Frst Name
Font auto adjust

Mewver

Concatenation

All changes are immediately visible in the Design View:

Appendix C.1.4 - Concatenation With Databases

© concatenation allows you to stack up to three database fields within the same Track. This is
allows for a much more dynamic and space efficient data generation when working with magnetic
tracks.

To use Concatenation on a Track select the Track, on the Track Properties select the Source
tab and click the Concatenation button.

The Concatenation pop-up provides the following options:

Data Prefix allows you to customize the text prefix that appears on the currently selected track.
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Ignore on print disables or enables encoding the Data Prefix.

Data Suffix allows you to customize a text suffix that appears on the currently selected track.

Ignore on print disables or enables encoding the Data Suffix.

Concatenate database columns enables or disables Concatenation

Column Prefix adds a text prefix to the data obtained from the selected data column.

0 Usually used for the Field Separator Sentinel

Column selects the database column from which to obtain the data.
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| Database v |
Teble
| Employee v
o Column
E %
3
2 | Employee Id v |
Font auto adjust
| MNewver v |
Data Prefix
TRACKI: | Ignore on print
Data Suffix

| | [ Ignore on print

Concatenate database columns

Column Prefix

I" |

Column

[ First Name v |

Column Prefix

| Fay

Column

[ Last Mame ?J

Column Prefix

| Fay

Column

[ Extension v |

[ oK [ Cancel

Appendix C.1.5 - Editing Magnetic Macros / Sentinels

6 Different encoder manufacturers use different Sentinels. To simplify managing sentinels
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cardPresso provides several Macros with preset Sentinels from several manufacturers.

You can change Macros trough the cardPresso menu File > Print Settings > Print Options >

Magnetic Encode > Macros and select your encoder/printer manufacturer.

Print Options

- Antialiasing -
- Composite black replacement

4 Magnetic Encode
4 Macros

Evolis

CIAAT -
1Datacard
<Evolis
{Fargo
GLADIO

Chimi
4Adv| g A Smart

* B Javelin

» Fli Magicard

=L Misca ul

To manually configure Macros open the cardPresso menu File > Print Settings > Print Options >

Magnetic Encode > Macros and select User Defined.

This will allow you to manually type the Start Sentinel and End Sentinel as shown bellow. All 3

Tracks must be manually set.

Print Options

4 Magnetic Encode
4 Macros

User Defined

» Font
a4 Track 1
4 Begin
%0
s End
7

> MalCK £
: Track 3

» Composite black replacement *

» Character encoding -

Appendix C.1.6 - Script Encoding

© cardPresso also allows you to manipulate Track data trough Scripts. This powerful feature
allows for even more advanced operations to customize your encoded data to it's full potential.
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In cardPresso each Tracks has a unique ID. Namely ISOTRACK1, ISOTRACK2, and ISOTRACK3
for Track 1, Track 2, and Track 3 respectively.
The data on this item can be manipulated trough scripting as with any other item.

0 The encoded data must still follow each Track's data type (see more on Appendix C.1 - Magnetic
Stripe).

To create a Script click an empty area of the card design and select the Script tab in the
Properties Dock..

0 Scripts can also be added to an item by selecting it and clicking the Script tab in the properties Dock.

On the Script tab you can select when the script should executed and on the text box, write the
script.

Ex: item.ISOTRACK1="Example Text"

| Before Printing

item.ISOTRACK1="Example Text"

Background

Databaseg

Database Filter

Database Find

a
(=

=
7]

1]

| Script_| Output | ©

Example Text
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Appendix C.2 - Contact Encoding

6 Contact encoding in cardPresso is done in the Encode Operations window in the Encode
View. Here you can dewelop your customized encoding operations for all the supported contact Card
Types.

This allows you to manipulate the data stored in your Card, the data in the Card Design ltems and
the data stored in your database, if connected to one.

The code varies with each Card Type. cardPresso comes with sample code for the supported Card
Types designed to get you familiar with the basic operations of each Card Type.

Below is the sample code of an 12C script.

Contact encoders | OMNIKEY CardMan 5x210 ||

card.hasNullUIDs=true;
card.waitForPresent("#12C");

12C.write(0 " L
12C.write(10,"6D6F7265207468616E20616E2061706CHO6361T4696FEE", "hex");

logf12C.read{0 .10).toHex ());
log{i2C.read(10,23).toUtfa(});

12C.read(10,23).toUtfa();

Contact Output @
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Appendix C.3 - Contactless Encoding

© Contactless encoding in cardPresso is done in the Encode Operations window in the Encode
View. Here you can dewelop your customized encoding operations for all the supported contact
Contactless Types.

This allows you to manipulate the data stored in your Card, the data in the Card Design ltems and
the data stored in your database, if connected to one.

The code varies with each Card Type. cardPresso comes with sample code for the supported Card
Types designed to get you familiar with the basic operations of each Card Type.

Below is the sample code of a Mifare script.

Contactless encoders | OMMIKEY CardMan 5x21-CL 0 A
/I Read and Wite to a Block of the card [a]

/1 write to HEX in sector X block ¥
jimifare.write(X,Y,"54657374207772697465000000000000" "HEX");

/I from the connected Database
fimifare.write(3{ ¥, currentRecord["Hire Date"].toString());

/f Simple text write
fimifarewrite(3 Y, Test read");

/I to write to the trailer use
Jimifare.writeTrailler(X,"FFFFFFFFFFFFFF0 7806 9FFFFFFFFFFFFY);

/i to read a Block without converting it
Himifare.read(3,y);

! Read with conversions
fimifare.read(},v).toHex();
fimifare.read(X,y).toString();
fimifare.read(}.Y).touTFa():

/I To save the read data to a field in a Database use:
JfeurrentRecord. COLUMNMAME=mifare.read(X,Y);currentRecord.save();

oy

Contactless | Output @
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Appendix D - Barcodes

(i Barcodes are a staple of today's industry and cardPresso follows trough in this feature as well.

Supporting 1D and 2D barcodes libraries with various customizations allows for a wide application
area.

To create a barcode simply click on the New Barcode or New 2D Barcode button on the Design
Toolbar and then click-drag the new barcode to the size you want.

m &3

Appendix D.1 - 1D Barcode

© A 1D Barcode is the most common barcode type also known as a Linear Barcode.

Q To create a 1D Barcode click the New Barcode button in the Design Toolbar or trough the
cardPresso menu Tool>Barcode.

You can then click-drag to place the new barcode with the desired size.

To customize the barcode, select it and click the Barcode separator in the Properties Dock.
The following options are availlable:

Symbology lets you select the symbology the barcode should use.

Barcode color lets you change the color of the barcode.

Module width lets you customize the width of the module.

Bearer bar customizes the positioning and shape of the barcode bearer bar.

Bearer width customizes the width of the Bearer Bar.

Quiet zone customizes the size of the quiet zone.

Human readable customizes or disables the barcode caption text.

Font customizes the size of the caption text.

CheckDigit enables or disables the Check Digit.
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Position

=
c
@
£
c

2

=L

Outline

[ Barcode

i JNPY>) Barcode also know as a matrix code, is an advanced barcode type which can hold more

|. Code 2 of 5

Barcode color

| lRGE(0.0.0)

Module width

| Auto

Bearer bar

| Mo bearer bar

Bearer width
0.75 mm

Quiet Zone

|Dmm

Human readable

| EBelow

Font

| Mormal

CheckDigit

|Nune

Appendix D.2 - 2D Barcode

data per area.

Appendix D - Barcodes

227

Q To create a 2D Barcode click the New 2D Barcode button in the Design Toolbar or trough

the cardPresso menu Tool>2D Barcode.

You can then click-drag to place the new barcode with the desired size.

To customize the barcode, select it and click the Barcode separator in the Properties Dock.

The following options are availlable:

Symbol format changes the symbol format of the barcode.
Barcode color changes the color of the barcode.
QRCode Format changes the barcode encode system.

Module Width changes the width of the barcode.
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Mask changes the barcode mask.
EC Level changes the error correction level.

Size/Version changes the barcode size/version.

| QRCode

Barcode color

RGE(0,0,0) >

Code Page

| Default

QRCode Format

| Standard

Module width

| Auto

=
_
a
£
{

=

=L

Mask

| Standard

Rotation

EC Lewvel

| Medium

Outline

Size/MNersion

| 21x 21/(vs 1)

" Barcode

Appendix D.3 - Database Generated Barcodes

(i ] cardPresso's barcodes also supports having database items as the data source. This means
cardPresso can dynamically generate barcodes using the data from an existing database.

As with any item in cardPresso, each Barcode contains it's own set of properties which can be
used for advanced barcode generation.

To add a database source to a Barcode:
1 - Select the Barcode in the Card Design view.
2 - On the Source tab, to the right, change the Source type to Database

3 - Select the Table where the database data is stored.
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4 - Select the Column which contains the data to be written on the Barcode.

| Database

Table

| Employee

Position

Column

| First Name

Concatenation

= Data Prefix
o
e
C .
= | O Ignore on print
=
c Data Suffix
o
a2
m
=
& [ Ignore on print
[V] Concatenate database columns
w
= Column Prefix
]
=
(@]
Column
Last Mame v
o Column Prefix
-D -
g Extension:
[
= Column .
Extension ¥

Column Prefix

Column

|. (Not Used) v

oK Eancel_

Concatenation allows you to stack up to three database fields within the same Barcode. This is
allows for a much more dynamic and space efficient data generation when working with barcodes.

To use Concatenation on a Barcode click the Concatenation button on the Source tab.

The Concatenation pop-up provides the following options:

Data Prefix allows you to customize the text prefix that appears on the currently selected track.
lgnore on print disables or enables encoding the Data Prefix.

Data Suffix allows you to customize a text suffix that appears on the currently selected track.
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Ignore on print disables or enables encoding the Data Suffix.
Concatenate database columns enables or disables Concatenation
Column Prefix adds a text prefix to the data obtained from the selected data column.

Column selects the database column from which to obtain the data.

Appendix D.4 - Script Generated Barcodes

© cardPresso also allows you to manipulate Barcode data trough Scripts. This powerful feature
allows for even more advanced operations to use your barcodes to their full potential.

In cardPresso the data on this item can be manipulated trough scripting as with any other item.

0 The encoded data must still follow each Barcode's format rules.

To create a Script click an empty area of the card design and select the Script tab in the
Properties Dock..

0 Scripts can also be added to an item by selecting it and clicking the Script tab in the properties Dock.

On the Script tab you can select when the script should executed and on the text box, write the

Oexin the example below the QR code being used was given the ID QR.

when ltem Double-Clicked

item.QR.data="TEXT "

Script | Output @]

Result:
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Please enter barcode data

TEXT

Close
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Appendix E - Link Image to DB Field

(i ] Pictures and images are a recurring element of ID cards. When connected to a database
cardPresso allows you to quickly set up a database field as a source for images on your computer.

To set a database field as a link to an image file follow these steps:

1 - Locate the database field that contains the name of the picture files. In the example image below,
the field name is Image File Path:

2 - Right click the database field to open it's Properties menu and change change the Data Type
to Indexed Image.

Image File Path Properties

Data Type

Text Line v E]

E( Text Line

Text Box

Value

Database Counter S
Integer Value | Cancel
Date

—m Time

Date and Time

List

3 - Before closing the Properties menu, click the "..." button to the right of the Data Type drop
down list.

4 - On the Indexed Image Properties menu in the Images Folder type the path to the folder
which contains your images.

Alternatively, click the "..." button to the right of the Images Folder path and browse to your images
folder.

Indexed Image

Valid extensions

\ipg.png.bmp. tif.gif |

Image Format | Image Free format

Default Data | Universally Unique Identifier

Source Feld | S how

| oK | Cancel
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When you're done. Click the OK button on the Indexed Image menu. Then click the OK button on
the Properties menu and finally click the Database refresh button as prompted.

When refreshed, if correctly configured and the database field contains valid image paths, the
database field will now show the images from the folder.

© 2014 cardPresso, Lda



Appendix E - Link Image to DB Field m

© 2014 cardPresso, Lda



CARIPRESSO

more than an application

PHONE: + 351 261 867 873 FAX: + 351707317213
EMAIL: (General Information) info@cardpresso.com (Technical Support) support@cardpresso.com (Sales) sales@cardpresso.com
SKYPE: (Support) cardpresso.support

www.cardPresso.com
. QUADRO orw
o] Intervir+ DE REFERENCIA 34¢] .k
Programa Operacional de Valorizagio ESTRATEGICO * ok
o Tl 4 RAM NACIONAL UNIAO EUROPEIA
©/Coesto fermitonial ca; PORTUGAL2007.2013 REGIAO AUTONOMA DA MADEIRA

FEDER



	Chapter 1. About cardPresso
	1.1 Overview
	1.2 Features
	1.3 Security

	Chapter 2. Installation and Support
	2.1 Installing cardPresso
	2.1.1 Windows Installation

	2.3 Updating cardPresso
	2.4 cardPresso Support

	Chapter 3. Getting Started
	3.1 - Welcome View
	3.1.1 - CP Menu

	3.2 - Creating a New Card
	3.3 - Open Your Own Card Documents
	3.3.1 - Open an Existing Card Document
	3.3.2 - Recover Your Card Documents From Backups

	3.4 - Using Templates
	3.4.1 - Create from Existing Template
	3.4.2 - Create Your Own Templates

	3.5 - Using Models
	3.5.1 - Create from Existing Model
	3.5.2 - Create Your Own Model


	Chapter 4. Design
	4.1 - Workspace
	4.2 - Document Properties
	4.2.1 - Background
	4.2.2 - Clipart
	4.2.3 - Layouts
	4.2.4 - Script

	4.3 - Document Objects
	4.3.01 - Line
	4.3.02 - Rectangle
	4.3.03 - Circle
	4.3.04 - Shape
	4.3.05 - Text
	4.3.06 - Print Counter
	4.3.07 - Print Date
	4.3.08 - 1D Barcode
	4.3.09 - 2D Barcode
	4.3.10 - Image
	4.3.11 - Signature

	4.4 - Objects Properties
	4.4.1 - Item
	4.4.2 - Position
	4.4.3 - Shape
	4.4.4 - Rotation
	4.4.5 - Outline
	4.4.6 - Fill
	4.4.7 - Font
	4.4.8 - Barcode
	4.4.9 - Image
	4.4.10 - Source
	4.4.10.1 - Text & Barcode
	4.4.10.1.1 - Print Counter
	4.4.10.1.2 - Print Date
	4.4.10.1.3 - Keyboard Input
	4.4.10.1.4 - Database
	4.4.10.1.5 - Item Link

	4.4.10.2 - Image & Signature
	4.4.10.2.1 - From Disk
	4.4.10.2.2 - From Camera or Scanner
	4.4.10.2.3 - From Signature Pad
	4.4.10.2.4 - From Image Editor
	4.4.10.2.5 - From Database
	4.4.10.2.6 - Item Link


	4.4.11 - Alignment
	4.4.12 - Script
	4.4.13 - Multi Align

	4.5 - Edit View

	Chapter 5. Database
	5.1 - Connection
	5.1.1 - Configuration
	5.1.1.1 - Direct CSV & TXT Driver
	5.1.1.2 - Direct Excel Driver
	5.1.1.3 - Direct MS Access Driver
	5.1.1.4 - Internal Database
	5.1.1.5 - ODBC
	5.1.1.6 - MySQL Driver

	5.1.2 - Database Operations
	5.1.3 - Table Columns
	5.1.4 - Guide Columns
	5.1.5 - Database Filter
	5.1.6 - Order Columns
	5.1.7 - Properties

	5.2 - Dockbar
	5.3 - Database

	Chapter 6. Printing
	6.1 - Printing with cardPresso
	6.1.1 - Printing With a Database
	6.1.1.1 - Printing a Database Range
	6.1.1.2 - Printing Selected Records in a Database
	6.1.1.3 - Printing with Conditional Printing from a Database
	6.1.1.4 - Update after Print

	6.1.2 - Copies
	6.1.3 - Print Operations

	6.2 - Print Settings
	6.2.1 - Printer
	6.2.2 - Print Layout
	6.2.3 - Options


	Chapter 7. Encoding
	7.1 Encode View
	7.2 - Encode Data
	7.3 - Data Inspector
	7.4 - Encode Operations
	7.5 - Properties
	7.3.1 - Preview
	7.3.2 - Printer Tools
	7.3.3 - Database
	7.3.4 - Database Filter
	7.3.5 - Database Find
	7.3.6 - Script


	Chapter 8. Users
	8.1 - Users View
	8.2 - Users
	8.2.1 - Enabling User Logins
	8.2.2 - Login
	8.2.3 - Add User
	8.2.4 - Remove User
	8.2.5 - Edit a User

	8.3 - Groups
	8.3.1 - Add Group
	8.3.2 - Remove Group
	8.3.3 - Edit a Group

	8.4 - Auditing
	8.4.1 - Audit Report


	Appendix A - XXL Net License
	Appendix A.1 - Installing the XXL Net License Service

	Appendix B - Advanced Print Operations
	Appendix B.1 - Overlay
	Appendix B.1.1 - Separate Page Overlay
	Appendix B.1.2 - External File Overlay
	Appendix B.1.3 - Printer Default Overlay
	Appendix B.1.4 - IDP SMART 50 Overlay Settings

	Appendix B.2 - Web Print Server
	Appendix B.2.1 - Configuring a Web Print Server
	Appendix B.2.2 - Sending a Web Print Job to the Web Print Server
	Appendix B.2.3 - Web Print Job Sample

	Appendix B.3 - AutoPrint
	Appendix B.3.1 - AutoPrint Commands
	Appendix B.3.2 - AutoPrint with Command Prompt and Windows Run
	Appendix B.3.1 - AutoPrint Batch File


	Appendix C - Encoding
	Appendix C.1 - Magnetic Stripe
	Appendix C.1.1 - Macros / Sentinels
	Appendix C.1.2 - Adding Data to a Track
	Appendix C.1.3 - Adding a Database Source to a Track
	Appendix C.1.4 - Concatenation With Databases
	Appendix C.1.5 - Editing Magnetic Macros / Sentinels
	Appendix C.1.6 - Script Encoding

	Appendix C.2 - Contact Encoding
	Appendix C.3 - Contactless Encoding

	Appendix D - Barcodes
	Appendix D.1 - 1D Barcode
	Appendix D.2 - 2D Barcode
	Appendix D.3 - Database Generated Barcodes
	Appendix D.4 - Script Generated Barcodes

	Appendix E - Link Image to DB Field

